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Chapter 1. BigFix Remote Control
V9.1.2V9.1.3V9.1.4 Installation Guide

By using BigFix® Remote Control you can remotely support and control thousands of PCs and servers, on 

an enterprise scale, from a central location or directly, in peer to peer mode.

Use the BigFix Remote Control administration web interface, to view and control a remote desktop, 

including its keyboard and mouse, anywhere on your network. You can also chat, transfer files, remotely 

guide the users, administer the policies to be applied to different users and target groups, and much 

more. These features can help provide more efficient and effective analysis of user problems from the 

administrators desktop, without the added cost of dispatching a technician or relying on user descriptions 

over the phone. Use BigFix Remote Control to deliver better support, more flexibility, and richer security, 

by using robust features that include enhanced central logging and video capture of the sessions and full 

data stream encryption.

Audience
This guide is for administrators and IT managers who want to install and administer BigFix Remote 

Control. It details the system requirements for each of the components and provides installation 

instructions that allow you to deploy the program in your environment. It also includes information about 

configuring and maintaining BigFix Remote Control.

Versions

The guide includes the functions introduced in BigFix Remote Control V9.1.3V9.1.4, © Copyright HCL Ltd. 

20012020.

Terms used in this guide

The following terms are all BigFix Remote Control terms, but are used throughout the guide without being 

labeled every time with BigFix Remote Control:

• Controller always means BigFix Remote Control Controller application

• Target always means BigFix Remote Control Target

• Server always means BigFix Remote Control Server

• Broker always means BigFix Remote Control Broker
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• Managed mode refers to installations where a server has been deployed and the targets are 

configured to register and report status to the server.



Chapter 2. Overview of the BigFix Remote Control
system

The BigFix Remote Control system includes the following main components:

BigFix Remote Control Target

The target is installed on every computer that you want to control remotely with BigFix

Remote Control. It listens for connection requests that come from the controller. You can 

also start a remote control session over the internet with a target, by using a broker.

Targets that are outside of your intranet can be configured to register their details with the 

server. Sessions with these targets are managed by server policies. The targets must be 

deployed with the Managed property set to Yes. The ServerURL and BrokerList properties 

must also be configured. Targets can also be configured so that they do not send their 

details to the server. These targets are classed as unregistered targets. You can install the 

target software and set the Managed property to No. The BrokerList property must also be 

set. You can also use the on-demand target features to start a remote control session with 

a computer that does not have any target software preinstalled. Server policies are used to 

manage the on-demand sessions. The target software is deleted at the end of the session. 

For information about target requirements, see Target requirements (on page 16).

BigFix Remote Control Controller

The controller can be installed by using the Fixlet, or by using the installer that is provided 

for use in peer-to-peer sessions. It can also be launched in context from the remote control 

server or the BigFix Remote Control console. In all instances, the controller can be used to 

allow the user to control a remote computer on which the remote control target is installed. 

The controller delivers an interface to several actions, available to the controller user, like 

remote control, guidance, chat, file transfer, collaboration, and many more. For information 

about controller requirements, see Controller requirements (on page 16).

BigFix Remote Control Server

A web application that manages all the deployed targets that are configured for managed 

mode and to point to the BigFix Remote Control Server 's URL. You can deploy it on an 

existing WebSphere® server, or install it by using the installer package along with an 

embedded version of WebSphere. The server listens for HTTP or HTTPS connections by 

default. When it is installed with the embedded WebSphere option, WebSphere it listens on 

ports 80 and 443. When it is deployed on top of an existing WebSphere server, the BigFix

Remote Control server listens on ports 9080 and 9443. The server requires a database 
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server: embedded Derby, only for proof of concept deployments; DB2®, SQL Server, and 

Oracle are the supported options. Additionally, it can also be configured to synchronize and 

authenticate user and group data from an LDAPv3 server, such as Active Directory or Tivoli 

Directory Server. This deployment scenario has the same networking characteristics as 

peer-to-peer. Therefore, direct TCP connectivity is required between all the controllers and 

all the targets. However, the BigFix Remote Control server provides a method of centralized, 

and finer, policy control, where targets can have different policies that are determined by 

the user who is trying to start the remote control session. The Server also provides for 

centralized audit and storage of full session automatic recordings. In this scenario, the 

controller is not a stand-alone application, but is started as a Java™ Web Start application 

from the BigFix Remote Control server's web interface to start the remote control session.

Note:  Peer-to-peer and managed are not exclusive modes. You can configure the BigFix

Remote Control target in the following ways:

• To be strictly managed.

• To fail back to peer-to-peer mode when the server is not reachable.

• To accept both peer-to-peer and managed remote control sessions.

The following components can be used only in managed mode:

BigFix Remote Control CLI tools

CLI tools are always installed as part of the target component but you can also install them 

separately. The CLI provides command-line tools for the following tasks:

• Script or integrate the launch of managed remote control sessions.

• Run remote commands on computers with the managed target installed.

BigFix Remote Control Gateway

A service that is installed in computers in secure network boundaries, where there is 

strict control of traffic flows between the secure networks. For example, the firewall at 

the boundary allows only traffic between a pair of specific IP address and ports. In these 

scenarios, a network of gateways can be deployed. The gateway routes and tunnels the 

remote control traffic from the controller, which is located in a particular network zone, to 

the target that is in a different network zone. The gateway is a native service that can be 

installed on a computer that has a Windows™ or Linux™ operating system installed. It does 

not have a default port for listening, although 8881 is a usual choice, and can be configured 

for multiple incoming listening ports and outgoing connections.
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BigFix Remote Control Broker

A service that is installed in computers typically in a DMZ so that computers outside the 

enterprise network, in an Internet cafe or at home, can reach it. The BigFix Remote Control

broker receives inbound connections from the controller and the target and tunnels the 

remote control session data between the two components. The broker is a native service 

that can be installed on a Windows or a Linux computer. It does not have a default port for 

listening, but 443 is a recommended option because usually this port is open for outbound 

connections and has fewer issues with content filtering than, for example, 80 would have.

How to use the guide

The process of getting BigFix Remote Control up and running varies, depending on your network 

environment and the management granularity you want to achieve. The installation guide focuses on 

three types of deployments:

Peer to peer

Is the simplest scenario and therefore ideal for small deployments. All targets are in network 

sight of the controllers and there is no requirement to centrally manage the controller 

policies.

Intranet managed

Are most appropriate in a complex network infrastructure that requires the deployment 

of gateways to traverse firewalls, or there is a requirement for strict policy control and 

centralized auditing.

Managed

With support for internet sessions where at least one broker must be installed in an internet-

facing computer so that it is visible to targets outside the controller's network sight.

For the sake of readability and generality, the installation guide assumes the following restrictions:

• Each BigFix Remote Control server must have access to one of the supported database servers. 

The database can be located locally on the server computer or remotely on a separate server. The 

supported database systems are DB2, Oracle, and MS SQL. It is also possible to install the server by 

using the embedded Derby database that is provided by the installer. However, this configuration is 

not supported for production deployments.

• In managed environments, each controller can make an HTTP or HTTPS connection to the BigFix

Remote Control server.
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• In managed environments, each BigFix Remote Control target computer in the network must be able 

to make an HTTP or HTTPS connection to a server, a gateway, or a broker on the specified ports.

If your network configuration does not match any of the scenarios in that chapter, contact a support 

technician for more options.

The initial deployment of a minimal managed BigFix Remote Control system (server and a few targets) 

can take approximately 1 hour to complete.

Several steps in the BigFix Remote Control installation depend on the completion of prior steps. For this 

reason, it is recommended that you follow the guide in the order presented.

BigFix Remote Control operating requirements
BigFix Remote Control runs efficiently by using minimal server, network, and client resources. The 

requirements for the client programs are not stringent. The hardware that is required by the server and the 

target depends on the number of computers that are administered and the frequency that is defined for 

their status updates.

A Basic installation
The most basic installation requires the BigFix Remote Control target and controller components. Use the 

two components to start a peer to peer remote control session, for which the policies are defined only at 

target level.

The port to be used for target to controller communication is configurable at installation time. The default 

is port 888.

Such an installation provides basic audit information. This information is accessible from the BigFix

console. It is also stored in the application event log, in a Windows operating system, or system log, in 

a Linux operating system. However, if centralized auditing and management of users and computers is 

required, install the server component.

The server component provides a single interface where controller users can easily search for targets. 

They can also organize the targets that are most frequently accessed and view their session history. For 

an administrator, a managed environment provides the following extra capability.

• Centralized management of users and targets: Users can be organized into groups with similar 

profiles. They can be organized manually, by using the BigFix Remote Control server interface, or by 

importing users and groups from LDAP. Similarly, targets can be organized into groups manually or 
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by setting target membership rules to automatically assign a target to a specific group. For more 

information about target membership rules, see the BigFix Remote Control Administrator's Guide.

• Centralized policy management: When a session is started from the server interface, the permissions 

that are set for the session are derived from the target and controller properties. Provides more 

flexibility to define different levels of access, against a single target, for different users in your 

organization.

• Centralized auditing and recording repository: Administrators can use the BigFix Remote Control

server interface to browse and examine audit information. They can also view recordings that are 

associated with a specific remote control session. Administrators can search the existing session 

history. For example, by user ID or computer name.

• Access request management: Administrators can grant temporary access, or increase the level of 

access, to a target or group of targets. Temporary access can be granted to BigFix Remote Control

registered and unregistered users.

• Reporting capabilities

Figure 1. Basic installation environment

Note:  It is not necessary to install the controller component in a managed environment. Remote 

control sessions are launched in-context from the BigFix Remote Control server interface. You can also 
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configure the target components, in a managed environment, to accept peer to peer remote control 

requests from a stand-alone controller component. For more information about installing the target, see 

Install the target (on page 57).

Installation with support for firewall and NAT traversal
In some environments, it is not possible to open a port in a firewall to enable controller to target, or target 

to server communication for all endpoints. It is more appropriate to enable traffic from, or traffic to a 

single computer that acts as a gateway to traverse the firewall.

The gateway component can be strategically installed in your network to enable traffic between targets 

and controllers, or targets and servers that are in different networks. This component can also be used as 

a proxy server to forward the target’s status update to the remote control server.
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Installation with support for remote control sessions over the internet
Sometimes the target that requires support is out of network sight in an internet location. For example, in 

a hotel or an airport lounge.

Use the broker component to enable remote control sessions to these computers by bridging the target 

and controller communication. The broker must be placed in the DMZ and a gateway is required to 

provide secure communication to the server in the intranet.

In this scenario, the controller user can start a broker connection and obtain a connection code from 

the server. The user who requires assistance enters the connection code by using the appropriate menu 

option in the target UI. When the session details are validated by the server, the session is connected.

Figure 2. Sample deployment environment

Server requirements
The hardware that is required by the server component depends on the number of computers that are 

administered and the frequency that is defined for their status updates.



BigFix® Remote Control Installation Guide | 2 - Overview of the BigFix Remote Control system | 10

The distributed architecture of BigFix Remote Control allows a single server to support hundreds of 

thousands of computers.

Note:  BigFix Remote Control includes entitlement for DB2 v10.5 and WebSphere v8.5.

The computer on which you install the BigFix Remote Control server must have the minimum following 

items or capability:

1. 1 Quad core or two dual core processors. 2.40 GHz with supported OS.

2. A minimum of 4 GB of memory.

3. A minimum of 2 GB of storage or hard disk space to install, and an average of 2 MB per client in the 

database.

4. A minimum screen resolution of 800 by 600 pixels is required when you run an automated server 

installation.

5. Adequate space for storing session video recordings. Recordings are stored on the hard disk and 

their size can vary depending on the duration and screen activity of the session. On average a 5-

minutes session, 8-bits mode, can use about 2 MB of space. In true color 24-bit mode, recordings can 

take more space.

6. A network card that supports TCP/IP.

7. A supported browser.

Operating system support

The following operating systems are supported.

• Windows Server 2008.

• Windows Server 2008 R2.

• Windows Server 2012.

• Windows Server 2012 R2.

• Windows Server 2016.

• Red Hat Enterprise Linux 5.0 or later.

• Red Hat Enterprise Linux 6.0 or later.

• Red Hat Enterprise Linux 7.0 or later.

• SUSE Linux Enterprise Server 10 or later.

• SUSE Linux Enterprise Server 11 or later.

• CentOS 5.0 or later.

• CentOS 6.0 or later.

Supported Architectures
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• Intel™ IA®-32 (also known as x86, x86-32)

• Intel 64 or AMD64 (also known as x64, x86-64, EM64T)

Note:  IA-64 (also known as Itanium™) processors are not supported.

The following databases are supported.

• IBM DB2 10.x, 11.x Workgroup(WSE) and Enterprise Edition(ESE).

• Oracle 11g and 12c.

When you use an Oracle database, if you are using the Oracle 11g drivers, set 

oracle.increment.keys.off=1 in the trc.properties file. Restart the server service.

• Microsoft SQL server 2008, 2012, 2014, and 2016.

You must use a JDBC driver whose version is bigger than 6.3. Older versions do not support TLS1.2 

or JRE8.

When you use an MS SQL database, Windows authentication is not supported. You cannot log on 

with a domain user. You must use mixed mode authentication and create an SQL user to connect to 

the database.

Note:  You should use JDBC drivers which support at least Java 8.

Derby Version 10.13 is included with the BigFix Remote Control server and is installed locally when you 

select the Derby option during the installation.

Note:  Install Derby only for proof of concept configurations. Derby is not supported in production 

environments.

When you install the server by using the installer, a WebSphere Application Server Liberty Profile version 

18.x.x.x is also installed.

Server environment guidelines
In addition to system requirements, you must also determine which type of server installation to use in 

your environment. Use the following information as a guide.

server installation types
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Table 1. BigFix Remote Control server installation types

Server instal­

lation type Components installed

Install by using

the BigFix console

Install by us­

ing the instal­

lation files

1 Embedded Liberty profile. Embedded

Derby database.

Yes Yes

2 Embedded Liberty profile, that uses an 

already installed DB2, MS SQL, or Ora­

cle database

Yes Yes

3 Stand-alone BigFix Remote Control

server that accesses WebSphere Ap­

plication Server, by using an already in­

stalled DB2, MS SQL, or Oracle data­

base

No Yes

Note:  Server installation types 1 and 2 are available only when you use Windows or Linux operating 

systems.

Note:  Server installation type 1 must be used only in Proof of Concept or test deployments.

The following sections provide guidance and recommendations based on environment size.

Small environment guidelines

For environments containing up to 5K targets, you can use server installation types 1, proof of concept 

only, or 2 in Server environment guidelines (on page 11).

Also, consider the following extra requirements.

• Processors: 1 Quad core or 2 dual core processors, 2.40 GHz, with supported OS.

• Memory: 4 GB RAM.

• Storage. For more information, see Server requirements (on page 9).

• Heartbeat configuration

Table 2. Heartbeat configuration properties: suggested values for a small environment

Property in tr­

c.properties Value

heartbeat.timeout 60
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Property in tr­

c.properties Value

Note:  If there are performance issues, set the value to 

1440, which is 24 hours. For example, when there is heavy us­

age of reports, especially with Derby.

Default is 60, which is 1 hour.

heartbeat.retry 10

heartbeat.delay 20

heartbeat.on.wake 0

heartbeat.on.user.change 1

heartbeat.on.change 0

heartbeat.on.stop 0

Note:  Installation type 1 is suitable for demonstrations or pilot projects. Installation type 2 can give 

better performance, which might be preferred for production systems in these environments.

Medium environment guidelines

For environments containing from 5K to 75K targets, you can use server installation types 2 or 3 in Server 

environment guidelines (on page 11). In terms of performance, installation type 2 is suitable. However, 

with installation type 3 you can also use the admin functions of the installed WebSphere Application 

Server.

Also, consider the following extra requirements.

• Processors: 1 Quad core or 2 dual core processors, 2.40 GHz.

• Memory: 8 GB RAM.

• Storage: RAID 5 - 6 HDD. DB2, Oracle, or MS SQL 64 bit or 32 bit.

• Heartbeat configuration -

Table 3. Heartbeat configuration properties: suggested values for a medium environment

Property in tr­

c.properties Value

heartbeat.timeout 1440



BigFix® Remote Control Installation Guide | 2 - Overview of the BigFix Remote Control system | 14

Property in tr­

c.properties Value

Note:  If there are specific groups of computers where 

more regular updates are needed, a smaller heartbeat timeout

setting can be applied as a group attribute for those specific

groups of targets. For details of setting this attribute at group 

level, see the chapter that explains how to create a target group 

in the BigFix Remote Control Administrator's Guide.

heartbeat.retry 10

Note:  In an environment that contains target numbers

nearer to 75 K, set this value to 20 to help with performance.

heartbeat.delay 20

Note:  In an environment that contains target numbers

nearer to 75 K, set this value to 40 to help with performance.

heartbeat.on.wake 0

heartbeat.on.user.change 1

heartbeat.on.change 0

heartbeat.on.stop 0

Note:  In this type of environment, ensure that the target deployment is done in stages. A staged 

deployment can avoid overload in the server when the targets try to register with the server. Give the 

RegistrationDelay target property a value that distributes the target computer registration evenly through 

the staged deployment. Distribute the target registration to avoid too many computers trying to register at 

the one time.

Large environment guidelines

For environments containing from 75K to 225K targets, you can use server installation type 3 in Server 

environment guidelines (on page 11).

Also, consider the following extra requirements.

To host WebSphere Application Server
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• Processors: 2 Quad core processors. 2.40 GHz with supported OS.

• Memory: 16 GB RAM.

• Storage: RAID 5 - 6 HDD.

• Heartbeat configuration -

Table 4. Heartbeat configuration properties: suggested values for a large environment

Property in tr­

c.properties Value

heartbeat.timeout 1440

Note:  If there are specific groups of computers where 

more regular updates are needed, a smaller heartbeat timeout

setting can be applied as a group attribute for those specific

groups of targets. For details of setting this attribute at group 

level, see the chapter that explains how to create a target group 

in the BigFix Remote Control Administrator's Guide.

heartbeat.retry 60

Note:  In an environment that contains target numbers

nearer to 75 K, set to a higher value to help with performance.

heartbeat.delay 60

Note:  In an environment that contains target numbers

nearer to 75 K, set to a higher value to help with performance.

heartbeat.on.wake 0

heartbeat.on.user.change 1

heartbeat.on.change 0

heartbeat.on.stop 0

• Optional: 2 network cards, one for target communications and one for database communications 

that could aid in performance tuning.

To host the database, DB2, Oracle, or MS SQL supported.

• Processors: 4 Quad core processors, 2.40 GHz.

• Memory: As recommended by the database supplier.

• Storage: RAID 5 - 6 HDD 146 GB
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Note:  The database administrator must tune the database for appropriate performance.

The following guidelines must also be considered when you use large reports, as some performance 

degradation can be experienced.

• Ensure that the All targets report is not the default home page report.

• Ensure staged deployment of the targets to avoid overload in the server when they try to register.

Note:  Give the RegistrationDelay target property a value that distributes the target computer 

registration evenly through the staged deployment. Distribute the target registration to avoid too 

many computers trying to register at the one time.

Note:  If you configure LDAP and LDAP synchronization is enabled, set a reasonable frequency for the 

synchronization. If your LDAP configuration is set up to import many users and groups, set the frequency 

to 24 hours. For more information about configuring LDAP, see Configure LDAP (on page 130).

Controller requirements

The Controller is a Java based application that can run on any operating system with the following 

prerequisites:

• Java Run Time environment: Oracle 8 or IBM®® 8 Oracle Java SE Runtime Environment 8 or IBM

Java SE Runtime Environment 8.

Note:  Oracle Java is not supported in FIPS or NIST SP800-131a mode. You must use the IBM

Java in this mode.

• Web Browser: either Microsoft™ Internet Explorer 9, 10, 11 or Mozilla Firefox Extended Support 

Release (ESR) 24, 31.

• Web Browser:

◦ Microsoft Internet Explorer 9, 10, 11.

◦ Mozilla Firefox Extended Support Release (ESR) 45.

◦ Safari 10 on OS X 10.11 El Capitan or macOS 10.12 Sierra.

• Java Run Time environment: Sun 1.6, Oracle 1.6, 1.7 or IBM® 1.5, 1.6, 1.7

Note:  Sun Java and Oracle Java are not supported in FIPS or NIST SP800-131a mode. You must 

use the IBM Java in this mode.

• Web Browser: either Microsoft Internet Explorer 9, 10, 11 or Mozilla Firefox ESR 24, 31.
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Target requirements

The computer on which you install the BigFix Remote Control target must have the minimum following 

items or specification:

• At least a 1 GHz Intel® or AMD processor.

• A minimum of 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit).

• A minimum of 50 MB hard disk space.

• Adequate space for storing session video recordings. Recordings are stored on the hard disk and 

their size can vary depending on the duration and screen activity of the session. On average a 5-

minutes session, 8-bits mode, can use about 2 MB of space. In true color 24-bit mode, recordings can 

take more space.

• The maximum display resolution per display is 7680 pixels by 4320 pixels.

• The maximum number of displays is 8 by 8.

Operating system Support

The following operating systems are supported

• Windows 7.

• Windows 8 and 8.1.

• Windows 10.

• Windows Server 2003.

• Windows Server 2003 R2.

• Windows Server 2008.

• Windows Server 2008 R2.

• Windows Server 2012.

• Windows Server 2012 R2.

• Windows Server 2016.

• Windows XP Pro (32 bits), (64 bits).

• Red Hat Enterprise Linux 5.0 or later.

• Red Hat Enterprise Linux 6.0 or later.

• Red Hat Enterprise Linux 7.0 or later.

• SUSE Linux Enterprise Server 10 or later.

• SUSE Linux Enterprise Server 11 or later.

• SUSE Linux Enterprise Desktop 10 or later.

• SUSE Linux Enterprise Desktop 11 or later.

• CentOS 5.0 or later.

• CentOS 6.0 or later.
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• OS X 10.11 El Capitan.

• macOS 10.12 Sierra.

• macOS 10.14 Mojave.

Supported Architectures

• Intel IA-32 (also known as x86, x86-32)

• Intel 64 or AMD64 (also known as x64, x86-64, EM64T)

Note:  IA-64 (also known as Itanium) processors are not supported.

Gateway requirements

The computer on which you install the BigFix Remote Control gateway must have the minimum following 

items or specification:

1. At least a 1 GHz Intel® or AMD processor.

2. A minimum of 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit)

3. A minimum of 50 MB hard disk space.

Operating system support

The following operating systems are supported.

• Windows Server 2003.

• Windows Server 2003 R2.

• Windows Server 2008.

• Windows Server 2008 R2.

• Windows Server 2012.

• Windows Server 2012 R2.

• Red Hat Enterprise Linux 5.0 or later.

• Red Hat Enterprise Linux 6.0 or later.

• Red Hat Enterprise Linux 7.0 or later.

• SUSE Enterprise Linux Server 10 or later.

• SUSE Enterprise Linux Server 11 or later.

• SUSE Linux Enterprise Desktop 10 or later.

• SUSE Linux Enterprise Desktop 11 or later.

• CentOS 5.0 or later.

• CentOS 6.0 or later.
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Supported Architectures

• Intel IA-32 (also known as x86, x86-32)

• Intel 64 or AMD64 (also known as x64, x86-64, EM64T)

Note:  IA-64 (also known as Itanium) processors are not supported.

Broker requirements

The computer on which you install the BigFix Remote Control broker must have the minimum following 

items or specification:

1. At least a 1 GHz Intel® or AMD processor.

2. A minimum of 1 gigabyte (GB) RAM (32-bit) or 2 GB RAM (64-bit)

3. A minimum of 50 MB hard disk space.

4. Adequate space for storing session video recordings. Recordings are stored temporarily on the hard 

disk and their size can vary depending on the duration and screen activity of the session. On average 

a 5-minutes session, 8-bits mode, can use about 2 MB of space. In true color 24-bit mode, recordings 

can take more space.

Operating system support

The following operating systems are supported

• Windows Server 2003.

• Windows Server 2003 R2.

• Windows Server 2008.

• Windows Server 2008 R2.

• Windows Server 2012.

• Windows Server 2012 R2.

• Red Hat Enterprise Linux 5.0 or later.

• Red Hat Enterprise Linux 6.0 or later.

• Red Hat Enterprise Linux 7.0 or later.

• SUSE Linux Enterprise Server 10 or later.

• SUSE Linux Enterprise Server 11 or later.

• CentOS 5.0 or later.

• CentOS 6.0 or later.

Supported Architectures
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• Intel IA-32 (also known as x86, x86-32)

• Intel 64 or AMD64 (also known as x64, x86-64, EM64T)

Note:  IA-64 (also known as Itanium) processors are not supported.



Chapter 3. Get started

Now that you understand the terms and components available in BigFix Remote Control, you can identify 

which components you need to install:

Table 5. Determining which components to install

Requirements Target Controller Server Gateway

Bro­

ker

I want others to remotely con­

nect to this computer.

Yes Yes

I want to remotely connect to 

other computers by using the 

BigFix Remote Control console

or by starting the stand-alone 

controller.

Yes Yes

To centrally manage users and 

targets, and their policies.

Yes Optional * Yes

To maintain a central audit and 

recording repository.

Yes Optional * Yes

Traverse firewalls in your com­

pany infrastructure

Yes Optional * Yes Yes

Connect to targets outside your 

company network.

Yes Optional * Yes Yes ** Yes

* In a managed environment, the controller user starts remote control sessions from the BigFix Remote 

Control server interface. Starting sessions this way does not require the controller component to be 

installed separately. The BigFix Remote Control server interface starts a Java Web Start controller 

console, in context.

** A gateway is not strictly required in a broker deployment but it does increase security.



Chapter 4. Install the BigFix Remote Control
components

The BigFix Remote Control components can be installed in two ways. If you have access to the BigFix

console, use a deployment fixlet to install the components.

For more information, see the BigFix Remote Control Console User's Guide. Alternatively use the 

component installation files.

You can obtain the installation files in various ways. Choose the appropriate method for obtaining the 

files. There is no specific order in which the different components must be installed.

Obtain the installation files
The installation files for installing the BigFix Remote Control components can be obtained in various 

ways.

HCL License & Delivery Portal
To install the BigFix Remote Control components, use the following images from Flexnet Operations – 

HCL License & Delivery Portal.

Table 6. Parts required for installing BigFix Remote Control

Part number File name

Windows operating system

CNEJ8ML - BIGFIX REM CNTRL V9.1.3 

IMAGE1.

BIGFIX_REM_CNTRL_V913_Image_­

1.zip

Linux operating system

CNEJ9ML - BIGFIX REM CNTRL V9.1.3 

IMAGE2.

BIGFIX_REM_CNTRL_V913_Image_­

2.tar

Windows, Linux, AIX®, Solaris operating systems

CNEK0ML - BIGFIX REM CNTRL V9.1.3 

IMAGE3.

BIGFIX_REM_CNTRL_V913_Image_­

3.tar

Depending on the operating system, and the component that you are installing, determines which image 

file you require.

BIGFIX_REM_CNTRL_V913_Image_1.zip

https://hclsoftware.flexnetoperations.com/flexnet/operationsportal/logon.do
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Extract the installation files for the Windows operating system components from this image 

file. The Windows operating system executable files are in the \windows directory.

BIGFIX_REM_CNTRL_V913_Image_2.tar

Extract the installation file for the Linux server component from this image 

file. The trc_server_setup.bin file is in the \linux directory. Use the 

BIGFIX_REM_CNTRL_V913_Image_3.tar file to access the installation files for the other 

Linux components.

BIGFIX_REM_CNTRL_V913_Image_3.tar

Extract the data from the BigFix_Rem_Cntrl_V913_Image_3.tar file. 

Extract the additional setup utility files, trc_additional_setup.exe, and 

trc_additional_setup.bin from this image file. Use the files to extract the installation 

files for Windows, Linux, and other supported operating system components. Go to the 

\Disk1\InstData\platform\VM directory where platform is relevant to your operating 

system. For more information about running the additional setup utility, see Extract the 

installation files by using the additional setup utility (on page 112).

HCL License & Delivery Portal
To install the BigFix Remote Control components, use the following images from Flexnet Operations – 

HCL License & Delivery Portal. For more information, refer to the article at https://hclpnpsupport.service-

now.com/csm?id=kb_article&sysparm_article=KB0010149

Note:

IBM Passport Advantage® and Fix Central® have been replaced by FlexNet Operations®.

Table 7. Parts that are required for installing BigFix Remote Control

Part number File name

Windows operating system

CNJ05ML - BIGFIX REM CNTRL V9.1.4 

IMAGE1.

BIGFIX_REM_CNTRL_V914_Image_­

1.zip

Linux operating system

CNJ06ML - BIGFIX REM CNTRL V9.1.4 

IMAGE2.

BIGFIX_REM_CNTRL_V914_Image_­

2.tar

Windows, Linux, macOS, AIX, Solaris operating sys­

tems

BIGFIX_REM_CNTRL_V914_Image_­

3.tar

https://hclsoftware.flexnetoperations.com/flexnet/operationsportal/logon.do
https://hclpnpsupport.service-now.com/csm?id=kb_article&sysparm_article=KB0010149
https://hclpnpsupport.service-now.com/csm?id=kb_article&sysparm_article=KB0010149
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Part number File name

CNJ07ML - BIGFIX REM CNTRL V9.1.4 

IMAGE3.

Depending on the operating system, and the component that you are installing, determines which image 

file you require.

BIGFIX_REM_CNTRL_V914_Image_1.zip

Extract the installation files for the Windows operating system components from this image 

file. The Windows operating system executable files are in the \windows directory.

BIGFIX_REM_CNTRL_V914_Image_2.tar

Extract the installation file for the Linux server component from this image 

file. The trc_server_setup.bin file is in the \linux directory. Use the 

BIGFIX_REM_CNTRL_V914_Image_3.tar file to access the installation files for the other 

Linux components.

BIGFIX_REM_CNTRL_V914_Image_3.tar

Extract the data from the BigFix_Rem_Cntrl_V914_Image_3.tar file. 

Extract the additional setup utility files, trc_additional_setup.exe, and 

trc_additional_setup.bin from this image file. Use the files to extract the installation 

files for Windows, Linux, and other supported operating system components. Go to the 

\Disk1\InstData\platform\VM directory where platform is relevant to your operating 

system. The additional setup utiliy can be run only on Windows and Linux systems. To 

extract the installation files for macOS components, run the utility on a Windows or Linux

system then copy the .pkg files to the macOS system. For more information about running 

the additional setup utility, see Extract the installation files by using the additional setup 

utility (on page 112).

Accessing the installation files on the installation DVD
The installation DVD contains the installation files that are required for installing the components.

Windows installation files

Go to the \trc\windows directory to access the required component installation file.

Linux server component

Go to the \trc\linux directory to access the trc_server.bin file, for installing 

the server. For all other component installation files, go to the \Disk1\InstData

\platform\VM directory where platform is relevant to your operating system. 

Use the additional setup utility files trc_additional_setup.exe or 
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trc_additional_setup.bin to extract the required installation files. For more 

information about running the additional setup utility, see Extract the installation files by 

using the additional setup utility (on page 112).

Downloading the files from the server UI
If you install the BigFix Remote Control server, you can download the installation files for the target, 

controller, and cli components. The controller installation file is for the standard controller. For the FIPS-

compliant controller installation file, use the additional setup utility.

1. Click Tools > Downloads.

2. Select Agent Downloads.

3. Select the relevant component file.

Install the server
BigFix Remote Control server supports the following installation types:

Table 8. Server installation types

Automated installation - For more 

information, see Installing by using

the server installer (on page 32)

Manual Installation - For more information, see 

Installing on WebSphere Application Server ver­

sion 8.5: deploying the war file (on page 44)

Available on Windows® operating

system and Linux operating system.

Available on AIX operating system and Solaris operating

system and for any operating system that WebSphere Appli­

cation Server 8.5 supports.

Derby is installed as embedded or us­

es existing supported database. Lo­

cal or remote.

Database must be created or an existing supported data­

base can be used.

All embedded components are in­

stalled locally on the same computer.

The database can be installed on a separate computer.

Note:  The embedded Derby database is not supported in production.

Set up the database
Before you set up the database, install the database software and create the instance where the database 

for BigFix Remote Control is held.
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Setting up DB2

To perform the database setup for DB2 complete the following steps. If you are using a Windows

operating system, begin from step 2 (on page 26). If you are using Linux operating system or AIX

operating systems, begin from step 1 (on page 26):

1. To verify that DB2 and the instance are ready for remote connectivity using TCP/IP complete the 

following steps:

a. Run db2 get database manager configuration and verify that the value of svcename is a valid 

port.

for example 50000 

or a reference mapped to a valid port 

for example,db2c_db2inst1.

b. Ensure that the configured port is not used by other processes in the system, or blocked by a 

firewall that sits between the Application Server host and the DB2 server.

c. Use the db2stop command to stop the DB2 instance.

Set DB2COMM to tcpip with the command

db2set DB2COMM=tcpip

Run db2start to start the DB2 instance again.

The DB2 server is now ready for accessing over the network.

2. Create the database that BigFix Remote Control will use by running the following command as the 

instance owner:

Note:  Not necessary when the database is local.

db2 create db databasename using codeset UTF-8 territory requiredtrerritory

where databasename is the name required for the database. This database name must be the name 

that was referenced in any configuration settings. For example, TRCDB.

requiredtrerritory is the required territory. For example, GB for Great Britain.

3. Verify the privileges that a specific user, for the database, needs to have.

Do not use the db2inst1 user as the user configured to access the BigFix Remote Control database. 

Create a new specific user for DB2 that has the database owner privileges.
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With the blank database created and ready to use, the next step is to set up the WebSphere server, see 

Setting up the application server (on page 44). It is possible to verify that the database is set up 

properly by using a DB2 client to connect to the database from another host. For more details see the DB2

Infocenter.

Setting up Oracle

To set up Oracle to use with BigFix Remote Control, create the database and then set up the database 

permissions.

Creating the database
Run the Oracle database configuration assistant to create the database.

To create the Oracle database that will be used for BigFix Remote Control, complete the following steps:

1. Run the Oracle database configuration assistant.

Windows systems

For example, Select Start  > All Programs  > Oracle > Configuration and Migration Tools

> Database Configuration Assistant.

UNIX®-based systems

Enter the command dbca from the $ORACLE_HOME/bin directory.

2. Click Next on the welcome screen.

3. Step 1: Select Create a Database. Click Next.

4. Step 2: Select General Purpose for the template. Click Next.

5. Step 3:

a. Specify a name for the database. For example, TRCDB.

b. Specify an SID to be used to reference the database. For example, TRCDB.

Click Next.

6. Step 4: Select the database management option that you require. For example, Use Database Control 

for Database Management. Click Next.

7. Step 5: Specify a password for the database and confirm the password. For example, dboracle. Click 

Next.



BigFix® Remote Control Installation Guide | 4 - Install the BigFix Remote Control components | 28

8. Step 6: Specify where the database will be stored. For example, File System. Click Next.

9. Step 7: Specify locations for the database files. For example, Use Database File Locations from 

Template. Click Next.

10. Step 8: Select the recovery options for the database. Click Next.

11. Step 9: On the Database Content window, click Next.

12. Step 10: On the Initialization Parameters screen select the Character Sets tab.

a. Select the required Database Character Set

b. Click Next.

13. When you are using Oracle 11g, the following two steps are also required.

a. Security Settings, accept the enhanced 11g default security settings.

b. Automatic Maintenance Tasks, enable automatic maintenance tasks.

14. Step 11: On the Database Storage window click Next.

15. Step 12: Select the required Creation Options. Click Finish.

16. On the Confirmation screen, click OK to start the database creation.

Note:  This may take some time as it goes through the different stages.

17. Click Exit when the database creation is complete.

The Oracle database that will be used for BigFix Remote Control is created.

Setting up database permissions
When you have created the Oracle database that will be used for BigFix Remote Control you will need to 

configure its permissions.

To configure the database permissions complete the following steps:

1. Run Oracle SQL*Plus.

Windows systems

For example: Click Start > Programs > Oracle-OraHomeName > Application 

Development > SQL Plus.

Alternatively, enter the following command at a command prompt.
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sqlplusw

Log on using the database user name and password and click OK. See your database 

system administrator if you do not have this.

For example:

Username - system

Password - dboracle

Linux systems

Open a UNIX or a Windows terminal and enter the SQL*Plus command:

sqlplus username / password @connect_identifier

username and password are the database credentials required to connect to the 

database.

connect_identifier is the connection required for your specific database.

For example, @TRCDB as SYSDBA

@//servername:port/DatabaseSID as SYSDBA

servername is the server name or IP address of the system where your Oracle 

installation is located.

port is the port of the system where your Oracle installation is located.

DatabaseSID is the SID defined for the database you created.

The SQL*Plus executable is installed in $ORACLE_HOME/bin, which is included in your 

operating system PATH environment variable. You may need to change directory to the 

$ORACLE_HOME/bin directory to start SQL*Plus.

2.

After SQL*Plus has started and connected to the database you can create the required users and 

grant permissions. There are two methods for creating users and granting permissions. Choose the 

appropriate method for creating the users.

Create one user ID in Oracle which will also be used to log on to BigFix Remote Control.

Create a single user. The user must be called Asset. This user ID is used by BigFix

Remote Control to create and log on to the database, and use the database.

Issue the following commands to create the user ASSET.

a. connect SYS/PASSWORD@DATABASE AS SYSDBA;
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where PASSWORD is the default Oracle user password.

and DATABASE is the database name that was defined when creating the 

database. For example, TRCBD.

b. CREATE USER ASSET IDENTIFIED BY PASSWORD DEFAULT TABLESPACE users 

TEMPORARY TABLESPACE temp;

Note:  PASSWORD can be changed to whatever you require, for the user ASSET.

c. GRANT UNLIMITED TABLESPACE TO ASSET;

d. GRANT CONNECT TO ASSET;

e. GRANT CREATE INDEXTYPE TO ASSET;

f. GRANT CREATE SEQUENCE TO ASSET;

g. GRANT CREATE TABLE TO ASSET;

h. GRANT CREATE TRIGGER TO ASSET;

i. GRANT CREATE INDEXTYPE TO ASSET;

j. GRANT CREATE PROCEDURE TO ASSET;

k. GRANT CREATE VIEW TO ASSET;

l. GRANT ANALYZE ANY TO ASSET;

Create a separate user ID to log on to BigFix Remote Control

Create 2 users. User 1 must be called Asset. This user has no specific permissions and 

is used only as a schema name. User 2 is the main user and can be called anything you 

require. This user is used by BigFix Remote Control to create and logon to the database, 

and use the database. Use the assistant tool to create user TRCDBU.

Complete the following steps to create the required permissions for user TRCDBU.

a. GRANT UNLIMITED TABLESPACE TO ASSET;

b. GRANT UNLIMITED TABLESPACE TO TRCDBU;

c. GRANT ALTER ANY INDEX TO TRCDBU ;

d. GRANT ALTER ANY INDEXTYPE TO TRCDBU ;

e. GRANT ALTER ANY PROCEDURE TO TRCDBU ;

f. GRANT ALTER ANY SEQUENCE TO TRCDBU ;

g. GRANT ALTER ANY TABLE TO TRCDBU ;

h. GRANT ALTER ANY TRIGGER TO TRCDBU ;

i. GRANT COMMENT ANY TABLE TO TRCDBU ;

j. GRANT CREATE ANY INDEX TO TRCDBU ;

k. GRANT CREATE ANY INDEXTYPE TO TRCDBU ;

l. GRANT CREATE ANY SEQUENCE TO TRCDBU ;

m. GRANT CREATE ANY TABLE TO TRCDBU ;
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n. GRANT CREATE ANY TRIGGER TO TRCDBU ;

o. GRANT CREATE INDEXTYPE TO TRCDBU ;

p. GRANT CREATE PROCEDURE TO TRCDBU ;

q. GRANT CREATE SEQUENCE TO TRCDBU ;

r. GRANT CREATE TABLE TO TRCDBU ;

s. GRANT CREATE TRIGGER TO TRCDBU ;

t. GRANT CREATE VIEW TO TRCDBU ;

u. GRANT DELETE ANY TABLE TO TRCDBU ;

v. GRANT INSERT ANY TABLE TO TRCDBU;

w. GRANT DROP ANY INDEX TO TRCDBU ;

x. GRANT DROP ANY INDEXTYPE TO TRCDBU ;

y. GRANT DROP ANY PROCEDURE TO TRCDBU ;

z. GRANT DROP ANY SEQUENCE TO TRCDBU ;

aa. GRANT DROP ANY TABLE TO TRCDBU ;

ab. GRANT DROP ANY TRIGGER TO TRCDBU ;

ac. GRANT EXECUTE ANY INDEXTYPE TO TRCDBU ;

ad. GRANT EXECUTE ANY LIBRARY TO TRCDBU ;

ae. GRANT EXECUTE ANY TYPE TO TRCDBU ;

af. GRANT SELECT ANY SEQUENCE TO TRCDBU ;

ag. GRANT SELECT ANY TABLE TO TRCDBU ;

ah. GRANT UNLIMITED TABLESPACE TO TRCDBU ;

ai. GRANT UPDATE ANY TABLE TO TRCDBU;

aj. GRANT ANALYZE ANY TO TRCDBU;

Setting up MSSQL

To set up MS SQL to use with BigFix Remote Control, create the database and then set up the database 

permissions.

Creating the database

Use the MS SQL management studio to complete the following steps:

Note:  During the installation of MS SQL, mixed mode authentication should have been set up.

1. Click Connect.

2. Right-click the server tree and click properties.

3. Select security.
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4. Ensure that SQL server and authentication mode is selected.

5. Expand the server tree.

6. Right-click databases.

7. Select Create New Database.

8. Enter a name for the database. For example, TRCDB. Click OK.

The default owner of the database is user sa, the system administrator. Create a new user, to be the 

owner of the database being used with BigFix Remote Control.

Database permissions

The default system administrator is the owner of the database and therefore has the required 

permissions for using the database. If you have created a new user, they also have the required 

permissions if they have been assigned as the owner of the database.

Installing by using the server installer
The BigFix Remote Control server installer can be used on Windows operating systems, Red Hat Linux

operating systems, and SUSE Linux operating systems. A fully functional self-contained server with either 

of the following component setup is installed.

• BigFix Remote Control server with WebSphere Application Server Liberty Profile version 16.0.0.2 and 

a Derby version  database.

• BigFix Remote Control server with WebSphere Application Server Liberty Profile version 16.0.0.2 and 

one of the following databases:

◦ IBM DB2 10.x, 11.x Workgroup(WSE) and Enterprise Edition(ESE).

◦ Oracle 11g and 12c.

When you use an Oracle database, if you are using the Oracle 11g drivers, set 

oracle.increment.keys.off=1 in the trc.properties file. Restart the server service.

◦ Microsoft SQL server 2008, 2012, 2014, and 2016.

You must use a JDBC driver whose version is bigger than 6.3. Older versions do not support 

TLS1.2 or JRE8.

When you use an MS SQL database, Windows authentication is not supported. You cannot log 

on with a domain user. You must use mixed mode authentication and create an SQL user to 

connect to the database.

For more information about the supported versions of the installed components, see Server requirements

(on page 9)



BigFix® Remote Control Installation Guide | 4 - Install the BigFix Remote Control components | 33

Note:  Click Cancel at any time to end the installation.

Approximate installation time

• Specifying options in the installer: 5 - 10 minutes.

• Installation of the software: 5 minutes.

1. A minimum screen resolution of 1024 by 768 pixels is recommended when you are using the installer.

2. On a Linux operating system, you must install libstdc++.so.5 when you are installing and configuring 

the operating system. If this package is not installed, you can install package compat-libstdc++-33, 

which contains libstdc++.so.5.

Note:  During the file copy phase of the server installation, a backup copy of any existing installation 

is saved. This feature is useful if a problem occurs with the installation when you are upgrading. The 

following directory is deleted if it exists.

[INSTALLDIR]/trcserver.bak.

The current server installation in [INSTALLDIR]/wlp/usr/servers/trcserver is then renamed or 

moved to [INSTALLDIR]/trcserver.bak.

You can access the backup directory to restore or recover anything from the previous installation.

To install the BigFix Remote Control server application, complete the following steps:

1. Run the server installation file relevant to your operating system.

Windows systems

trc_server_setup.exe

Linux systems

trc_server_setup.bin

To obtain the installation file see Obtain the installation files (on page 22).

2. Choose the language and click OK.

3. At the Introduction window click Next.

4. Click to accept both the IBM and non-IBM terms, click Next.

5. Accept the default location or click Choose to define a location for the installation files, click Next.

Note:  WebSphere Application Server cannot be installed in a directory with a name that contains 

non-English-language characters. This installation installs an embedded version of WebSphere
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Application Server. Therefore, you must choose a destination for the installation files that do not 

contain any non-English-language characters.

6. Select the database, click Next.

Note:  Derby is embedded in the application and is installed locally when you select Derby. To use 

DB2 or Oracle, you must install them and create a database instance before you install BigFix Remote 

Control.

7. Enter the options for your selected database and click Next.

Derby

a. Specify a name for the database, click Next. For example, TRCDB.

Note:  If you are using an existing database, you can choose to drop the 

database.

DB2

Database server

The IP address or host name of your database server.

Note:  127.0.0.1 can be used when DB2 is installed locally. If you 

install DB2 on a remote system, type the IP address of the remote system.

Port

Port on which DB2 is installed.

Note:

a. On Windows® systems, the default port is 50000. On Linux systems, 

the default port is 50001.

b. A remote DB2 installation is limited to type four connections. A local 

installation can use type two or four. For type two connections, set 

the port value to 0.

Administrator Userid

Specify the Administrator user ID that is used for logging on to the 

database. The user ID must have admin access to the database.

If you select create database, the user ID must have administrator access 

for DB2.

Administrator password
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Specify the Administrator password for connecting to the database.

Database Name

Specify a name for the database. For example, TRCDB.

Note:  If you are using a remote database, type the name of the 

database that was created on the remote system.

Directory path to db2jcc.jar file

Specify the path to the DB2 JAR files, db2jcc.jar, and 

db2jcc_license.jar

Note:  If you are using a remote database share the drive, on the 

remote system, that the DB2 JAR files are in. Enter the shared drive 

location.

Create database

If DB2 is installed locally (127.0.0.1), you can select to create a blank 

database during the installation. You can also select to drop an existing 

local database and create a new database.

Note:  Do not select create database or drop database if you are using 

a remote database.

Path for database install

Specify the path where the database can be installed. If the installation 

is local and you select to create the database, the admin user who is 

specified must have the appropriate authority. On a Windows system, use 

the db2admin user, and on a Linux system, the user must be a member of 

the group db2grp1.

Note:

Linux systems

Specify a directory that the admin User ID has read and write 

permissions for.

Windows systems

Specify a drive letter.

Oracle
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Database server

The IP address or host name of your database server. 127.0.0.1 can be 

used when Oracle is installed locally. If you install Oracle on a remote 

system, type in the IP address of the remote system.

Port

Port on which Oracle is installed.

Administrator Userid

Specify the administrator user ID that is used for logging on to the 

database. The user ID must have admin access to the database.

Note:  For an Oracle installation, a user that is called asset must exist. 

This user ID can be used here or use an existing or new user.

Administrator password

Specify the administrator password for connecting to the database.

Database Name

Specify a name for the database. The name is the SID name on the server, 

not the one in tnsnames.ora. For example, TRCDB.

Directory path to the oracle Java JDBC library

Specify the path to the oracle Java JDBC library. The location can 

be obtained from the Oracle server installation or downloaded from 

the Oracle website. For example, c:\oracle\ora92\jdbc\lib

\ojdbc14.jar

MSSQL

Database server

The IP address or host name of your database server.

Note:  127.0.0.1 can be used when MS SQL is installed locally on a 

Windows system only.

Port

Port on which MS SQL is installed.

Administrator Userid
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Specify the administrator user ID that is used for logging on to the 

database. The user ID requires admin access to the database.

Administrator password

Specify the administrator password for connecting to the database.

Database Name

Specify a name for the database. For example, TRCDB.

Directory path to the MS JDBC Java files

Specify the path to the MS JDBC Java files. The mssql-jdbc-

X.X.X.jre8.jar file must be used depending on the version of MS SQL 

database that you are using.

If installed on the same server, select to create database

If MS SQL is installed locally, you can select to create the database.

Drop the database if installed locally

Select if you already have an existing database with the name that is 

entered for Database Name that you do not want to use.

If local, select path where to create the database

Specify the database installation path. If the installation is local and you 

select to create the database the Admin user must have appropriate 

authority to do so.

Linux systems.

Specify a directory that the admin User ID has read and write 

permissions for.

Windows systems.

Specify an existing directory.

8. Specify the web server parameters then click Next.

Force targets to use HTTPS

Select this option for the target software to communicate with the server 

by using the HTTPS URL. The enforce.secure.endpoint.callhome and 

enforce.secure.endpoint.upload properties in the trc.properties file are also set to 

true. The check box is selected by default on a new installation.
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Regardless of your selection, the enforce.secure.web.access, 

enforce.secure.weblogon, and enforce.secure.alllogon properties that enable HTTPS 

logon and access to the web portal, are all set to True by default. For more information 

about these properties, see Set a secure environment the BigFix Remote Control 

Administrator's Guide.

Note:  If you are using HTTPS, you must use a fully qualified domain name for the 

server name.

Select whether the server and target software communicates by using 

HTTP or HTTPS. The check box is selected by default. Regardless of your 

selection, the enforce.secure.web.access, enforce.secure.endpoint.callhome, 

enforce.secure.endpoint.upload, enforce.secure.weblogon, and 

enforce.secure.alllogon properties that enable HTTPS logon and access to the web 

portal, are all set to True by default. For more information about how to configure a 

secure environment, see the BigFix Remote Control Administrator's Guide.

Note:  If you are using HTTPS, you must use a fully qualified domain name for the 

server name.

Use secure registration tokens to register targets

Select this option to enable the secure target registration feature. This feature prevents 

unauthorized targets from registering with the BigFix Remote Control server. The check 

box is selected by default on a new installation.  Ensure that the Force targets to use 

HTTPS option is also selected. For more information about secure registration, see 

Enable secure target registration (on page 114).

Upload data to server

The fully qualified name for the BigFix Remote Control server. For example, 

trcserver.example.com

Note:  You must make sure that you enter the fully qualified name. The name is 

used for creating the URL in the trc.properties file that is passed to the target after 

it contacts the server for the first time. If the fully qualified name is incorrect, the target 

might not be able to contact the server successfully when it is next due to contact it.

Web path of URL

Specify the web path for the server URL. For example, /trc.

Server port on Webserver (default 80)
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Specify a port for the server.

SSL Port (default 443)

Specify a port for SSL.

Administrator email

Specify an administrator email address. For example, admin@company.com.

Note:  To use the email function, you must install a mail server. Edit the 

trc.properties file after you install the BigFix Remote Control server. For 

more information about editing the properties files, see the BigFix Remote Control 

Administrator's Guide

Advanced port configuration

Select this option to change port values when you click Next. If any of the port values 

that are displayed are being used by other applications, change the value to avoid 

conflict.

Enable FIPS

Select this option to enable FIPS compliance on the server. For more information about 

enabling FIPS compliance, see Federal information processing standard (FIPS 140-2) 

compliance in BigFix Remote Control (on page 150) .

Enable NIST SP800-131A Compliance (Enables FIPS)

Select this option to enable NIST SP800-131A compliance on the server. For more 

information about enabling NIST SP800-131A compliance, see NIST SP800-131A 

compliance in BigFix Remote Control (on page 163).

9. Select the secure web settings parameters and click Next.

click for HTTPS / unclicked for HTTP

Select whether the server and target software communicates by using HTTP or HTTPS. 

Use HTTPS is the default value.

Note:  If you are using HTTPS, you must use a fully qualified domain name for the 

server name.

Enforce secure web access

An HTTP request that is not a call home, upload, or validation request is redirected to 

the secure URL. The value that is set in the secure.url property is used as a base.
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Selected

The HTTP request is redirected to the secure URL. This value is the 

default value.

Not selected

The HTTP request is not redirected to the secure URL.

Enforce secure callhome

Determines the URL that a target uses to contact the BigFix Remote Control server.

Selected

If a call home is received by using HTTP, the request is redirected to 

the secure URL. The secure URL is also returned in the response from 

the server. Targets are forced to use the secure URL when they send 

heartbeats to the BigFix Remote Control server. This value is the default 

value.

Not selected

Targets are not forced to use the secure URL when they send heartbeats 

to the BigFix Remote Control server. This value is the default value.

Note:  From BigFix Remote Control V9.1.3, HTTPS secure 

communication is enforced by setting the url property in the 

trc.properties file to HTTPS when Force targets to use https is 

selected during installation. To ensure HTTP target communication, 

confirm that the url property is set to the HTTP URL in the 

trc.properties file. If the url property is set to HTTPS, the targets use 

HTTPS after they first contact the server.

Enforce secure upload

Determines the URL that a target uses to contact the BigFix Remote Control server.

Selected

If an upload or a validation request is received by using HTTP, the server 

redirects the request to an equivalent URL. The equivalent URL is built 

with the value that is defined in secure.url as a base. It also uses the value 

of secure.url as a base to provide the upload and validation URLs to the 

controller and target when the session starts. This value is the default 

value.
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Not selected

The server does not redirect to the secure URL if an upload or a validation 

request is received by using HTTP.

Note:  From BigFix Remote Control V9.1.3, HTTPS secure 

communication is enforced by setting the url property in the 

trc.properties file to HTTPS when Force targets to use https is 

selected during installation. To ensure HTTP target communication, 

confirm that the url property is set to the HTTP URL in the 

trc.properties file. If the url property is set to HTTPS, the targets use 

HTTPS after they first contact the server.

Enforce secure web logon

Make the default log on action from the web UI use HTTPS. This property requires 

secure.url to be set with the full host name.

Selected

Logons from the BigFix Remote Control Server UI use HTTPS. Logons that 

use HTTP through another tool or page are not prevented.

HTTPS is not shown in the URL, but the logon page with USERID/

PASSWORD is posted as HTTPS. The secure.url parameter is used. If this 

property is set incorrectly, the logon does not succeed. This value is the 

default value.

Not selected

Log on by using HTTP or HTTPS, whichever is entered in the browser URL.

Enforce secure all logon

Force any logon action to use HTTPS, deny any logon that does not use HTTPS. This 

property requires secure.url to be set with the full host name.

Selected

Any logon attempt that uses HTTP is rejected and redirected to the logon 

page. This value is the default value.

Not selected

Log on by using HTTP or HTTPS, whichever is entered in the browser URL.
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10. Select options for your SSL certificate and click Next. The certificate configuration is stored in the 

ssl.xml file.

Use an auto generated certificate store

Select this option to use a self-signed certificate that is generated by the installer.

Note:  If the following options are not enabled, click Use an auto generated 

certificate store to enable them.

Overwrite an existing certificate store.

If a self-signed certificate store is already saved, the new certificate 

overwrites the saved certificate store. This option is the default option.

Password for a new or a previously generated certificate store.

Type a new password for the self-signed certificate. If you do not select to 

overwrite, type the password for your existing auto generated certificate 

store. If left blank, the default password TrCWebAS is saved as the 

password. The password must have a minimum of 6 characters.

Select an existing certificate store

Select this option to use an existing certificate store that is already saved.

Select existing certificate store location.

Click Choose to browse to the relevant certificate store. Select the 

certificate store. The file extension can be .jks or .p12.

When you use an existing certificate store, it is not copied to the 

installation directory during installation. The server software instance 

points to the location of the certificate store that you provide. Therefore, 

you must make sure that you save the certificate store to an adequate 

location on the server before you start the server installation. The 

certificate store must be stored in a location that does not get deleted. 

Therefore, do not save the file in the [installdir]\wlp directory or any 

of its subdirectories. Do not delete the certificate store at the end of the 

installation.

If you select a previously saved auto-generated certificate store from the 

server installation directory, a warning is displayed. Choose Copy file to 

copy the file to a location that is not deleted during the installation. If the 

file is not copied successfully, you must manually copy the certificate 



BigFix® Remote Control Installation Guide | 4 - Install the BigFix Remote Control components | 43

store file to another location. Click Choose and select the new location of 

the file.

Click Restore Default to reset the field value to its original value.

Enter the certificate store password.

Type a password for the certificate store.

11. Select options to configure Single-Sign-On (SSO) and click Next. The SSO configuration is stored in 

the sso.xml file.

Enable SSO

Select this option to enable Single-Sign-On (SSO). To continue with the configuration, 

you must get the SAML metadata XML file from the Identity Provider (IdP) and which 

hash algorithm they are using: SHA-1 or SHA-256. After the server starts, download the 

SP metadata and provide it to the IdP to establish federation between this SP and the 

IdP. Type the following URL in your browser to download the metadata: HTTPS://[rc-

server-url]:443/ibm/saml20/defaultSP/samlmetadata, where [rc-server-url]

is the URL of your remote control server. You must also add users to the remote control 

database so that they can log on by using SSO.

Metadata XML file

Click Choose and select the SAML metadata XML file that you obtained from the IdP.

Algorithm used to sign SAML messages

Select the signature algorithm (SHA-1 or SHA-256) to use to sign messages in 

communications between the Identity Provider (IdP) and this Service Provider (SP) 

which is the BigFix Remote Control Server.

Advanced parameters (optional)

Type in further configuration options, by adding attribute names in a space-separated 

list, in the following format: [keyword]="[keyword-value]". Where [keyword] is the 

attribute name and [keyword-value] is the attribute value. For more information 

about further configuration parameters, see SAML Web SSO 2.0 Authentication 

(samlWebSso20).

Force regeneration of SAML data. (you must re-register with the IdP)

The first time that you enable SSO, a new default SAML certificate keystore is created. 

For future upgrades, you can select the regeneration option to create a new default 

certificate keystore. The current keystore is deleted and the new one is saved. When 

http://www.ibm.com/support/knowledgecenter/SSAW57_liberty/com.ibm.websphere.wlp.nd.doc/ae/rwlp_config_samlWebSso20.html
http://www.ibm.com/support/knowledgecenter/SSAW57_liberty/com.ibm.websphere.wlp.nd.doc/ae/rwlp_config_samlWebSso20.html
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you select this option, you must reestablish the connection between the SP and the IdP 

after the server restarts.

12. Select a location for the product icons to be displayed.

If you select Other, click Choose to specify a location.

Note:  Product icons do not work when you are using Linux.

13. In the Summary pane, click Install.

14. If you selected to enable SSO, a pane that is labeled as Important is displayed. Take note of the URL 

and information and click Next.

15. Click DONE to complete the installation.

The BigFix Remote Control server software is installed including a set of properties files. These files can 

be edited to configure your environment.

Note:

1. It is important to make sure that the URL property in the trc.properties file contains the correct 

URL for the BigFix Remote Control server. This property is used when targets contact the server 

and for determining the server during a remote target installation. If the URL property value is not 

correct, the remote targets are not able to contact the server successfully. Therefore, you might have 

problems when you start remote control sessions with the targets.

2. If the IP address of the server changes at any time, make sure that you update the URL property in 

trc.properties. Restart the server service because the targets try to contact to the old IP address 

until the change to the property is made.

Installing on WebSphere Application Server version 8.5: deploying the war 
file
BigFix Remote Control includes a license for WebSphere Application Server v8.5.

This license can be used for installations on AIX systems since the option of using the embedded Liberty 

profile is not available for these systems. However, this option is also available to customers that prefer to 

use the WebSphere Application Server on Windows systems or Linux systems.

As described in the prerequisites section, a database needs to be created for BigFix Remote Control. After 

the database is created, add it to the WebSphere data sources.
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Setting up the application server

A regular installation of WebSphere 8.5 Base must be installed. Installation of the server war file 

requires the use of a Java 7 environment in the Application Server. For more information about the Java 

requirements, see http://www-01.ibm.com/support/docview.wss?uid=swg21976905

Note:  It is necessary to create the WebSphere profile in a folder that does not include any spaces in 

its path. Otherwise, unrecoverable issues might occur when you deploy the application war file.

Use the WebSphere Integrated Solution Console to configure the application server.

To access the Integrated Solution Console, complete the following steps:

1. In your browser type

https://[server : port]/ibm/console 

where server is the IPaddress or name for the application server machine 

for example localhost or 192.0.2.0 

and port is the port that the server is listening on. 

The default port for the WebSphere Application Server admin console is 9060.

2. Log on with the ID and password that you defined when you installed WebSphere.

DB2 configuration

Creating DB2 database authentication data
Creating authentication data for connecting to an BigFix Remote Control DB2 database

Credentials to use for the database connection need to be established and added as a new entry to the 

JAAS-J2C authentication data.

To create an entry complete the following steps:

1. Click Security > Global Security.

2. On the right of the screen, expand Java Authentication and Authorization Services .

3. Click J2C authentication data.

4. Click New to add a new entry.

http://www-01.ibm.com/support/docview.wss?uid=swg21976905
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5. Supply the following information:

Alias

Specify a name for the authentication alias.

Userid

Type the user ID that was defined when DB2 was installed. Can be one of the following 

users.

• The user who has permissions to access the TRCDB database, if a specific user 

was created.

• The DB2 owner instance, db2admin in a Windows system and db2inst1 in UNIX / 

Linux system.

Password

Type the password that you defined when you installed DB2.

6. Click OK.

7. Click Save.

Verifying the Websphere variables

The JDBC Provider uses WebSphere environment variables to define the paths to the JDBC driver JAR 

files.

• db2jcc.jar

• db2jcc-javax.jar

• db2jcc-license_cu.jar

• db2jcc4.jar. If available.

Verify that the correct values are defined by completing the following steps:

1. Select Environment / WebSphere Variables.

2. Click DB2UNIVERSAL_JDBC_DRIVER_PATH and verify that this points to the DB2 libraries.

Local DB2 database

If you have installed the DB2 database locally the files are located in

Windows systems

\Program Files\ibm\sqllib\java
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Linux systems

/opt/ibm/db2/VERSION/java

 where VERSION is the DB2 version number 

for example: /opt/ibm/db2/V8.1/java 

Remote DB2 database

If you are using a remote DB2 database you must copy the jar files from the remote 

system to a location on your local system and put the path to the local files here.

3. Click OK.

4. Click Save.

Creating the DB2 data source

When you have verified that the JDBC Provider is configured properly, the data source for BigFix Remote 

Control must be created using that JDBC Provider.

To create the data source complete the following steps:

1. Select Resources > JDBC > Data Sources.

2. Select the scope from the drop down menu that includes the node and the server. 

For example, Node=TEST-2008Node02, Server=server1.

3. Click New.

4. Specify the data source information.

a. Enter basic data source information

Data source name

Specify a name for the data source. This can be any required name.

JNDI Name

This should be set to jdbc/trcdb

Note:  If this name is changed, you need to change the common.properties file 

also.

b. Select JDBC Provider
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The data source will use the Universal JDBC Provider for DB2 that is predefined in WebSphere.

i. If DB2 Universal JDBC Driver Provider is available, select Select an existing JDBC provider

from the list. If it is not available, click Create new JDBC provider.

ii. In the Database type list, select DB2.

iii. Select DB2 universal JDBC Driver provider.

iv. From the Implementation type list, select Connection pool data source.

v. Click Next.

vi. Accept the default values and click Next.

c. Enter database specific properties for the data source

Driver Type

Select 4 from the list.

Database name

This is the name used when the db2 create db command was issued.

Server name

This is set to the IP or host name of the server where DB2 is installed. If DB2 is 

installed locally you can use localhost.

Port number

This is set to the port that was configured in DB2 for remote connections.

Click Next.

d. Setup security aliases

i. From the Component-managed authentication alias list, select your node/DB2 where your 

node is the node you previously created for DB2.

ii. Accept the default of none in the remaining lists.

iii. Click Next.

e. Review the summary and click Finish.

5. To save the configuration changes, click Save.

When the data source has been created and the changes to the profile are saved, test that the data source 

is correctly configured. Select the data source from the list of data sources and click Test connection. 

If the connection is successful, a conformation message is displayed. A failure in the test should be 

corrected before continuing with the installation, as BigFix Remote Control will not work without a valid 

data source.
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Oracle configuration

Creating Oracle database authentication data

Credentials to use for the database connection need to be established and added as a new entry to the 

JAAS-J2C authentication data.

To create an entry complete the following steps:

1. Click Security > Global Security.

2. On the right of the screen, expand Java Authentication and Authorization Services .

3. Click J2C authentication data.

4. To add a new entry, click New .

5. Supply the following information:

Alias

Specify a name for the authentication alias.

Userid

Type the ID that was defined when the Oracle database was created.This is the user 

that you created permissions for.

Password

Type the password that was defined when Oracle was installed.

6. Click OK.

7. Click Save.

Creating the Oracle JDBC provider

To establish access to your Oracle database you must create a JDBC provider for Oracle access.

To create the JDBC provider complete the following steps:

1. Select Resources > JDBC > JDBC Provider.
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2. Select Scope and choose the one which has Node and Server.

3. Click New.

4. Specify the JDBC provider information

Database type

Set to Oracle.

Provider Type

Set to Oracle JDBC Driver.

Implementation type

Set to Connection Pool datasource.

5. Click Next.

6. The Class path is already pre-populated as ${ORACLE_JDBC_DRIVER_PATH}/ojdbc6.jar. The 

directory location for ${ORACLE_JDBC_DRIVER_PATH} to the jar files must be correct. This can be 

obtained from the Oracle server installation or downloaded from the Oracle website. For example, C:

\app\Administrator\product\11.2.0\dbhome_1\jdbc\lib. Click Next.

7. Click Finish.

8. Click Save.

Verifying the Websphere variables

The JDBC Provider uses WebSphere environment variables to define the paths to the JDBC driver JAR 

files. Verify that the correct values are defined by completing the following steps:

1. Select Environment / WebSphere Variables.

2. Click ORACLE_JDBC_DRIVER_PATH

and verify that this points to the directory location chosen in step 6 (on page 50) in the Creating 

the Oracle JDBC Provider section.

3. Click OK.

4. Click Save.
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Creating the Oracle data source

When you have verified that the JDBC Provider is configured properly, the data source for BigFix Remote 

Control must be created using that JDBC Provider.

To create the data source complete the following steps:

1. Select Resources > JDBC > Data Sources.

2. Select the scope with Node and Server.

3. Click New.

4. Specify the data source information

a. Specify the data source information.

Data source name

Specify a name for the data source. This can be any required name.

JNDI Name

This should be set to jdbc/trcdb

Note:  If this name is changed, further changes to the common.properties file 

are also required.

Click Next.

b. Select JDBC provider

Click Select Existing JDBC provider and select Oracle JDBC Driver. Click Next.

c. Enter database specific properties for the data source.

URL

url=jdbc:oracle:thin@dbserver:1521:SID

where dbserver is the IP address of the server.

SID is the Oracle database SID.

Data store helper class name

Accept the default Data store helper class name, Oracle 11g.data store helper.

Accept remaining default selected values and click Next.

d. Set up security aliases
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i. Select Component-managed authentication alias and select the alias you previously 

created for Oracle.

ii. Accept the default of none in the remaining lists.

iii. Click Next.

e. On the summary screen, click Finish to create the data source.

5. Click Save.

You can select the newly created datasource and click Test, to test connectivity.

MS SQL configuration

Creating authentication data

Credentials to use for the database connection need to be established and added as a new entry to the 

JAAS-J2C authentication data.

To create an entry complete the following steps:

1. Click Security > Global Security.

2. On the right, expand  Java Authentication and Authorization Services .

3. Click J2C authentication data.

4. To add a new entry, click New.

5. Supply the following information:

Alias

Specify a name for the authentication alias.

Userid

Type the ID that was defined when MS SQL was installed. This is the user that you 

created permissions for. Default is sa.

Password

Type the password that was defined when MS SQL was installed.

6. Click OK.
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7. Click Save.

Creating the JDBC provider

To establish access to your MS SQL database you must create a JDBC provider for MS SQL access.

To create the JDBC provider complete the following steps:

1. Select Resources > JDBC > JDBC Provider.

2. Select Scope and choose the one which has Node and Server.

3. Click New.

4. Specify the JDBC provider information.

Database type

Set to SQL Server.

Provider Type

Set to Microsoft JDBC Driver .

5. Select Connection pool data source.

6. Click Next.

7. To accept the path to the jar files, click Next.

8. Click Finish.

9. Click Save.

Verifying the Websphere variables

The JDBC Provider uses WebSphere environment variables to define the paths to the JDBC driver JAR 

files. The correct jdbc driver software must be downloaded from Microsoft. The following version is 

recommended:

Microsoft JDBC Driver 4.0 for SQL Server - sqljdbc_4.0.2206.100_enu.exe

Download the SQL Server jdbc driver and copy it to the root drive of the server. Run the file to extract the 

driver. The sqljdbc4.jar file is extracted to the following directory structure:

C:\extract_path\sqljdbc_4.0\enu\
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where extract_path is the directory chosen when you unzipped the file.

Note:  The path cannot contain any spaces.

Verify that the correct values are defined by completing the following steps:

1. Select Environment / WebSphere Variables.

2. Click MICROSOFT_JDBC_DRIVER_PATH and verify that this points to the Microsoft SQL Server JDBC 

driver, sqljdcb4.jar file that you extracted.

3. Click OK.

4. Click Save.

Creating the MS SQL data source

When you have verified that the JDBC Provider is configured properly, the data source for BigFix Remote 

Control should be created using that JDBC Provider.

To create the data source complete the following steps:

1. Select Resources > JDBC > Data Sources.

2. Select the scope with Node and Server.

3. Click New.

4. Specify the data source information

a. Enter basic data source information

Data source name

Specify a name for the data source. This can be any required name.

JNDI Name

This should be set to jdbc/trcdb

Note:  If this name is changed, the datasource.context property in the 

common.properties must be changed after the WAR file is deployed. After the 

correct value is set, save the file and restart the application from the Websphere 

admin console.

b. Select JDBC provider

Select Microsoft SQL Server JDBC Driver or the required JDBC provider. Click Next.
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c. Enter database specific properties for the data source

Database name

This is the name used when you created the MS SQL database.

Port number

Port used when installing MS SQL. Default is 1433.

Server name

This is set to the IP or hostname of the server containing the MS SQL installation. If 

MS SQL is installed locally you can use localhost.

d. Set up security Alias

i. Select Component-managed authentication alias and select the alias you previously 

created for MS SQL.

ii. Accept the default of none in the remaining lists.

iii. Click Next.

e. On the summary screen, click Finish to create the data source.

5. Click Save.

Deploying the BigFix Remote Control application

After you install and set up the application server, deploy the application code for BigFix Remote Control

on the WebSphere server. You require the trc.war file that can be obtained by using the additional setup 

utility to extract the server installation media.

Note:

1. The heap size must be set to at least 512 MB for this type of installation.

To deploy the server application, complete the following steps:

1. Extract the trc.war file by using the additional setup utility. For details about the files that are 

required and for running this utility, see Utility for extracting the component installation files (on page 

111).

2. In the WebSphere administrative console complete the following steps:

a. Select Applications >  New Applications.
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b. Click New Enterprise Application.

c. Click browse and type the path to the trc.war file in a local or remote file system. Click Next.

d. On the Preparing for the application installation screen, select Fast path. Click Next

e. Step 1: Installation options

The default options can be left. The application name can be changed to something more 

descriptive but it must not contain any spaces. Click Next.

f. Step 2: Map modules to servers

Leave the default association to the server. Click Next.

g. Step 3: Map virtual hosts for Web modules

The default association to the default_host, virtual host can be changed. Click Next.

h. Step 4

Use /trc as the context root, otherwise further changes must be made in the 

trc.properties file. Click Next.

i. Step 5

A summary of the chosen deployment settings is displayed before the installation of the BigFix

Remote Control application proceeds.

Click Finish

A status page for the installation in progress and the outcome when the installation is finished is 

displayed.

j. Click Save to save to the master configuration.

The BigFix Remote Control application is displayed in the list of Enterprise Applications with the 

descriptive name that you entered in the Installation options step of the deployment process. Before 

you start the application, you can customize the trc properties file and change the default 

values. The properties files are deployed with the application and are in the installedApps

directory within WebSphere. For more information about the properties in the files, see the BigFix

Remote Control Administrator's Guide.

Note:  Ensure that the correct server IP address or server name is set in the URL field in the 

trc.properties file, so that the targets connect to the correct server. If you are using HTTPS, the host 

name or IP address that is set in the URL property must exactly match the value of the CN field of the 

SSL certificate that is installed on the server.
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Installing from the BigFix console

You can create and run a server installation task to install the server by using the BigFix console. For more 

information, see the BigFix Remote Control Console User's Guide and the chapter about Managing target 

and server configuration.

Install the target

The BigFix Remote Control target can be installed on every computer that you want to control remotely. 

You can also use it to start a remote control session over the internet, by using a broker to make the 

connection.

BigFix Remote Control provides two ways to install the target component. If you have access to the BigFix

console, use the deployment fixlets to deploy the target. For more information, see the BigFix Remote 

Control Console User's Guide. Alternatively use the BigFix Remote Control target installation files.

Installing the Windows target
The trc_target_setup.exe file is required to install the BigFix Remote Control target component on a 

Windows system.

For details of how to obtain the Windows component installation files see, Install the BigFix Remote 

Control components (on page 22). Choose the appropriate method for obtaining the file.

1. Run the trc_target_setup.exe file.

2. Click Next at the welcome screen.

3. Accept the license agreement. Click Next.

4. Accept the default location for the installation files, or click Change to select a different location.

5. Specify the host name of the BigFix Remote Control server that the target connects to.

For example, trcserver.example.com.

Note:  Select Use secure connections (https) if you selected to use HTTPS during the server 

installation.

6. On the Server Address window, for secure target registration, enter or paste the Registration token.
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Ensure that Use secure connections (https) is also selected. For more information about secure 

target registration, see Add a token for secure target registration (on page 115)

7. For advanced settings, click Advanced settings

Server port

The port must match the value that is entered for the Server port on Webserver

parameter during the server installation.

Server Context

The server context is used as part of the URL for contacting the server. It must 

match the value that is entered after the '/' in the Path to URL field, on the Web server 

parameters screen during the server installation.

Use a FIPS certified cryptographic provider

Select this option to enable FIPS compliance on the target. For more information about 

enabling FIPS compliance, see Enable FIPS compliance on the target (on page 159).

Enable NIST SP800-131A compliance (Enables FIPS)

Select this option to enable NIST SP800-131A compliance on the target. For more 

information about enabling NIST SP800-131A compliance, see NIST SP800-131A 

compliance in BigFix Remote Control (on page 163).

8. Click Next.

9. On the Proxy settings screen if you are not using a proxy server, click Next.

• To use a Proxy, select Use a proxy server or a Remote Control Gateway.

a. Type in the IP address or host name for the Proxy server.

b. Type in the port that proxy server is listening on.

c. Select whether you are using an HTTP proxy or a Remote Control Gateway.

d. Select Proxy requires authentication if you must authenticate with the proxy server. Enter 

the ID and password for authenticating to the proxy server. The user ID and password are 

automatically encrypted when the target starts. For more information about the automatic 

passphrase encryption, see the BigFix Remote Control Administrator's Guide. 

Note:  When you rerun the target installer and select Modify after the user ID and 

password are encrypted, the encrypted user ID and password combination is displayed in 

the user ID field. The password field remains empty.

e. Click Next.

10. Accept or change the port value to be used to listen for incoming remote control sessions. Click Next
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Note:  Your operating system might have a firewall that is installed by default. The inbound 

firewall rule for target port defaults to 888. Incoming TCP connections to that port must be open. If 

another port is configured instead for the BigFix Remote Control sessions, the same applies. Also, 

traffic on the localhost loopback address 127.0.0.1 between trc_base, trc_gui, and trc_dsp on 

arbitrary ports must be allowed.

11. To enable failover to peer-to-peer mode, select one of the following options:

Regardless of server status

A peer to peer session can be established between a controller and this target directly if 

the server is available or not. Click Peer to Peer policies to set the local policies for the 

target to use during a peer to peer session. Click Next  to move through the peer to peer 

policies screens.

Only when server is down or unreachable

A peer to peer session can be established only if the server is down or the target cannot 

connect to the server. Click Peer to Peer policies to set the local policies for the target 

to use during a peer to peer session. Click Next  to move through the peer to peer 

policies screens.

Never

A peer to peer session is not allowed directly between a controller and this target. If you 

select this option, continue from step 12 (on page 81).

Peer to Peer policies

Session policies options

Table 9. Session policies options.

Installation

option. Target Property.

Default

Value. Description

Active AllowActive Selected. Determines whether the target can take part in active

peer to peer sessions. For more information about the 

different types of remote control session that can be 

started, see the BigFix Remote Control Controller User's 

Guide.

Selected.

The target can take part in active peer to 

peer sessions and the Active option is avail­
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Installation

option. Target Property.

Default

Value. Description

able in the session type list in the controller

window. The Open connection window also

displays an Active option.

Not selected.

The target cannot take part in active peer to 

peer sessions and the Active option is not 

available in the session type list in the con­

troller window.

Guidance AllowGuidance Selected. Determines whether the target can take part in guidance

peer to peer sessions. For more information about the 

different types of remote control session that can be 

started, see the BigFix Remote Control Controller User's 

Guide.

Selected.

The target can take part in guidance peer to 

peer sessions and the Guidance option is 

available in the session type list in the con­

troller window. The Open connection win­

dow also displays a Guidance option.

Not selected.

The target cannot take part in guidance

peer to peer sessions and the Guidance op­

tion is not available n in the session type list 

in the controller window.

Monitor AllowMonitor Selected. Determines whether the target can take part in monitor

peer to peer sessions. For more information about the 

different types of remote control session that can be 

started, see the BigFix Remote Control Controller User's 

Guide.

Selected.

The target can take part in monitor peer to 

peer sessions and the Monitor option is 

available in the session type list in the con­
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Installation

option. Target Property.

Default

Value. Description

troller window. The Open connection win­

dow also displays a Monitor option.

Not selected.

The target cannot take part in monitor peer 

to peer sessions and the Monitor option is 

not available in the session type list in the 

controller window.

Enable high 

quality col­

ors

EnableTrueColor Not select­

ed.

Determines whether the target desktop is displayed in 

high-quality colors in the controller window at the start of 

a session. Used together with Lock color quality.

Selected.

The target desktop is displayed in true color

24-bit mode at the start of the session. Par­

tial screen updates are also enabled.

Not selected.

The target desktop is displayed in 8-bit col­

or mode at the start of the session. Partial

screen updates are also enabled. This value

is the default value.

Enable true 

color

EnableTrueColor Not select­

ed.

Determines whether true color is used as the initial color

depth to display the target desktop, in the controller win­

dow at the start of a session. Used along with Lock color

depth.

Selected.

The target desktop is displayed in true color

24-bit mode at the start of the session.

Not selected.

The target desktop is displayed in 8-bit col­

or mode at the start of the session. This 

value is the default value.
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Installation

option. Target Property.

Default

Value. Description

Lock color

quality

LockColorDepth Not select­

ed.

Determines whether the color quality that a remote con­

trol session is started with can be changed during the 

session. Used together with Enable high quality colors.

Selected.

The initial color quality, for the remote

control session, is locked and cannot be 

changed during the session. The Perfor­

mance settings icon is disabled in the con­

troller window. The controller user cannot

change settings to improve the session per­

formance if their network is slow.

Not selected.

The color quality can be changed during the 

session. The Performance settings icon is 

enabled in the controller window.

Lock color

depth

LockColorDepth Not select­

ed.

Determines whether the color depth that a remote control

session is started with can be changed during the ses­

sion. Used along with Enable true color.

Selected.

The initial color depth, for the remote

control session, is locked and cannot be 

changed during the session. The Enable

true color icon is disabled in the controller

window.

Not selected.

The initial color depth can be changed dur­

ing the session.

Remove

desktop

background

RemoveBackground Not select­

ed.

If the target has a desktop background image set, this 

property can be used to remove the background from 

view during a remote control session.

Selected.
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Installation

option. Target Property.

Default

Value. Description

The desktop background image on the tar­

get is not visible during a remote control

session.

Not selected.

The desktop background image on the tar­

get is visible during a remote control ses­

sion.

Stop screen 

saver up­

dates when 

screen saver 

is active

NoScreenSaver Not select­

ed.

Stops the target from sending screen updates when it de­

tects that the screen saver is active.

Selected.

While the screen saver is active on the tar­

get system, the target stops transmitting

screen updates. The controller displays a 

simulated screen saver, so that the con­

troller user is aware that a screen saver is 

active on the remote display. The controller

user can remove the screen saver by press­

ing a key or moving the mouse.

Not selected.

A simulated screen saver is not displayed

in the session window. The target screen is 

displayed as normal and the target contin­

ues to transmit screen updates.

Policies options

Table 10. Peer to peer policy descriptions -

Installer

screen

names. Target property.

Default

value. Description

Disable chat DisableChat Not se­

lected.

Determines whether you can start a chat session with the 

target and also chat to the controller user during a peer to 

peer session.
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Installer

screen

names. Target property.

Default

value. Description

Selected.

If ChatOnly is chosen as the connection type 

on the open connection screen, the session

is refused. During the session, the chat icon 

is not available in the controller window.

Not selected.

A Chat Only session can be started from the 

open connection window. During the session,

the chat icon is available in the controller

window.

Save chat 

messagess

AutoSaveChat Not se­

lected.

Determines whether the chat messages that are entered

during a chat session are saved.

Selected.

The chat messages are saved in an html file, 

in the working directory of the target. The lo­

cation is defined by the target property Work­

ingDir. The file name is prefixed with chat-. 

For example, on a Windows system, a file 

that is named chat-m15.html is saved to the 

following location.

c:\Documents and Settings\All 

Users\Application Data\IBM\Tivoli

\Remote Control

Not selected.

The chat messages are not saved to a file.

Disable file 

transfer from 

target to con­

troller

DisableFilePull Not se­

lected.

Determine whether files can be transferred from the target

to the controller during the session.

Selected.

Files can be transferred from the target to 

the controller.

Not selected.
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Installer

screen

names. Target property.

Default

value. Description

Files cannot be transferred from the target to 

the controller.

Disable file 

transfer from 

controller to 

target

DisableFilePush Not se­

lected.

Determines whether files can be transferred from the con­

troller to the target during the session.

Selected.

Files can be transferred from the controller

to the target.

Not selected.

Files cannot be transferred from the con­

troller to the target.

Disable clip­

board transfer

DisableClipboard Not se­

lected.

Determines the availability of the clipboard transfer menu. 

Use this menu option to transfer the clipboard content be­

tween the controller and target during a remote control

session.

Selected.

The clipboard transfer menu is available dur­

ing the session and you can transfer the clip­

board content to and from the target.

Not selected.

The clipboard transfer menu is not available

during the session.

Allow local

recording

AllowRecording Selected. Determines whether the controller user can make and save 

a local recording of the session in the controlling system.

Determines the availability of the record option on the con­

troller window. For more information about recording ses­

sions, see the BigFix Remote Control Controller User's 

Guide.

Selected.

The record option is available in the con­

troller window.
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Installer

screen

names. Target property.

Default

value. Description

Not selected.

The record option is not available in the con­

troller window.

Allow collabo­

ration

AllowCollaboration Selected. Determines whether more than one controller can join a 

session. Determines the availability of the collaboration

icon on the controller window. For details of collaboration

sessions, see the BigFix Remote Control Controller User's 

Guide.

Selected.

The collaboration icon is available in the con­

troller window.

Not selected.

The collaboration icon is not available in the 

controller window.

Allow session

handover

AllowHandover Selected. Determines whether the master controller in a collabora­

tion session can hand over control of the session to a new 

controller. Determines the availability of the Handover but­

ton on the collaboration control panel. For more informa­

tion about collaboration sessions, see the BigFix Remote

Control Controller User's Guide.

Selected.

The handover option is available in the col­

laboration control window.

Not selected.

The handover option is not available in the 

collaboration control window.

Allow re­

quests to dis­

connect exist­

ing session

AllowForceDiscon­

nect

Not se­

lected.

Determines whether a controller user is given the option

to disconnect a session with a target so that they can con­

nect to the target instead. Used with the Managed and 

CheckUserLogin properties. For more information about 
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Installer

screen

names. Target property.

Default

value. Description

disconnecting sessions, see the BigFix Remote Control

Controller User's Guide.

Selected.

A Disconnect session option is available in 

the message window that is displayed when 

you attempt to connect to the target.

Not selected.

A Disconnect session option is not available

when you attempt to connect to the target.

The CheckUserLogin property must be set to Yes and 

Managed set to No for AllowForceDisconnect to take ef­

fect.

Disconnect

grace time

ForceDisconnect­

Timeout

45 Number of seconds in which the current controller user 

must respond to the prompt to disconnect the current ses­

sion. If they do not respond on time, they are automatically

disconnected from the session. The timer takes effect only

when AllowForceDisconnect and CheckUserLogin are set 

to Yes. The default value is 45.

Audit to Appli­

cation Event 

Log

AuditToSystem Selected. Determines whether the actions that are carried out dur­

ing remote control sessions are logged to the application

event log on the target. This log can be used for audit pur­

poses.

Selected.

Entries are displayed in the application event 

log of the target corresponding to each ac­

tion carried out during the session.

Not selected.

No entries are logged to the application

event log.

Security policies
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Table 11. Peer to peer policy descriptions - Security policies.

Installer

screen names. Target property.

Default

Value. Description.

Authenticate by us­

ing Windows logon

CheckUserLogin Selected. Determines whether a logon window is displayed

when the controller user clicks a session type button

on the Open Connection window.

Yes

The logon window is displayed and the 

controller user must log on with a valid 

Windows ID and password. If the cre­

dentials are invalid, the target refuses

the session.

No

The user acceptance window does not 

appear and the peer to peer session is 

established.

Must be a member

of these Windows

groups

CheckUserGroup See de­

scription.

Default value.

Windows systems.

BUILTIN\Administrators

Linux systems.

wheel

When Authorized user group has a value set, the user 

name that is used for authentication must be a mem­

ber of one of the listed groups. Otherwise, the ses­

sion is refused. Multiple groups must be separated

with a semicolon. For example, wheel;trcusers.

Note:  By default, on a Windows system, only

the administrator user is granted access. On a Lin­

ux system, by default no users are granted access.

To resolve this issue, complete one of the following

steps.

a. If the users must also be granted administrator

rights, add them as members of the Administra­
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Installer

screen names. Target property.

Default

Value. Description.

tors group on a Windows system or the wheel 

group on a Linux system.

b. If the users must not have administrator rights, 

complete the following steps.

i. Create a group or use an existing group. For 

example, the following command might be 

run as root:

groupadd trcusers

.

ii. Add the users to this group. For example,

the following command might be run as root 

to add bsmith to trcusers.

usermod -a -G trcusers <bsmith>

iii. Add the group to the list in the Authorized

user group field.

Allow privacy AllowPrivacy Selected. Determines whether a controller user can lock the lo­

cal input and display of the target when in a remote

control session. Determines the visibility of the En­

able Privacy option on the controller window.

Selected.

The Enable Privacy option is available

in the Perform Action in target menu in 

the controller window.

Not selected.

The Enable Privacy option is not avail­

able in the Perform Action in target 

menu in the controller window.

Allow input lock AllowInputLock Selected. This property works with Allow privacy and on its 

own. Select Allow input lock  to lock the target users 

mouse and keyboard during a remote control ses­

sion.

Selected.
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Installer

screen names. Target property.

Default

Value. Description.

The lock target input menu item is en­

abled, in the Perform action in target

menu in the controller window. Select 

lock target input to lock the target

users mouse and keyboard during a re­

mote control session. The target screen 

is still visible to the target user.

Not selected.

The lock target input menu item is not 

enabled in the Perform action in target

menu in the controller window.

Note:  If Enable Privacy is selected during a ses­

sion, the remote user input is automatically locked. It 

is not possible to enable privacy without also locking

the input.

Enable privacy

when session

starts

EnablePrivacy Not select­

ed.

Determines whether the local input and display are 

locked for all sessions. Therefore, the target user 

cannot interact with the target screen during a re­

mote control session.

Selected.

The target screen is blanked out by the 

privacy bitmap when the session starts. 

The target user cannot interact with the 

screen during the session. The target

desktop is still visible to the controller

user in the controller window.

Not selected.

The target screen is not blanked out 

when the session starts and the target

user can interact with the screen.
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Installer

screen names. Target property.

Default

Value. Description.

Enable input lock 

when session

starts

EnableInputLock Not select­

ed.

This property works with Enable privacy. Use Enable

input lock to determine whether the target user can 

view their screen or not during a remote control ses­

sion when privacy mode is enabled.

Selected.

The target screen is visible to the target

user during the session, while in priva­

cy mode but their mouse and keyboard

control is locked.

Not selected.

The target screen is not visible to the 

target user and the privacy bitmap is 

displayed on the target during the ses­

sion. The target users mouse and key­

board are also disabled.

Note:  Enable privacy must be selected to allow

Enable input lock to take effect.

Enable on-screen 

session notifica­

tion

EnableOSSN Not select­

ed.

Determines whether a semi-transparent layer is 

placed onto the target screen. The layer displays

text that indicates that a remote control session is 

in progress. Can be used when privacy is a concern

so that the user is clearly notified when somebody re­

motely views or controls their PC.

Selected.

The semi-transparent layer is displayed

on the target screen. The text indicates

which type of remote control session is 

in progress. For example : BigFix Re­

mote Control - Active Mode. The layer

does not intercept keyboard or mouse 

actions. Therefore, the user is still able 

to interact with their screen.
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Installer

screen names. Target property.

Default

Value. Description.

Not selected.

A semi-transparent layer is not dis­

played on the target screen.

Note:  This policy is only supported on targets

where a Windows operating system is installed.

Disable Panic Key DisablePanicKey Not select­

ed.

Determines whether the target user can use the 

Pause Break key to automatically end the remote

control session.

Selected.

The target user cannot use the Pause 

Break key to automatically end the re­

mote control session.

Not selected.

The target user can use the Pause 

Break key to automatically end the re­

mote control session.

Inactivity timeout IdleTimeout 360 Number of seconds to wait until the connection ends 

if there is no session activity. Set this value to 0 to 

disable the timer so that the session does not end 

automatically. The minimum timeout value is 60 sec­

onds. For values 1 - 59, the session times out after 60 

seconds of inactivity.

Note:  The inactivity timeout value applies to Ac­

tive session mode only. The session does not end au­

tomatically when other session modes are used.

The default value is 360.

User acceptance policies
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Table 12. Peer to peer policy descriptions - User acceptance policies.

Installer

screen names. Target property.

Default

Value. Description.

Take over ses­

sion

ConfirmTakeOver Selected. Determines whether the user acceptance window is 

displayed when a remote control session is request­

ed.

Selected.

The user acceptance window is dis­

played to the target user who can accept

or refuse the session.

Not selected.

The user acceptance window is not dis­

played and the session is established.

Change session

mode

ConfirmMode­

Change

Selected. Determines whether the user acceptance window is 

displayed when the controller user selects a different

session mode from the session mode list on the con­

troller window.

Selected.

The user acceptance window is dis­

played each time a session mode 

change is requested. The target user 

must accept or refuse the request.

Not selected.

The user acceptance window is not 

displayed and the session mode is 

changed automatically.

File transfers ConfirmFileTransfer Selected. Determines whether the user acceptance window is 

displayed when the controller user transfers files be­

tween the target and the controller.

Selected.

The acceptance window is displayed

when the following options are selected.
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Installer

screen names. Target property.

Default

Value. Description.

The target user must accept or refuse 

the file transfer.

• The controller user selects pull file

from the file transfer menu on the 

controller window.

Note:  After they accept the re­

quest, the target user must select

the filethat is to be transferred.

• The controller user selects send file 

to controller from the Actions menu 

in the target window.

Not selected.

The acceptance window is not displayed

and files are transferred automatically

from the target to the controller system

when requested.

System informa­

tion

ConfirmSysInfo Selected. Determines whether the user acceptance window is 

displayed when the controller user requests to view 

the target system information.

Selected.

The user acceptance window is dis­

played when the controller user clicks 

the system information icon in the con­

troller window. The target user must ac­

cept or refuse the request to view the 

target system information.

Not selected.

The target system information is dis­

played automatically when the controller

user clicks the system information icon.

Local recording ConfirmRecording Selected. Determines whether the user acceptance window is 

displayed when the controller user clicks the record 

icon on the controller window.
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Installer

screen names. Target property.

Default

Value. Description.

Selected.

A user acceptance window is displayed

when the controller user clicks the 

record icon on the controller window. If 

the target user clicks Accept, the con­

troller user can select where to save the 

recording to. If the target user clicks 

Refuse, a refusal message is displayed

to the controller.

Note:  After the target user accepts

the request for recording, the accep­

tance window is not displayed again 

if the controller user stops and then 

restarts local recording in the same ses­

sion. Also, the refusal message is dis­

played in English and is not translated.

Not selected.

When the controller user clicks the 

record icon on the controller window,

the user acceptance window is not dis­

played. The controller user can then se­

lect where to save the recording to.

Collaboration ConfirmCollabora­

tion

Selected. Determines whether the user acceptance window is 

displayed when another controller user requests to 

join a collaboration session with a target.

Selected.

The user acceptance window is dis­

played when the controller user tries to 

join the collaboration session. The tar­

get user must accept or refuse the re­

quest. If the target user clicks Accept, 

the additional controller joins the collab­

oration session. If they click Refuse, a 
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Installer

screen names. Target property.

Default

Value. Description.

message is displayed on the controller

and the additional controller cannot join 

the collaboration session.

Not selected.

The additional controller automatically

joins the collaboration session.

User acceptance

grace time

AcceptanceGrace­

Time

45 Sets the number of seconds to wait for the target user 

to respond before a session starts or times out. Used 

with Take over session.

• Acceptable values 0 - 60 - If set to 0 the activity

starts without displaying the message box for 

user acceptance on the target.

Note:  If Take over session is selected, User ac­

ceptance grace time must be set to a value >0 to al­

low the target user time to respond.

Proceed on ac­

ceptance timeout

AcceptanceProceed Not select­

ed.

Continue with the session if the user acceptance time­

out lapses. The target user does not click accept or 

refuse within the number of seconds defined for Ac­

ceptance grace time.

Selected.

The session starts.

Not selected.

The session does not start.

Do not prompt 

for user accep­

tance when user 

is not logged on.

AutoWinLogon Selected. Determines whether a session can be started when 

no users are logged on at the target. Determines

whether the user acceptance window is displayed on 

the target, at session start, when the target user is not 

logged on.

Selected.

Session is started with the target.The 

acceptance window is not displayed
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Installer

screen names. Target property.

Default

Value. Description.

on the target and the session is estab­

lished.

Not selected.

Session is not started and the following

message is displayed. Session reject­

ed because there is no user logged 

to confirm the sessionThe session

is refused because the target user is not 

logged on and therefore cannot accept

the session request.

Enable Hide win­

dows

HideWindows Not select­

ed.

Determines whether the Hide windows check box is 

displayed on the user acceptance window when Con­

firm incoming connections is also selected.

Selected.

The Hide windows check box is dis­

played on the user acceptance window.

Not selected.

The Hide windows check box is not dis­

played on the user acceptance window.

Session scripts

Table 13. Peer to peer policy descriptions - Session scripts policies.

Installer

screen names. Target property.

Default

Value. Description.

Run pre-session

script

RunPreScript Not select­

ed.

Determines whether a user-defined script must be 

run before the remote control session starts. It is run 

just after the session is authorized but before the con­

troller user has access to the target. The outcome of 

running the script and the continuation of the session

is determined by the value set for Proceed on pre/

post-script failure.

Selected.
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Installer

screen names. Target property.

Default

Value. Description.

When a remote control session is re­

quested, the defined script is run before

the controller user has access to the tar­

get.

Not selected.

No script is run before the session.

For details of setting up pre-session scripts and post 

session scripts, see the Session policies chapter in the 

BigFix Remote Control Administrator's Guide.

Run post-session

script

RunPostScript Not select­

ed.

Determines whether a user-defined script is run after

the remote control session finishes.

Selected.

When a remote control session ends, the 

user-defined script is run.

Not selected.

No script is run after the session.

For details of setting up pre and post session scripts, 

see the Session policies chapter in the BigFix Remote

Control Administrator's Guide.

Proceed with ses­

sion when script 

fails

ProceedOnScript­

Fail

Not select­

ed.

Continue with the session if the pre-script or post 

script execution fails. A positive value or 0 is consid­

ered a successful run of the pre-script or post session

script. A negative value, a script not found error, or a 

script that does not finish within 3 minutes is consid­

ered a failure.

Selected.

If the pre-script or post script run fails, 

the session continues.

Not selected.
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Installer

screen names. Target property.

Default

Value. Description.

If the pre-script or post script run fails, 

the session does not continue ends im­

mediately.

For the definition and more information about the properties, see Properties that can be 

set in the target configuration (on page 196).

Session policies options

Table 14. Session policies options.

Installation

option. Target Property. Default Value.

Active AllowActive Selected.

Guidance AllowGuidance Selected.

Monitor AllowMonitor Selected.

Enable high quality colors EnableTrueColor Not selected.

Enable true color EnableTrueColor Not selected.

Lock color quality LockColorDepth Not selected.

Lock color depth LockColorDepth Not selected.

Remove desktop background RemoveBackground Not selected.

Stop screen saver updates

when screen saver is active

NoScreenSaver Not selected.

Policies options

Table 15. Policy descriptions -

Installer screen

names. Target property. Default value.

Disable chat DisableChat Not selected.

Save chat messagess AutoSaveChat Not selected.

Disable file transfer from target to 

controller

DisableFilePull Not selected.
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Installer screen

names. Target property. Default value.

Disable file transfer from con­

troller to target

DisableFilePush Not selected.

Disable clipboard transfer DisableClipboard Not selected.

Allow local recording AllowRecording Selected.

Allow collaboration AllowCollaboration Selected.

Allow session handover AllowHandover Selected.

Allow requests to disconnect ex­

isting session

AllowForceDisconnect Not selected.

Disconnect grace time ForceDisconnectTimeout 45

Audit to Application Event Log AuditToSystem Selected.

Security policies

Table 16. Security policies.

Installer screen names. Target property. Default Value.

Authenticate by using Windows logon CheckUserLogin Selected.

Must be a member of these Windows

groups

CheckUserGroup See description.

Allow privacy AllowPrivacy Selected.

Allow input lock AllowInputLock Selected.

Enable privacy when session starts EnablePrivacy Not selected.

Enable input lock when session starts EnableInputLock Not selected.

Enable on-screen session notification EnableOSSN Not selected.

Disable Panic Key DisablePanicKey Not selected.

Inactivity timeout IdleTimeout 360

User acceptance policies

Table 17. User acceptance policies.

Installer screen names. Target property. Default Value.

Take over session ConfirmTakeOver Selected.
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Installer screen names. Target property. Default Value.

Change session mode ConfirmModeChange Selected.

File transfers ConfirmFileTransfer Selected.

System information ConfirmSysInfo Selected.

Local recording ConfirmRecording Selected.

Collaboration ConfirmCollaboration Selected.

User acceptance grace time AcceptanceGraceTime 45

Proceed on acceptance timeout AcceptanceProceed Not selected.

Do not prompt for user acceptance

when user is not logged on.

AutoWinLogon Selected.

Enable Hide windows HideWindows Not selected.

Session scripts

Table 18. Session scripts policies.

Installer screen names. Target property. Default Value.

Run pre-session script RunPreScript Not selected.

Run post-session script RunPostScript Not selected.

Proceed with session when script fails ProceedOnScriptFail Not selected.

Additional Features

Select Install device driver for Virtual Smart Card Reader to install the virtual smart 

card reader driver. For more information about the smart card reader driver, see Install a 

driver to support smart card authentication in the target (on page 121).

12. Click Install  to begin the installation.

13. When the installation is complete, click Finish.

Installing the Linux target
You can install the target component on a Linux computer by using the RPM file that is provided in the 

BigFix Remote Control installation files.
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Note:  The target, CLI, gateway, and broker component installation packages depend on the 32-bit 

version of the following libraries. For all components, glibc and libblkid. Also, for the target component, 

libgcc, libXmu, libXtst, libXp, libXi, libXScrnSaver, and libXinerama. Therefore, you must ensure that the 

libraries are installed.

Use the ibm-trc-target-9.x.x.i386.rpm file to install the target component in Linux, where 9.x.x 

is the version that you want to install. For more information about how to obtain the Linux component 

installation files, see Obtain the installation files (on page 22). Choose the appropriate method for 

obtaining the file.

Install a default target RPM file and then configure the target after the installation.

Note:  If you are using Red Hat Enterprise Linux 6.0 64-bit the following libraries along with their 

dependencies, need to be installed if they are not already installed, glibc.i686, libgcc.i686, libXmu.i686, 

libXtst.i686, libXp.i686, libXi.i686, libXScrnSaver.i686.

Note:  The installation package depends on the 32-bit version of the following libraries, glibc, libgcc, 

libXmu, libXtst, libXp, libXi, libXScrnSaver, libXinerama, and libblkid. Therefore, you must ensure that the 

libraries are installed.

To install the RPM file, run the following command and use the file specific to the version that you want to 

install. For example,

rpm -ivh ibm-trc-target-9.1.2.i386.rpmrpm -ivh ibm-trc-target-9.1.3.i386.rpmrpm -ivh ibm-trc-

target-9.1.4.i386.rpm

When the target is installed, configure the target properties by editing the /etc/ibmtrct.conf file. For 

more information about target properties and their definitions, see Installing the Windows target (on page 

57)Properties that can be set in the target configuration (on page 196).

Install the BigFix Remote Control Target for macOS
You can install the BigFix Remote Control Target for macOS in numerous ways. Use the 

trc_target.pkg file to install the application in attended or unattended mode. You can also install the 

target by using a Fixlet® in the BigFix console.

For information about how to obtain the BigFix Remote Control Target for macOS component installation 

files, see Install the BigFix Remote Control components (on page 22). Choose the appropriate method 

for obtaining the file.
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Installing the BigFix Remote Control Target for macOS from the BigFix
console
You can use a Fixlet in the BigFix console to install the BigFix Remote Control Target for macOS

component. The deployment Fixlet is available in the Remote Control site in the Systems Lifecycle 

domain.

Note:  An option to select managed mode, which prompts for a server URL and a secure registration 

token, is not available because managed mode is not supported on the BigFix Remote Control Target for 

macOS.

To install the BigFix Remote Control Target for macOS target component, complete the following steps.

1. Within the Systems Lifecycle domain, expand Remote Control configuration > Remote Control.

2. Expand the Deployment node.

3. Select macOS.

4. Select Deploy BigFix Remote Control Target for macOS.

5. In the Task pane, review the description and follow the instructions in the Actions box to start the 

task.

6. In the Take Action pane on the Target tab, select the relevant option for determining the computers 

on which to deploy the BigFix Remote Control Target for macOS component.

7. Click OK.

The summary screen shows the progress of the task and the status is set to Complete when it is 

finished.

Installing the BigFix Remote Control Target for macOS by using the .pkg file
You can use the trc_target.pkg file to install the BigFix Remote Control Target for macOS.

You can obtain the pkg file from Passport Advantage or from the BigFix Remote Control server UI. For 

more information, see Obtain the installation files (on page 22). Two installation methods can be used 

when you have the pkg file: attended and unattended.

You can also apply custom configuration settings when you install the target. The configuration values 

are set in the trc_target.cfg file. Create the file and add your custom values. Copy the file to 
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the computers on which you want to install the BigFix Remote Control Target for macOS. Copy the 

trc_target.cfg file to the same directory as the trc_target.pkg file.

Your configuration settings are installed together with the target. The target configuration is installed to /

Library/Preferences/com.ibm.bigfix.remotecontrol.target.plist.

To configure the target to support broker sessions, you must configure the BrokerList property and 

provide trusted certificates. Place a broker.certs file, that contains the trusted certificates in the same 

directory as the trc_target.pkg file. The package installs the broker.certs file to

/Library/Application Support/com.ibm.bigfix.remotecontrol.target/TrustStore.

For more information about the target properties that can be set in the .cfg file, see Properties that can 

be set in the target configuration (on page 196).

If you do not apply any custom configuration, the target uses built in configuration settings when it 

installs.

Choose an installation method for installing the BigFix Remote Control Target for macOS.

Attended Mode:

1. Double-click the  trc_target.pkg file.

2. Click Continue.

3. Click Install to install to the startup disk. If your system has multiple disks, you can select the disk on 

which to install the target. Click Change Install Location to select an installation disk.

4. If you are a user with admin authority, type in your password when prompted. Otherwise, type a valid 

admin ID and password. Click Install Software.

5. When the installation completes, click Close.

Unattended mode:

1. Open a Terminal window and type the following command.

sudo installer -pkg "/[path]/trc_target.pkg" -target /

Where [path] is the path to the .pkg file.

After you install the .pkg file, open the Remote Control Target.app to start the target.

Run a target custom installation
Run an BigFix Remote Control target custom installation to install the target software by using 

parameters. You can run the installation in multiple ways.
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Unattended and silent

No interaction is required by the user and no UI dialogs or progress bars are displayed to the 

user.

Unattended

No interaction is required by the user and an installation progress bar is displayed to the 

user.

Attended

The full installation UI is displayed and requires user interaction.

You can customize installation settings and also assign the target to a specific group during the 

installation.

Running a target custom installation on a Windows system
To install the target software on a Windows operating system, use the trc_target_setup.exe file.

For more information about obtaining this file, see Obtain the installation files (on page 22).

To install the target, complete the following steps:

1. Create a folder in your root drive called IBMTRC.

2. Copy trc_target_setup.exe to IBMTRC.

3. Open a command prompt window and go to IBMTRC.

4. Type DIR to verify that the exe file is in this folder.

5.

To install the target, type the following command in one line.

trc_target_setup.exe /s /v"/qn [INSTALLPARAMETER1][INSTALLPARAMETER2]...[INSTALLPARAMETERX]"

Use the following installation parameters customize your installation.

Note:  Ensure that the correct values are assigned to the parameters as no validation of the 

values is carried out.

/s

Denotes a silent installation.

/v"
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The string that is attached to /v contains the parameters for msiexec.exe, which is a 

piece of software that runs the installation.

/qn

Run a silent and unattended installation with no progress window and no UI.

You can also replace /qn with the following parameters.

/qb

For an unattended installation with a basic UI and a small progress bar.

/qr

For an unattended installation with a reduced UI progress bar in a large 

window.

/qf

For an attended installation with full UI.

TRC_SERVER_HOSTNAME

The host name or IP address of the server. This property is required. Default value is 

<blank>.

For example, TRC_SERVER_HOSTNAME=trc.myserver.com.

TRC_SERVER_CONTEXT

This parameter value must match the last part of the path in the server URL. Default 

value is trc.

For example, TRC_SERVER_CONTEXT=trc.

TRC_SERVER_PORT

If the server runs on a non-standard port, specify the port number. Default value is 80.

For example, TRC_SERVER_PORT=8080.

TRC_SERVER_PROTOCOL

Choose between plain HTTP and secure HTTPS protocols. Valid values are http and 

https. Default value is http.

For example, TRC_SERVER_PROTOCOL=http.

TRC_PROXY_HOSTNAME

Host name or IP address for the proxy server, if you are using one. Default value is 

<blank>.
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For example, TRC_PROXY_HOSTNAME=proxy.company.com.

TRC_PROXY_PORT

Port number for the proxy server. Default value is <blank>.

For example, TRC_PROXY_PORT=8080.

TRC_PROXY_USER_ID

The user ID, if the proxy requires authentication. Default value is <blank>. The 

user ID and password are automatically encrypted when the target starts, unless 

DISABLEAUTOMATICPASSPHRASEENCRYPTION is set to Yes. For more information 

about automatic passphrase encryption, see the BigFix Remote Control Administrator's 

Guide.

For example, TRC_PROXY_USER_ID=proxyuser.

TRC_PROXY_PASSWORD

The password, if the proxy requires authentication. Default value is <blank>. The 

user ID and password are automatically encrypted when the target starts, unless 

DISABLEAUTOMATICPASSPHRASEENCRYPTION is set to Yes. For more information 

about automatic passphrase encryption, see the BigFix Remote Control Administrator's 

Guide.

TRC_PROXY_PASSWORD=v264xmpt.

TRC_PROXY_AUTH_B64

The user ID and password, format user: password, encoded in base64. Overrides the 

user ID and password properties. If you do not want the password to be easily visible, 

use this parameter. Base64 is not encryption. Default value is <blank>.

For example, TRC_PROXY_AUTH_B64=cHJveHl1c2VyOnYyNjR4bXB0

The user ID and password are automatically encrypted when the target starts, unless 

DISABLEAUTOMATICPASSPHRASEENCRYPTION is set to Yes. For more information 

about automatic passphrase encryption, see the BigFix Remote Control Administrator's 

Guide.

TRC_TARGET_PORT

To run the target on a non-standard port, specify the port number to use. Default value 

is 888.

For example, TRC_TARGET_PORT=888.

TRC_SERVER_HEARTBEAT_RETRY
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The amount of time, in minutes, that the target waits before it resends a heartbeat to 

the server, when the server is not responding. Default value is 10.

For example, TRC_SERVER_HEARTBEAT_RETRY=1.

TRC_ACCESSIBILITY

Enables the accessible UI. Default value is No. Available on Windows operating system.

GROUP_LABEL

The name of the group that the target is to be assigned to. To enable this feature, 

edit the trc.properties file and set allow.target.group.override = true. For 

more information about editing the properties files, see the BigFix Remote Control 

Administrator's Guide. Default value is DefaultTargetGroup.

Note:

a. The GROUP_LABEL parameter is discarded if the target is already registered in the 

BigFix Remote Control server.

b. The target group that is specified must already be defined on the server.

For example, GROUP_LABEL=NewTargetGroup.

INSTALLDIR

Use this parameter to specify the directory for installing the target software to.

For example, INSTALLDIR= c:\trc\target.

ALLOWP2P

Use this parameter to enable peer to peer connections regardless of the server status. 

Default value is No.

ALLOWP2PFAILOVER

Use this parameter to enable failover to peer-to-peer mode when the server is down or 

unreachable. Default value is No.

AUDITTOSYSTEM

Use this parameter to log peer to peer session events in the targets application event 

log for auditing purposes. Default value is No.

AUTOSAVECHAT

Use this parameter to save the contents of the chat window to a file on the target. 

Default value is No.

AUTOWINLOGON
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Determines whether a session can be started when no users are logged on at the 

target. Determines whether the user acceptance window is displayed on a target where 

the user is not logged on. Default value is Yes.

CHECKUSERGROUP

The controller user must be a member of the listed groups. Default value is BUILTIN

\Administrators on Windows systems and wheel on Linux systems.

CHECKUSERLOGIN

Determines whether the login window is displayed when the controller user selects a 

session type in the Open Connection window. Default value is Yes.

CONFIRMFILETRANSFER

Determines whether the user acceptance window is displayed before the controller user 

transfer files from the target to the controller in a peer to peer session. Default value is 

Yes.

CONFIRMMODECHANGE

Determines whether the user acceptance window is displayed when the controller user 

selects a different session mode during the remote control session. Default value is 

Yes.

CONFIRMSYSINFO

Determines whether the user acceptance window is displayed when the controller user 

requests to view the target system information. Default value is Yes.

CONFIRMTAKEOVER

Determines whether the user acceptance window is displayed when a peer to peer 

session is requested. Default value is Yes.

DISABLEAUTOMATICPASSPHRASEENCRYPTION

Determines whether the proxy authentication user ID and password are automatically 

encrypted when the target starts. Default value is No. For more information about 

automatic passphrase encryption, see the BigFix Remote Control Administrator's 

Guide.

DISABLECHAT

Determines whether you can start a chat session with the target and also chat to the 

controller user during a peer to peer session. Default value is No.

DISABLECLIPBOARD
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Determines the availability of the clipboard transfer menu during a peer to peer session. 

Default value is No.

DISABLEFILEPULL

Determines whether you can transfer files from the target to the controller during a peer 

to peer session.

DISABLEFILEPUSH

Determines whether you can transfer files from the controller to the target during a peer 

to peer session. Default value is No.

DEBUGTRACE

Enable debug logging. Debug messages are written to the target log file that can be 

used for problem determination. Default value is No.

FIPSCOMPLIANCE

Enable the use of a FIPS certified cryptographic provider for all cryptographic functions. 

Default value is No.

SP800131ACOMPLIANCE

Enable the use of NIST SP800-131A compliant algorithms and key strengths for all 

cryptographic functions. Default value is No.

HTTPSSTRICTVALIDATION

Determines whether the target uses the system truststore to verify HTTPS connections 

to the server. Default value is No.

LOGLEVEL

Set the logging level. The logging level determines the types of entries and how much 

information is added to the target log file. Possible values 0, 1, 2, or 4. However, use 

LOGLEVEL=4 only by request from IBM software support. Default value is 2.

For example, LOGLEVEL=2.

LOGROTATION

Controls the period after which an older log file is overwritten. Set to Daily, Weekly, or 

Monthly. Default value is Weekly.

For example, LOGROTATION=Monthly.

You can also disable log rotation by using the value Disabled.
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LOGROLLOVER

Controls the period after which a new log file is started. Therefore, this period must be 

shorter than the LOGROTATION period, not all combinations are valid. LOGROLLOVER 

cannot be disabled. Set to Daily or Hourly. Default value is Daily.

For example, LOGROLLOVER=Daily.

VSC

Use the parameter to install the device driver for the IBM virtual smart card reader. Add 

VSC=1 to the parameter list to install the driver.

Note:  The appearance of VSC in the parameter list determines whether the driver is 

installed, not the value of the parameter. If VSC= n is in the parameter list, the driver is 

installed. If VSC is not in the parameter list, the driver is not installed. VSC can have any 

value. However, VSC=1 is the suggested value.

For more information about installing the device driver for the IBM virtual smart card 

reader during a silent installation, see Installing the virtual smart card reader driver by 

running a silent installation (on page 123).

REGISTRATIONTOKEN

Use this parameter to provide the registration token to the target. The token is used to 

authenticate the target to the server when it first contacts the server. The value of the 

property is set to the registration token. For more information about installing the target 

with a secure registration token by running a silent installation, see Running a target 

silent installation with a secure registration token (on page 117).

Note:  To reconfigure the parameters on an existing target installation, use the parameter, 

REINSTALL=ALL. However, the parameter is ignored if it is used when you upgrade the target.

For example, on the command line you can type the following command:

trc_target_setup.exe /s /v"/qn REINSTALL=ALL"

To modify the target configuration and apply an upgrade, complete the following steps.

1. Perform a silent installation with the new version of target software. Do not use any parameters. If 

you do use parameters, the target is upgraded but the parameters are ignored and are not updated.

2. Perform a silent re installation with REINSTALL=ALL and any new parameters.
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You can also specify the parameters that you want to override.

For example, to change the target port to 2222, type the following command.

trc_target_setup.exe /s /v"/qn TRC_TARGET_PORT=2222 REINSTALL=ALL"

Note:  To view Help options during the installation, type the following command on the command line. 

trc_target_setup.exe --help

Installing and configuring the target using the RPM file
RPM (Red Hat Package Manager) is the most common software package manager used for Linux

distributions.

The following instructions will allow you to customise and build the BigFix Remote Control target RPM 

file.

Note:  If you have the target CLI package already installed on the target you must uninstall this before 

installing the target software by running the following command

$ rpm -e ibm-trc-cli

Configuring the BigFix Remote Control RPM build tree

The RPM build tree is where building an RPM takes place. By default, this tree is under /usr/src, but this 

requires building as the root user. It is recommended that you create your own RPM build tree.

Use the following steps to configure the RPM build tree in src/rpm in your home directory.

Type the following commands to configure the RPM build tree :

1. $ mkdir -p ~/src/rpm

2. $ cd ~/src/rpm

3. $ mkdir BUILD RPMS SOURCES SPECS SRPMS

4. $ mkdir RPMS/i[3456]86 RPMS/noarch RPMS/athlon

5. To override the default location of the RPM build tree, create or edit .rpmmacros in your home 

directory,

or use the following command.

$ echo -e "%_topdir\t${PWD}" > ~/.rpmmacros
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Note:  this command overwrites the .rpmmacros file.

6. To verify that the configuration was successful, check that the following command gives the correct 

path to the SOURCES directory.

$ rpm --eval %_sourcedir

For example: /home/yourusername/src/rpm/SOURCES

Obtaining the BigFix Remote Control Target Source RPM package

The source RPM package is obtained from the installation files. By default, this package will extract the 

install files for the target to the IBM/Tivoli_Remote_Control  directory inside your home directory.

Installing the Source RPM package

Installing a source RPM package installs the files that are needed to build or rebuild the package into the 

RPM build tree.

Use the following command to install the package for the Target:

$ rpm -ivh ~/IBM/Tivoli_Remote_Control/RCTarget/ibm-trc-target-9.x.x.src.rpm 

Where 9.x.x is relevant to the version that you want to install. For example, 9.1.0.

Note:  This command might generate warnings about users and groups that do not exist. These 

warnings are because your system does not have the user and groups that were used to build the original 

package. You can ignore these warnings.

Examples of the warning messages:-

Warning: user user name does not exist - using root

Warning: group build does not exist - using root

Warning: group trc_build does not exist - using root

To verify that this step was successful, check the SPECS and the SOURCES directories and make sure that 

the following files are there:

$ ls SPECS/ SOURCES/

SOURCES/:ibm-trc-target.tar

SPECS/: ibm-trc-target.spec
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Customizing the SPEC file

To make sure that you can tell the customized package apart from the original package, you must 

customize the version number in the SPEC file. It is recommended that you use an identifier that is based 

on your organization's name. In this example "BFC Fiction Ltd" is used.

To customize the SPEC file, complete the following steps:

1. Edit the SPEC file. 

You can use your favorite editor instead of vi.

$ vi SPECS/ibm-trc-target.spec

2. Change the line Version: ${_buildversion}  to Version: 5.1.2.bfc

3. The release field must be updated as well. 

This field can be used to track the version of your customized builds.

Change Release: %{_buildlevel} to Release: 1

Customising the default configuration file

Before the configuration file can be customised, it needs to be extracted from the tar archive into a 

temporary directory.

To extract the configuration file complete the following steps:

1. Create a temporary directory

$ mkdir SOURCES/ibm-trc-target

$ cd SOURCES/ibm-trc-target

2. Extract all the files from the tar archive

$ tar xvf ../ibm-trc-target.tar

3. Edit the configuration file with the customisations necessary for your environment.

$ vi ibmtrct.conf

For example: to enable the target for peer to peer failover set ALLOWP2P to Yes and 

ALLOWP2PFAILOVER to Yes. See

4. When the changes are complete the tar archive needs to be recreated so that the modifications are 

used by the RPM build process.
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$ tar cvf ../ibm-trc-target.tar *

$ cd ../..

Building your customized BigFix Remote Control target RPM package

The following command will rebuild the RPM package using your customized configuration file.

$ rpmbuild -ba SPECS/ibm-trc-target.spec

The RPM package will be saved to RPMS/i386/ibm-trc-target-5.1.2.bfc-1.i386.rpm

You should now run the following command to install your customised target.

$ rpm -ivh RPMS/i386/ibm-trc-target-5.1.2.bfc-1.i386.rpm

Installing the target by using the SPB file
You can install the BigFix Remote Control target components on a Windows system and a Linux system 

by using the Software Package Block (SPB) installation method.

This method requires IBM® Tivoli®® Provisioning Manager. The following files are required for the 

installation.

Windows systems

trc_target_win.spb

Linux systems

trc_target_linux.spb

These files can be extracted by using the additional setup utility. For more information about using the 

additional setup utility, see Extract the installation files by using the additional setup utility (on page 

112)

Note:  If you are using Red Hat Linux 6.0 64-bit operating system, the following libraries along with 

their dependencies, need to be installed if they are not already installed, glibc.i686, libgcc.i686, 

libXmu.i686, libXp.i686, libXtst.i686.

Note:  Tivoli Common Agent (TCA) needs to be installed on the computers before the target can be 

installed using the SPB method.
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Install the controller
The BigFix Remote Control controller can be installed locally on your system, to be used for connecting to 

a target directly if peer to peer mode is enabled.

BigFix Remote Control provides two ways to install the controller component. If you have access to the 

BigFix console, use the deployment Fixlet to deploy the controller. For more information, see Deploy the 

BigFix Remote Control componentsthe BigFix Remote Control Console User's Guide. Alternatively use 

the BigFix Remote Control controller installation files.

Installing the controller on a Windows system
The trc_controller_setup.exe file is required to install the controller component on a Windows

system.

For more information about how to obtain the component installation files for a Windows system, see 

Install the BigFix Remote Control components (on page 22). Choose the appropriate method for 

obtaining the file.

1. Run the trc_controller_setup.exe file.

2. On the file download window, select Run or Save

Run

Select Run to start the installation wizard.

a. Click Next at welcome screen.

b. Accept the license agreement, click Next.

c. Accept or change the location for the installation files, click Next.

d. Click Install.

e. Click Finish.

Note:  If the controller software is already installed on the system, modify, repair, or 

remove options are available.

Save

Select Save to save the trc_controller_setup.exe file to a selected location. Run 

the file to install the controller.

The controller is installed to the default location \Program Files\IBM\Tivoli\Remote Control

\Controller or the location that is selected during the installation.
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Installing the Linux controller

Use the ibm-trc-controller-9.x.x.noarch.rpm and ibm-trc-controller-

jre-9.x.x.i386.rpm files to install the controller component in Linux. Where 9.x.x is relevant to the 

version that you want to install. For example, 9.1.0For more information about how to obtain the Linux

component installation files, see Install the BigFix Remote Control components (on page 22). Choose 

the appropriate method for obtaining the file.

You can install the controller in two modes in Linux, a FIPS-compliant controller or a standard controller.

Type the relevant command for installing the controller. Where 9.x.x is relevant to the version that you 

want to install. For example, 9.1.2.

• For the standard controller type

#rpm -ivh ~/IBM/Tivoli_Remote_Control/RCTarget/ibm-trc-controller-9.x.x.noarch.rpm

• For a FIPS-compliant controller, install the standard controller and the FIPS-compliant JRE by running 

both commands.

#rpm -ivh ~/IBM/Tivoli_Remote_Control/RCTarget/ibm-trc-controller-9.x.x.noarch.rpm

#rpm -ivh ~/IBM/Tivoli_Remote_Control/RCTarget/ibm-trc-controller-jre-9.x.x.i386.rpm

Note:  Standard controller installations work with the ibm-trc-controller-9.x.x.noarch.rpm

file, with an alternative JRE installed on the system. If the controller is to be FIPS-compliant, the ibm-

trc-controller-jre-9.x.x.i386.rpm file must also be installed. The ibm-trc-controller-

jre-9.x.x.i386.rpm file can also be installed even if the controller is not going to be run in FIPS 

mode.

You can start the controller from your applications list when it is installed.

Install the BigFix Remote Control Controller for macOS
The BigFix Remote Control Controller for macOS can be installed in multiple ways. You can use the 

trc_controller.pkg file to install the application. You can also install the controller by using a Fixlet

in the BigFix console.

For information about how to obtain the BigFix Remote Control Controller for macOS component 

installation files see, Obtain the installation files (on page 22). Choose the appropriate method for 

obtaining the file.
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Installing the BigFix Remote Control Controller for macOS from the BigFix
console
You can use a Fixlet in the BigFix console to install the BigFix Remote Control Controller for macOS

component. The deployment Fixlet is available in the Remote Control site in the Systems Lifecycle 

domain.

1. Within the Systems Lifecycle domain, expand Remote Control configuration > Remote Control.

2. Expand the Deployment node.

3. Select macOS.

4. Select Deploy BigFix Remote Control Controller for macOS.

5. In the Task pane, review the description and follow the instructions in the Actions box to start the 

task.

6. In the Take Action pane on the Target tab, select the relevant option for determining which 

computers to deploy the BigFix Remote Control Controller for macOS component on.

7. Click OK.

The summary screen shows the progress of the task and the status is set to Complete when it is 

finished.

Installing the BigFix Remote Control Controller for macOS
You can use the trc_controller.pkg file to install the BigFix Remote Control Controller for macOS.

You can obtain the pkg file from Passport Advantage or from the BigFix Remote Control server UI. For 

more information, see Obtain the installation files (on page 22). To install the controller, complete the 

following steps.

1. Double-click the trc_controller.pkg file.

2. Click Continue.

3. Click Install to install to the startup disk. If your system has multiple disks, you can select which disk 

to install the controller on. Click Change Install Location to select an installation disk.

4. If you are a user with admin authority, type in your password when prompted. Otherwise, type a valid 

admin ID and password. Click Install Software.

5. When the installation completes, click Close.
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After you install the .pkg file, open the Remote Control Controller.app to start the target.

Installing the controller in other supported operating systems

If you are using a supported operating system other than Windows operating system, Linux, AIX, or Solaris 

(SPARC), extract the controller files by using the additional setup utility. Then, copy the required files to 

the system that you are running the controller on. You must run the additional setup utility on a Windows, 

Linux, AIX, or Solaris(SPARC) system. For more information about obtaining the additional setup utility 

files, see Install the BigFix Remote Control components (on page 22).

Note:  Ensure that you install a supported version of Java to run the controller on the other supported 

operating system. See Controller requirements (on page 16).

To install the controller, complete the following steps:

1. After you extract the installation files, go to the RCController directory.

2. Copy the file trc_console.zip to the system that you are running the controller on.

3. Extract the files from the trc_console.zip file.

4. Type the following command to run the controller

java -jar TRCConsole.jar

Installing a preconfigured controller component
You can configure the controller component by editing the trc_controller.cfg configuration file after 

the controller is installed. You can also apply custom configuration settings when you install the controller 

component.You can apply custom configuration settings when you install the controller component.

Preconfiguring the controller is useful for unattended installations. You can set your configuration file 

values in the configuration file and copy the file to the computers that you want to install the controller 

on. Your configuration settings are installed together with the controller. The configuration values are 

set in the trc_controller.cfg file. You can create the file and add your custom values or you can 

edit a default configuration file. If you do not apply any preconfiguration, the default configuration file is 

installed when you install the controller component.

The property values in the trc_controller.cfg are global and are the same for all users who run the 

controller. However, a user can create a local configuration. The values in the users' local configuration 

are used when they run the controller and override the global values. To enforce the global property value, 
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you can set a property to mandatory so that a user cannot edit the property in the Configuration Window

in the controller UI. The mandatory global property overrides the local property.

To set a mandatory property, complete the following steps:

1. Open the trc_controller.cfg file.

2. Copy the property name and add .mandatory = true to the end.

For example, to make the Enable Address History property mandatory so that it cannot be edited in 

the Configuration Window.

enable.address.history=false

enable.address.history.mandatory=true

3. Save the file.

After you save the trc_controller.cfg file, install the controller.

Preconfigure the controller for a Windows operating system installation

1. Copy the trc_controller.cfg file to the same directory as the 

trc_controller_setup.exe or trc_controller.msi file.

2. Run the controller installation file.

The controller is installed with your configured settings.

Note:  Preconfiguring the controller is not supported for installation on a Linux operating system. If 

necessary, you can modify and rebuild the controller .rpm file from the source .rpm file.

Use the content of the default configuration file to create your custom configuration file and set your own 

values.

# Licensed Materials - Property of IBM

#

# 5725-C43

#

# Copyright International Business Machines Corp. 2011, 2014. 

#All Rights Reserved

#

# US Government Users Restricted Rights - Use, duplication or disclosure

# restricted by GSA ADP Schedule Contract with IBM Corp.

fips.compliance=false
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sp800131a.compliance=false

enable.address.history=true

enable.user.history=false

enable.domain.history=true

history.max.items=20

tool01.ToolName = Control Panel

tool01.ToolCommand = [SystemFolder]\\control.exe

tool01.ToolParameters =

tool01.ToolUser =

tool02.ToolName = Command Prompt

tool02.ToolCommand = [SystemFolder]\\cmd.exe

tool02.ToolParameters =

tool02.ToolUser =

tool03.ToolName = Administrator Command Prompt

tool03.ToolCommand = [SystemFolder]\\cmd.exe

tool03.ToolParameters =

tool03.ToolUser = admin

tool04.ToolName = Task Manager

tool04.ToolCommand = [SystemFolder]\\taskmgr.exe

tool04.ToolParameters =

tool04.ToolUser =

tool05.ToolName = Windows Explorer

tool05.ToolCommand = [WindowsFolder]\\explorer.exe

tool05.ToolParameters =

tool05.ToolUser =

tool06.ToolName=Terminal



BigFix® Remote Control Installation Guide | 4 - Install the BigFix Remote Control components | 102

tool06.ToolCommand=/usr/bin/gnome-terminal

tool06.ToolParameters =

tool06.ToolUser =

tool07.ToolName=Control Panel

tool07.ToolCommand=/usr/bin/gnome-control-center

tool07.ToolParameters =

tool07.ToolUser =

tool08.ToolName=

tool08.ToolCommand=

tool08.ToolParameters =

tool08.ToolUser =

tool09.ToolName=

tool09.ToolCommand=

tool09.ToolParameters =

tool09.ToolUser =

tool10.ToolName=

tool10.ToolCommand=

tool10.ToolParameters =

tool10.ToolUser =

# Custom keys

# example.KeySequenceName = Inject F1

# example.KeySequenceValue = [F1]

#

# For a list of supported key codes, please refer to the User's Guide

key01.KeySequenceName =

key01.KeySequenceValue =

key02.KeySequenceName =

key02.KeySequenceValue =
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key03.KeySequenceName =

key03.KeySequenceValue =

Install the command-line tools
You can use the command-line tools to start a remote control session from the command-line, or run 

commands on a target system without target user interaction. The commands can be useful if you want 

to connect to a target without using the BigFix Remote Control Server interface or for using as part of a 

script to run multiple commands in an automated fashion. The command-line tools are only available to 

run on Windows operating systems and Linux operating systems.

BigFix Remote Control provides two ways to install the command-line tools. If you have access to the 

BigFix console, use the deployment fixlets to deploy the tools. For more information about deploying the 

components, see the BigFix Remote Control Controller User's Guide. Alternatively use the BigFix Remote 

Control controller installation files.

Installing the cli tools on a Windows system
The trc_cli_setup.exe file is required to install the controller component on a Windows system.

For more information about how to obtain the Windows component installation files, see Install the BigFix 

Remote Control components (on page 22). Choose the appropriate method for obtaining the file.

1. Run the trc_cli_setup.exe file.

2. On the file download window, select Run or Save

Run

Select Run to start the installtion.

a. Click Next  at the welcome screen.

b. Accept the license agreement, click Next.

c. Accept or change the location for the installation files, click Next.

d. On the server address screen type in the information and click Next:

Server host name

Enter the IP address or server name of the BigFix Remote Control

server.

Use secure connections (https)

Select https to use secure connections to contact the server.
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Advanced settings

Click Advanced settings for more configuration settings.

Server port

Enter the port number that the server is listening on.

Server context

Enter a value for the server context. For example, trc.

Use a FIPS certified cryptographic provider

Select Use a FIPS certified cryptographic provider for 

installing FIPS-compliant tools.

Enable NIST SP800-131A compliance (Enables FIPS)

Select Enable NIST SP800-131A compliance (Enables 

FIPS) for installing NIST SP800-131A compliant tools.

e. On the Proxy settings panel, if you are not using a proxy server click Next.

• If you are using a Proxy, select Use a proxy server or a Remote Control 

Gateway. Type in the relevant information

i. Type in the IP address or host name for the proxy server.

ii. Type in the port that proxy server is listening on.

iii. Select Use an HTTP proxy or Use a Remote Control Gateway.

iv. Select Proxy requires authentication and enter the user ID and password 

for authenticating to the proxy server.The user ID and password are 

automatically encrypted when the target starts. For more information 

about the automatic passphrase encryption, see the BigFix Remote 

Control Administrator's Guide. 

Note:  The CLI is unable to automatically encrypt the proxy credentials 

when the CLI is installed stand-alone, without the target and when the CLI 

is run by a standard user. If you use the CLI that is included in the target 

package, the proxy credentials are automatically encrypted by the target. 

You must restart the target after you edit the settings in the registry or 

configuration file. When you use the stand-alone CLI tools, you must run 

the CLI once from an Administrator Command Prompt in a Windows 

operating system or when logged in as root in Linux.

v. Click Next.

f. Accept the default port or type in a value, click Next

g. Click Install.
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h. Click Finish.

Save

Select Save to save the trc_cli_setup.exe file to a specific location.

Note:  Run this executable file to install the command-line software.

The following executable files are in the selected directory.

wrc.exe

Use this tool to start a remote control session with a target.

wrcmdpcr.exe

Use this tool to run a command on a target and see the output from the command on the 

computer that you issue the command from.

For more information about using the command line tools, see theBigFix Remote Control Controller 

User's Guide

Installing the CLI tools in Linux
You can install the CLI tools on a Linux computer by using the RPM file that is provided in the BigFix

Remote Control installation files.

Note:  The target, CLI, gateway, and broker component installation packages depend on the 32-bit 

version of the following libraries. For all components, glibc and libblkid. Also, for the target component, 

libgcc, libXmu, libXtst, libXp, libXi, libXScrnSaver, and libXinerama. Therefore, you must ensure that the 

libraries are installed.

Use the ibm-trc-cli-9.x.x.i386.rpm file to install the CLI tools in Linux. Where 9.x.x is relevant to 

the version that you want to install. For example, 9.1.0 For more information about obtaining the Linux

component installation files, see Install the BigFix Remote Control components (on page 22). Choose 

the appropriate method for obtaining the file.

Note:  If the ibm-trc-target RPM file is installed, you do not need to install the ibm-trc-cli

RPM file because the CLI commands are already included in the target. For more information about using 

the commands, see the BigFix Remote Control Controller User's Guide.

1. Type, the following command to install the command line software.

Where 9.x.x is relevant to the version that you want to install. For example, 9.1.0.
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$ rpm -ivh ~/IBM/Tivoli_Remote_Control/RCTarget/ibm-trc-cli-9.x.x.i386.rpm

2. When the installation is complete, edit the /etc/ibmtrct.conf file and set your configuration.

• Set the value of ServerURL to the host name or IP address of your BigFix Remote Control Server.

• For FIPS-compliance set the value of FIPSCompliance to Yes.

• For NIST SP800-131a compliance, set the value of SP800131ACompliance to yes.

3. Save the file.

For more information about using these commands, see the BigFix Remote Control Controller User's 

Guide.

Install gateway support in BigFix Remote Control
For targets, controllers, and server on different networks that cannot directly contact each other you can 

install and configure gateway support.

BigFix Remote Control provides two ways to install the gateway support. If you have access to the BigFix

console, use the deployment fixlets to deploy gateway support. For more information, see the BigFix

Remote Control Console User's Guide. Alternatively you can use the BigFix Remote Control gateway 

support installation files.

Installing Windows gateway support

The trc_gateway_setup.exe file is required to install gateway support in a Windows operating 

system. For more information about how to obtain the Windows gateway support files, see Install the 

BigFix Remote Control components (on page 22). Choose the appropriate method for obtaining the 

file.

Note:  You can also install gateway support with no user interaction by running a silent installation. 

For more information about a silent installation, see Installing the gateway support by running a silent 

installation (on page 107).

To install gateway support, complete the following steps:

1. Run the trc_gateway_setup.exe file.

2. Click Next at the Welcome screen.

3. Accept or change the installation location and click Next.

4. Click Install.
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5. Click Finish when the installation is complete.

When the gateway support is installed, you must configure it for your environment. For more information 

about configuring gateway support, see the BigFix Remote Control Administrator's Guide.

Installing the gateway support by running a silent installation

To install the gateway support on a Windows system by running a silent installation, complete the 

following steps:

1. Create a folder in your root drive called IBMTRC.

2. Copy trc_gateway_setup.exe file to IBMTRC.

3. Open a command prompt window and go to IBMTRC.

4. Type in the following command all in one line:

trc_gateway_setup.exe /s /v"/qn"

/s

Denotes a silent installation.

/v"

The string that is attached to /v contains the parameters for msiexec.exe, which is a 

piece of software that runs the actual installation.

/qn

Perform a silent installation with no progress window.

For more information about configuring gateway support, see the BigFix Remote Control Administrator's 

Guide.

Installing Linux gateway support
You can install gateway support on a Linux computer by using the RPM file that is provided in the BigFix

Remote Control installation files.

Note:  The target, CLI, gateway, and broker component installation packages depend on the 32-bit 

version of the following libraries. For all components, glibc and libblkid. Also, for the target component, 
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libgcc, libXmu, libXtst, libXp, libXi, libXScrnSaver, and libXinerama. Therefore, you must ensure that the 

libraries are installed.

Use the ibm-trc-gateway-9.x.x.i386.rpm file to install gateway support in Linux. Where 9.x.x is 

the version that you want to install. For more information about obtaining the Linux gateway support files, 

see Install the BigFix Remote Control components (on page 22). Choose the appropriate method for 

obtaining the file.

Type the following command at a command prompt to install the gateway support. Where 9.x.x is the 

version that you want to install. For example, 9.1.0.

$ rpm -ivh ibm-trc-gateway-9.x.x.i386.rpm

When the gateway support installed, configure it for your environment. For more information about 

configuring gateway support, see the BigFix Remote Control Administrator's Guide.

Install broker support
Broker support must be installed on the computers that connect the controller to the target computer 

when the target computer is not directly accessible by the controller and the connection is made across 

the internet.

BigFix Remote Control provides two ways to install the broker support. If you have access to the BigFix

console, use the deployment fixlets to deploy the broker support. For more information, see the BigFix

Remote Control Console User's Guide. Alternatively use the BigFix Remote Control broker installation 

files.

Installing Windows broker support
The BigFix Remote Control broker installation files are executable files that can be used to install broker 

support on a Windows computer.

The trc_broker_setup.exe file is required to install broker support on a Windows system. For more 

information about how to obtain the Windows broker support files, see Install the BigFix Remote Control 

components (on page 22). Choose the appropriate method for obtaining the file.

To install broker support on a Windows computer, complete the following steps.

1. Run the trc_broker_setup.exe file.

2. Click Next  at the welcome screen.



BigFix® Remote Control Installation Guide | 4 - Install the BigFix Remote Control components | 109

3. Accept license terms and click Next.

4. Accept the default location or change the installation destination folder. Click Next.

Default location is \Program Files\IBM\Tivoli\Remote Control\Broker

5. Click Install.

6. Click Finish.

The following files are installed in the [working dir]\Broker directory, where [working dir] is determined by 

the version of Windows operating system that you are installing the broker support on.

For example, \Documents and Settings\All Users\Application Data\IBM\Tivoli\Remote 

Control.

• trc_broker.properties

• TRCICB-computername-day.log where computername is the computer name of the system that 

the broker is installed on and day is the day of the week that the broker is installed on.

You must check that the BigFix Remote Control- Internet Connection Broker  service is registered and is 

started.

Installing Linux broker support
You can install broker support on a Linux computer by using the RPM file that is provided in the BigFix

Remote Control installation files.

Note:  The target, CLI, gateway, and broker component installation packages depend on the 32-bit 

version of the following libraries. For all components, glibc and libblkid. Also, for the target component, 

libgcc, libXmu, libXtst, libXp, libXi, libXScrnSaver, and libXinerama. Therefore, you must ensure that the 

libraries are installed.

Use the ibm-trc-broker-9.x.x.i386.rpm file to install the broker support in Linux. Where 9.x.x is 

the version that you want to install. For example, 9.1.0. For more information about obtaining the Linux

component installation files, see Install the BigFix Remote Control components (on page 22). Choose 

the appropriate method for obtaining the file.

At a command prompt type, the following command to install the broker software. Where 9.x.x is the 

version that you want to install. For example, 9.1.0.

rpm -ivh ibm-trc-broker-9.x.x.i386.rpm
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The following files are installed in the /opt/ibm/trc/broker  directory.

• libcrypto.so.1.0.0

• libssl.so.1.0.0

• trc_icb

• A license directory.

The trc_broker.properties file is installed in the /etc  directory.

When the broker support is installed, configure the broker properties by editing the 

trc_broker.properties file.



Chapter 5. Utility for extracting the component 
installation files

BigFix Remote Control provides a utility that you can use to extract the installation files that are required 

for each component.

Note:  This utility can be run only on computers with a Windows, Linux,  AIX, or Solaris SPARC 

operating system installed. For other supported operating systems, for example macOS or HP-UX, extract 

the installation files by running the utility on another computer. Copy the extracted files to the required 

computer.

Extract the data from the BigFix_Rem_Cntrl_V914_Image_3.tar file.  Go to the \Disk1\InstData

\platform\VM directory where platform is relevant to your operating system. The utility can be 

run only by using the trc_additional_setup.exe or trc_additional_setup.bin file. To 

extract the installation files for other supported operating systems, for example, macOS, run one of the 

trc_additional_setup files to extract the installation files, then copy the .pkg files to the macOS 

system.

Use the following files to run the additional setup utility:

Windows systems

trc_additional_setup.exe

AIX, Linux, Solaris systems

trc_additional_setup.bin

For more information about how to obtain the BigFix_Rem_Cntrl_V914_Image_3.tar file, see 

Obtain the installation files (on page 22).

You can extract the following component installation files.

• Server Installation media: Use the files to run a manual server installation. The trc.war file and 

instructions are extracted.

• Target Installation media:

◦ Windows Packages (.exe and .msi)

◦ Linux Package (.rpm)

◦ macOS Package (.pkg)

• Controller installation media:.

◦ Windows Packages (.exe and .msi)

◦ Linux Package (.rpm)
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◦ macOS Package (.pkg)

• Command Line Interface installation media:

◦ Windows Packages (.exe and .msi)

◦ Linux Package (.rpm)

• Gateway installation media:

◦ Windows Packages (.exe and .msi)

◦ Linux Package (.rpm)

• Internet Connection Broker installation media:

◦ Windows Packages (.exe and .msi)

◦ Linux Package (.rpm)

• Server Installation media: Use the files to run a manual server installation. The trc.war file and 

instructions are extracted.

• Target Installation media: The target .msi, .exe, .rpm, and instructions files are extracted.

• Controller installation media.

• Command Line Interface Installation Media.

• Gateway Installation Media.

• Internet Connection Broker Installation Media.

Extract the installation files by using the additional setup 
utility
To run the additional setup utility, complete the following steps:

1. Run the trc_additional_setup file relevant to your operating system.

The file must be run from within the file structure that is extracted from the 

BigFix_Rem_Cntrl_V914_Image_3.tar file. For more information about which file to use, see 

Utility for extracting the component installation files (on page 111).

2. Select the language and click OK.

3. Accept the license agreement and click Next.

4. Clear the options that you do not want to extract the files for. Only the options you require must 

remain selected.

a. Server Installation media: to extract the files for installing the server.

b. Target Installation media: to extract the files for installing the target.

c. Controller Installation media: to extract the files for installing the controller.
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d. Command Line Interface Installation media: to extract the files for running the command line 

interface.

e. Gateway Installation media: to extract the files for installing gateway support.

f. Internet Connection Broker Installation media: to extract the files for installing broker support.

5. Click Next.

6. Accept or change the installation folder. Click Next.

7. On the summary screen, click Install.

8. When complete, click Done.

9. Go to the chosen installation folder.

The installation files are in the following directories:

• RCServer - server installation file, trc.war.

• RCTarget - target installation files.

• RCController - controller installation files.

• RCCLI - command line tools installation files.

• RCGateway - gateway installation files.

• RCBroker - broker installation files.



Chapter 6. Enable secure target registration

To prevent unauthorized targets from registering with the BigFix Remote Control server, you can enable 

the secure registration feature and use tokens to authenticate the target.

The secure registration feature is enabled by default on a new BigFix Remote Control server installation 

when you use the installer program. After you install the server, create a registration token on the server 

and use it when you install the target. For more information about the secure registration feature and 

how to create a token, see Secure target registrationthe Secure target registration chapter in the BigFix

Remote Control Administrator's Guide

Enable secure target authentication in the server
The BigFix Remote Control Server provides an installation option to enable secure registration of targets.

When the feature is enabled, the server verifies that a secure registration token that is sent by the target 

matches an existing token on the server. If the token is valid, the target is registered in the server and 

receives an endpoint token from the server. The target sends the endpoint token to the server each time it 

contacts the server.

Note:  If you have existing targets in the database and you enable the secure registration feature, 

the existing targets cannot successfully contact the server because they do not have an endpoint token. 

Therefore, you must create or use a valid a secure registration token and reinstall the existing targets with 

the token so that they can continue to contact the server.

Enabling secure registration when you run the server installer program
You can enable the secure target registration feature when you install the server by using the installer 

program. The feature is enabled by default on a new server installation.

To enable the secure registration feature, complete the following steps:

1. Follow the installation steps in Installing by using the server installer (on page 32).

2. On the Web server parameters window, ensure that Force targets to use https is selected.

3. Select Use secure registration tokens to register targets.

4. Complete the installation.
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After you install the server and enable the secure target registration feature, create registration tokens. 

For more information about creating registration tokens, see Creating a secure registration tokenthe 

BigFix Remote Control Administrator's Guide.

Enabling secure target registration after you install the server
You can enable the secure target registration feature after you install the server by editing properties in 

the trc.properties file.

To enable the secure registration feature after you install the server, complete the following steps.

1. In the server UI select Admin > Edit properties file.

2. Select trc.properties from the list.

3. Set rc.enforce.secure.registration to true.

Ensure that the enforce.secure.endpoint.callhome and enforce.secure.endpoint.upload properties 

are also set to true.

4. Click Submit.

5. Click Admin > Reset Application.

You can also manually edit the properties files and set the property to true. Restart the server after you 

edit the file. The properties files are in the following directories:

Windows systems

[installdir]\wlp\usr\servers\trcserver\apps\TRCAPP.ear\trc.war\WEB-INF\classes

Where installdir is the directory that the BigFix Remote Control Server is installed. For 

example,

C:\Program Files\IBM\Tivoli\TRC\server\wlp\usr\servers\trcserver 

\apps\TRCAPP.ear\trc.war\WEB-INF\classes

Linux systems

[installdir]/wlp/usr/servers/trcserver/apps/TRCAPP.ear/trc.war/WEB-INF/classes

Where installdir is the directory that the BigFix Remote Control Server is installed. For 

example,

 

/opt/IBM/Tivoli/TRC/server/wlp/usr/servers/trcserver/apps/TRCAPP.ear 

/trc.war/WEB-INF/classes
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Add a token for secure target registration
The BigFix Remote Control Target provides an installation option to add a secure registration token. You 

can also add the token by running a Fixlet in the BigFix console.

The token is used to prevent unauthorized targets from registering with the BigFix Remote Control server. 

Create a token on the server and use it when you install the target. The secure registration feature on the 

server must also be enabled.

The target sends the secure registration token to the server the first time it contacts the server. The server 

verifies that the token matches an existing token on the server. If the token is valid, the target is registered 

in the server and receives an endpoint token from the server.

Note:

The target includes the token in its callhome to the server only when it uses a secure connection to the 

server. The server URL that it uses to connect to the server must start with HTTPS.

The token is used to restrict new target registrations, or restrict updates to existing target details when 

you reinstall a target. After the target registers, the server sends a new token to the target to replace the 

token that was used when it registered. The target uses the new token to authenticate to the server each 

time it contacts the server. The feature is controlled by the rc.enforce.secure.registration property in the 

trc.properties file.

true

Secure target registration is enabled. Secure tokens are used to authenticate a target when 

it contacts the server. This value is the default value.

false

Secure target registration is disabled.

The secure registration feature is enabled by default on a new server installation when you are using the 

installer program. For an upgrade, you can enable it during the server installation, or after installation by 

editing the rc.enforce.secure.registration in the trc.properties file.

New installations

1. Install the server

2. Create a registration token

3. Install the targets along with the registration token

Upgrades
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1. Upgrade the server

2. Create a registration token

3. Upgrade the targets along with the registration token

4.

After you install the server, you can create a registration token. For more information about creating the 

token, see

Add the secure registration token when you install the target on a Windows
system
On a Windows system, you can add a secure registration token in multiple ways:

• Add the token by using the target installer program.

• Add the token by running the target installation from the command line.

• Modify the target after installation.

Running the target installer with a secure registration token
When you install the target component, use the BigFix Remote Control Target installer to provide the 

target with a secure registration token. The target uses the token to authenticate to the server when it 

contacts the server for the first time.

To run the target installer with a token, complete the following steps:

1. Follow the installation steps in Installing the Windows target (on page 57).

2. On the Server Address window, for secure target registration, enter or paste the token in the Secure 

registration token field.

Ensure that Use secure connections (https) is also selected. For more information about secure 

target registration, see Add a token for secure target registration (on page 115).

3. Complete the installation.

Running a target silent installation with a secure registration token
Install the target along with a secure registration token when you run a new BigFix Remote Control target 

silent installation.
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For more information about running a target custom installation, see Run a target custom installation (on 

page 84)the BigFix Remote Control Installation Guide.

To install the target component and the token, run the following command on one line.

trc_target_setup.exe /s /v"/qn REGISTRATIONTOKEN=xxxxxxxxxxx

TRC_SERVER_HOSTNAME=yyyyyyyyyyyyyy"

  

Replace xxxxxxxxxxx with the token and yyyyyyyyyyyyyy with the host name of your BigFix Remote 

Control server.

For more information about running a silent installation when you upgrade the target, see Upgrading the 

target with a secure registration token (on page 119).

Adding the secure registration token after you install the target
If you install the target component and do not install the secure registration token, you can modify the 

target and add the token.

Select the method for adding the token.

To add the token by running the installer program, complete the following steps:

1. Go to the Control Panel. For example, Start > Control Panel > Programs > Programs and Features.

2. Right-click BigFix Remote Control-Target.

3. Select Change.

4. On the Program Maintenance window, select Modify.

5. Click Next until the Server Address window is displayed.

6. Enter or paste the token in the Secure registration token field. Ensure that Use secure connections 

(https) is also selected.

7. Click Install.

8. Click Finish.

To add the token by editing the target registry, complete the following steps:

1. Edit the target registry and go to HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Tivoli\Remote 

Control\Target
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Note:  On a 64-bit system, all the 32-bit registry keys are under the Wow6432Node key. For 

example, HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\IBM\Tivoli Remote Control

\Target

2. Right-click RegistrationToken.

3. Click Modify.

4. Enter or paste the token.

5. Restart the target.

Upgrading the target with a secure registration token
Upgrade the BigFix Remote Control target with a secure registration token.

The upgrade process requires two steps. You must upgrade the target first, then run an installation with 

the token.

• To use the installer to upgrade the target with a token, complete the following steps:

1. Run the trc_target_setup.exe file.

2. Select Yes for an automatic upgrade.

3. Click Next.

If a Files in Use window is displayed, click OK.

4. Click Finish.

5. To add the token, complete the steps in, Adding the secure registration token after you install the 

target (on page 118).

• To run a silent installation to upgrade the target with a token, complete the following steps.

1. At a command prompt type trc_target_setup.exe /s /v"/qn" to upgrade the target.

2. To add the token run trc_target_setup.exe /s /v"/qn REGISTRATIONTOKEN=xxxxxx 

REINSTALL=ALL"

Where xxxxxx is replaced by the token that you saved when you created a token.

Add the registration token when you install a target on a Linux system
On a Linux system, you can add a registration token for secure target authentication by editing the /etc/

ibmtrct.conf file after you install the target.
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To add a secure registration token to a Linux target, complete the following steps after you install the 

target. For more information about installing the target on a Linux system, see Installing the Linux target

(on page 81).

1. Edit the /etc/ibmtrct.conf file.

2. Add the registration token property and set it to the value of your registration token. Set 

RegistrationToken = xxxxxxxxxxxxxxx, where xxxxxxxxxxxxxxx is replaced with your token data. For 

example, 6386e21f-4316-460b-b339-deb3d132f3c7

3. Save the file.

4. Restart the target service. For more information, see Starting, stopping, or restarting the Linux 

components (on page 127).



Chapter 7. Install a driver to support smart card 
authentication in the target

The BigFix Remote Control Target provides an installation option to install a virtual smart card reader 

driver. You can also install the driver by running a fixlet in the BigFix console.

The device driver for the IBM virtual smart card reader is required to enable the use of smart cards for 

remote authentication, or to perform an action on the target computer.

During a remote control session, the target creates a virtual card reader. The controller user selects a 

physical card reader on their system to connect it to the virtual card reader so that the target system can 

access the smart card. During the session, when Windows makes a request to the virtual card reader, the 

target redirects the request to the physical card reader on the controller system.

For more information about using the smart card feature during a session see, Connecting to a smart 

card reader during a sessionthe BigFix Remote Control Controller User's Guide.

The device driver for the IBM virtual smart card reader is supported only in Windows 7 or later and 

Windows Server 2008 R2 or later.

Note:  Installation of the driver on Windows 7 or Windows server 2008 R2 might require the following 

updates to be installed on the target.

KB2921916

Microsoft hotfix to resolve the "Untrusted publisher" dialog box appears when you install a 

driver in Windows 7 or Windows Server 2008 R2 issue.

KB3033929

Security Update for Windows 7 for x64-based Systems.

Installing the virtual smart card reader driver by using the 
installer
Use the BigFix Remote Control Target installer to install the device driver for the IBM virtual smart card 

reader when you install the target component. You can also use the installer to install the driver on a 

system that has the target component already installed.

For more information about adding the driver after you install the target, see Adding or removing the 

virtual smart card reader driver by using the installer (on page 122).
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To install the target software and the device driver for the IBM virtual smart card reader, complete the 

following steps:

1. Follow the installation steps in Installing the Windows target (on page 57)

2. On the Additional features window, select Install device driver for Virtual Smart Card Reader.

After you install the driver, you must install a certificate so that the target can automatically enable the 

driver when smart card authentication is requested. For more information about installing the certificate 

by running a Fixlet, see Installing the certificates by running a Fixlet (on page 125) the BigFix Remote 

Control Console User's Guide. You can also download the certificates and install them manually. For 

more information, see Downloading the certificates for the IBM virtual smart card reader (on page 125)

the BigFix Remote Control Console User's Guide.

Adding or removing the virtual smart card reader driver by 
using the installer
After you install the target component, you can add or remove the device driver for the IBM virtual smart 

card reader by using the installer.

If you install the target component and do not install the device driver, you can modify the target and add 

the driver. To add the driver, complete the following steps:

1. Go to the Control Panel. For example, Start > Control Panel > Programs > Programs and Features.

2. Right-click BigFix Remote Control-Target.

3. Select Change.

4. On the Program Maintenance window, select Modify.

5. Click Next until the Additional features window is displayed.

6. Select Install device driver for Virtual Smart Card Reader. Click Next.

7. Click Install.

8. Click Finish.

The target can automatically enable the driver when smart card authentication is requested during a 

remote control session. Use the same procedure to remove the driver. In step 6 (on page 122), clear 

Install device driver for Virtual Smart Card Reader.

After you install the driver, you must install a certificate so that the target can automatically enable the 

driver when smart card authentication is requested. For more information about installing the certificate 

by running a Fixlet, see Installing the certificates by running a Fixlet (on page 125) the BigFix Remote 

Control Console User's Guide. You can also download the certificates and install them manually. For 
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more information, see Downloading the certificates for the IBM virtual smart card reader (on page 125)

the BigFix Remote Control Console User's Guide.

Installing the virtual smart card reader driver by running a 
silent installation
Install the device driver for the IBM virtual smart card reader when you run an BigFix Remote Control

target silent installation.

You can install the driver when you run a silent installation on a computer that does not have the target 

component. You can also add or remove the driver from an installed target. For more information about 

running a target custom installation, see Run a target custom installation (on page 84).

• To install the target component and the device driver for the IBM virtual smart card reader, run the 

following command.

trc_target_setup.exe /s /v"/qn VSC=1"

• To add the driver to an installed target, run the following command.

trc_target_setup.exe /s /v"/qn ADDLOCAL=vsc REINSTALL=service"

• To remove the driver from an installed target, run the following command.

trc_target_setup.exe /s /v"/qn REMOVE=vsc REINSTALL=service"

After you install the driver, you must install a certificate so that the target can automatically enable the 

driver when smart card authentication is requested. For more information about installing the certificate 

by running a Fixlet, see Installing the certificates by running a Fixlet (on page 125) the BigFix Remote 

Control Console User's Guide. You can also download the certificates and install them manually. For 

more information, see Downloading the certificates for the IBM virtual smart card reader (on page 125)

the BigFix Remote Control Console User's Guide.

Installing the virtual smart card reader driver when you 
upgrade the target
Install the device driver for the IBM virtual smart card reader when you upgrade the BigFix Remote Control

target.

• To install the driver when you upgrade the target by using the installer, complete the following steps:
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1. Run the trc_target_setup.exe file.

2. Select Yes for an automatic upgrade.

3. Click Next.

If a Files in Use window is displayed, click OK.

4. Click Finish.

5. To install the driver, complete the steps in, Adding or removing the virtual smart card reader 

driver by using the installer (on page 122).

• To install the driver when you upgrade by running a silent installation, complete the following steps.

1. At a command prompt type trc_target_setup.exe /s /v"/qn" to upgrade the target.

2. To add the driver run trc_target_setup.exe /s /v"/qn ADDLOCAL=vsc REINSTALL=service".

After you install the driver, you must install a certificate so that the target can automatically enable the 

driver when smart card authentication is requested. For more information about installing the certificate 

by running a Fixlet, see Installing the certificates by running a Fixlet (on page 125) the BigFix Remote 

Control Console User's Guide. You can also download the certificates and install them manually. For 

more information, see Downloading the certificates for the IBM virtual smart card reader (on page 125)

the BigFix Remote Control Console User's Guide.

Installing the virtual smart card reader driver and certificates 
by running a Fixlet
Install the device driver for the IBM virtual smart card reader together with the certificates by running a 

Fixlet in the BigFix console.

You can install the driver and certificates by running a Fixlet after you install the target. To install the 

driver and certificates, complete the following steps:

1. In the Remote Control site, click the Deployment node.

2. Select the Install BigFix Remote Control Virtual Smart Card Reader Driver version 9.1.4.0500 and 

certificates task.

3. Review the information in the Description tab.

4. Follow the instructions in the Actions field to install the driver.
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The device driver and certificates that are required for smart card authentication are installed. During a 

remote control session, when the controller user selects a physical card reader on their system, the target 

can now create a virtual card reader.

Note:  If an error is reported when you run the Fixlet, use the VSCDriverInstall.log file in the 

target installation directory for debugging purposes.

Installing the certificates by running a Fixlet
Use a Fixlet to install the certificates that are required by the device driver for the IBM virtual smart card 

reader.

You can install the certificates together with the driver by running a Fixlet. However, if the results of the 

BigFix Remote Control - Virtual Smart Card Reader Driver Status analysis show that the device driver is 

installed on your computer, but there are no certificates, you can install the certificates by running a Fixlet. 

To install the certificates, complete the following steps:

1. In the Remote Control site, click the Deployment node.

2. Select the Install BigFix Remote Control Certificates for the Virtual Smart Card Reader Driver 

version 9.1.4.0500 task.

3. Review the information in the Description tab.

4. Follow the instructions in the Actions field to install the driver.

The certificates that are required for smart card authentication are installed. For more information about 

the BigFix Remote Control - Virtual Smart Card Reader Driver Status analysis, see Determining whether 

smart card support is enabled.

Note:  If an error is reported when you run the Fixlet, use the VSCCertsInstall.log file in the 

target installation directory for debugging purposes.

Downloading the certificates for the IBM virtual smart card 
reader
You can download the certificates that are required by the device driver for the IBM virtual smart card 

reader and install them manually. For example, by using Active Directory Group Policy.

You can download the certificates in multiple ways. Choose the method for downloading the certificates.
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• Download the files from the Remote Control site in the BigFix console:

1. Click the Deployment node and select the Install BigFix Remote Control Virtual Smart Card 

Reader Driver version 9.1.4.0500 and certificates task.

2. Select the Description tab.

3. Follow the instructions in the Description field to download the certificates.

4. Save the vsc_certs_0502.zip file.

5. Extract the certificate files from the .zip file.

• Extract the certificate files from the installation media:

1. Access the BigFix Remote Control V9.x.x Image 1 in Passport Advantage. For more information 

about the image file, see Obtain the installation files (on page 22).

2. Download the BigFix_Rem_Cntrl_V9xx_Image_1.zip file, where 9xx is relevant to the 

version that is installed.

3. Extract the certificate files from the \Windows directory of the .zip file.

When you install the certificates, you must install the ibm_corporation.crt file to the Trusted 

Publishers store. Install the TrustedRoot.crt and verisign-universal.cer files to the Trusted 

Root Certificate Authorities store.



Chapter 8. Manage the component services

After you install the BigFix Remote Control components, if you change their configuration, you can stop, 

start, or restart the component services.

Follow the steps in the section that is relevant to your operating system.

Starting, stopping, or restarting the Windows components
You can start, stop, or restart the BigFix Remote Control Windows components from within the Control 

Panel.

To manage the BigFix Remote Control Windows components, complete the following steps.

1. In Control Panel select Administrative tools > Services.

2. Highlight the relevant service.

Server service

BigFix Remote Control- Server

Target service

BigFix Remote Control- Target

Gateway service

BigFix Remote Control- Gateway

Broker service

BigFix Remote Control- Internet Connection Broker

3. Choose the appropriate method for selecting an action for the service.

You can right-click and select start, stop, or restart or select Start, Stop, or Restart from the list on 

the left.

Starting, stopping, or restarting the Linux components
You can start, stop, or restart the BigFix Remote Control Linux components from within the Control Panel.

Depending on the version of Linux you are using, use one of the following commands to manage the 

components.
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• /sbin/service component action

• /etc/init.d/component action

Where component is the component service that you want to manage and action is start, stop, or restart.

Server

For example, to start the server service.

• /sbin/service trcserver start

• /etc/init.d/trcserver start

Target

For example, to stop the target service.

• /sbin/service ibmtrct stop

• /etc/init.d/ibmtrct stop

Gateway

For example, to restart the gateway service.

• /sbin/service ibmtrcgw restart

• /etc/init.d/ibmtrcgw restart

Broker

For example, to restart the broker service.

• /sbin/service ibmtrcicb restart

• /etc/init.d/ibmtrcicb restart



Chapter 9. Enabling email

To use the email function, you must install and set up an email server. For example, for a forgotten 

password, to export and email a report, or to request access to certain targets.

To enable the email function, complete the following steps:

1. Log on to BigFix Remote Control server with a valid admin ID and password.

2. Click Admin > Edit properties files.

3. Select trc.properties.

4. Edit the following variables

email.enabled

Set to true to enable email.

SMTP.server

Set to the address of your mail server.

SMTP.authentication

Set to true of false, Set to true to authenticate with the SMTP ID and password.

SMTP.userid

User ID for the SMTP server.

SMTP.password

Password for the SMTP server.

5. Click Submit.

The email function is enabled.



Chapter 10. Configure LDAP

BigFix Remote Control provides Lightweight Directory Access Protocol Version 3 support. You can use 

LDAP to enable authentication and integration of users and their associated group membership into the 

BigFix Remote Control database.

All configuration information that is required for LDAP authentication is in the ldap.properties file. 

Before you configure, some prerequisite information must be obtained. This information simplifies the 

configuration process.

• A user name and password to be used by BigFix Remote Control to establish a connection with the 

Active Directory server. This user name must have the authority necessary to read all the required 

information from the directory tree.

• The fully qualified server host name or IP address of the Active Directory server to be used with 

BigFix Remote Control.

• In an Enterprise scenario, a secondary backup LDAP server would also be configured in BigFix

Remote Control.

Setting up LDAP synchronization
To enable LDAP authentication, synchronization with the LDAP server must also be enabled. Edit values in 

the common.properties file and the ldap.properties file to enable synchronization.

To perform the basic configuration for LDAP authentication, complete the following steps:

1. Click Admin > Edit properties file.

2. Ensuring that you are editing the common.properties file, edit the following properties

authentication.LDAP

To enable or disable LDAP authentication.

True

LDAP user authentication is enabled.

Note:  Each time the synchronization with Active Directory takes place 

the users and user groups are deleted from the BigFix Remote Control

database and then imported from Active Directory. Therefore, if LDAP 
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is enabled, new users and new user groups must be created in Active 

Directory and not in BigFix Remote Control.

False

LDAP user authentication is not enabled. Users are authenticated against 

the BigFix Remote Control database.

authentication.LDAP=true

authentication.LDAP.config

Defines the file that contains the LDAP configuration properties.

authentication.LDAP.config=ldap.properties

sync.ldap

Synchronize the users and groups from Active Directory with the BigFix Remote Control

database. Takes the values true, to synchronize or false, for no synchronization.

True

The LDAP server is synchronized with the BigFix Remote Control database 

to reflect any changes that are made in LDAP.

False

No synchronization takes place. If synchronization is disabled, you must 

manually import the users into the BigFix Remote Control database. 

Otherwise, they cannot log on to the BigFix Remote Control server. The 

users must exist in the BigFix Remote Control database so that they can 

be associated with the relevant permissions that are required to establish 

remote control sessions.

Note:  The synchronization is performed by running a scheduled task. The task 

pulls the LDAP information from the LDAP server and updates the database with any 

changes that are made to the user or group information. Within the trc.properties

file, two attributes define the time interval that the scheduler uses to check for 

scheduled tasks.

scheduled.interval

The frequency hat the server must check for scheduled tasks. The 

number of units of time between each checking period. Default is 60.
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Note:  If you change this value, restart the server service for the new 

value to take effect.

scheduled.interval.period

The unit of time to be used along with the scheduled interval to specify 

how often the server must check for scheduled tasks. Default is minutes.

The scheduled.interval attribute is set to 60 as default and the 

scheduled.interval.period set to minutes, that is, the server checks for and runs any 

scheduled tasks every 60 minutes. To accurately reflect any changes to the users or 

groups, set the scheduled.interval attribute to a lower value so that the synchronization 

can occur more frequently.

3. Click Submit.

Verifying connection information
Use parameters to define how BigFix Remote Control connects to the LDAP server. The connection is 

used to query the LDAP server for the user and group information that is imported into BigFix Remote 

Control.

Any changes to the ldap.properties file do not take effect until you select Admin,Reset Application. 

To avoid multiple restarts or an extended outage use an LDAP browser and the LDAP Configuration Utility

as an aid to the entire configuration process.

To verify the connection information by using an LDAP browser, define an LDAP server profile by entering 

the fully qualified host name and credential information. When you open an LDAP browser for the first 

time, provide details for a new profile.

The profile can include the following information.

Host

Host name or FQDN of the preferred LDAP Server.

Port

Port that is used to communicate with the directory. Typically, port 389 but if your 

environment contains child domains, port 3268 must be used instead. Port 3268 points to 

the Global catalog that includes the child domains.

Base DN
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The root point to bind to the server. For example, 

DC=mydomain,DC=mycompany,DC=com.

After the information is entered, the LDAP Browser displays attribute names and values available at the 

root of the Active Directory tree.

When a connection is established, use the same information that is used in the LDAP browser to set the 

parameters in the ldap.properties file.

• Click Admin > Edit properties files

• Select ldap.properties from the list

• When modifications are complete, click Submit

The application must be reset for the changes to take effect. Click Admin > Reset Application or restart 

the server service.

The properties file can also be edited manually by locating it on the BigFix Remote Control Server. The file 

is in the [installdir]wlp\usr\servers\trcserver\apps\TRCAPP.ear\trc.war\WEB-INF

\classes directory, where installdir is the directory that the BigFix Remote Control Server is installed in. 

For example,  C:\Program Files\IBM\Tivoli\TRC\server\wlp\usr\servers\trcserver 

\apps\TRCAPP.ear\trc.war\WEB-INF\classes

Note:  BigFix Remote Control is provided with a default ldap.properties file and many of the 

extended configuration options are commented out. To enable the options, the file must be edited 

manually.

Note:  The BigFix Remote Control Server is capable of managing one Global catalog only. This means 

that domain controllers of different domains cannot be managed by the same BigFix Remote Control 

Server.

Users belonging to a domain which is not included in the forest specified in the server configuration 

cannot be added to the users of the same BigFix Remote Control Server.

Configuring connection credentials
Use the following properties to set valid credentials for connecting to the LDAP server.

Note:  Check that a successful connection to the LDAP browser can be established by using these 

credentials to verify that they are valid.

1. Edit the ldap.properties file.
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2. Configure the following properties.

ldap.connectionName

The user name that is used to authenticate to a read-only LDAP connection. 

If left not set, an anonymous connection is attempted. For example, 

administrator@mydomain.mycompany.com.

ldap.connectionPassword

The password that is used to establish a read-only LDAP connection. The password can 

be entered here in plain text or it can be encrypted. Use the LDAP wizard to encrypt your 

password. For more information, see Configure LDAP properties by using the LDAP 

wizard.

ldap.connectionPasswordEncrypted

True

The LDAP password is encrypted.

False

The LDAP password is not encrypted and entered as plain text.

Use the following method to generate the encrypted password. In a Windows system.

a. Open a command prompt window and type

cd [installdir]\wlp\usr\servers\trcserver\apps\TRCAPP.ear\trc.war\ 

WEB-INF\lib

where installdir is the BigFix Remote Control server installation directory For 

example,

cd \Program Files\IBM\Tivoli\TRC\server\wlp\usr\servers\trcserver\ 

apps\TRCAPP.ear\trc.war\WEB-INF\lib

b. Type the following command

java -cp ./trc.jar com.ibm.uk.greenock.authentication.Encrypt <password>

Where password is the LDAP password to be encrypted.

For example,

java -cp ./trc.jar com.ibm.uk.greenock.authentication.Encrypt myPassw0rd

Note:  This command is all on one line with a space between jar and com.

c. The following output from the command can be displayed.

Encrypted Password : [encrypted password]
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Decrypted Password : [text version of password ]

For example,

Encrypted Password: 10|ydEBl67atSSbrAA=

Decrypted Password: myPassw0rd

Edit the ldap.properties file and set the ldap.connectionPassword property to 

the encrypted password value. The decrypted password is shown to verify that the 

encryption is valid.

In a UNIX or Linux system.

a. Open a terminal window and type

[installdir]/wlp/usr/servers/trcserver/apps/TRCAPP.ear/trc.war/ 

WEB-INF/lib

where installdir is the BigFix Remote Control server installation directory

b. Type the following command

java -cp ./trc.jar com.ibm.uk.greenock.authentication.Encrypt <password>

c. The output from the command is the following

Encrypted Password : [encrypted password]

Decrypted Password : [text version of password ]

ldap.connectionURL

The directory URL used to establish an LDAP connection. Type in the URL of your LDAP 

server.

ldap://myldapserver.mydomain.mycompany.com

Setting connection security
The following properties define the level of security to be used on the connection to the LDAP server. Set 

the following parameter to simple so that the BigFix Remote Control server can communicate with most 

Active Directory servers.

ldap.security_authentication

Specifies the security level to use. Value can be set to one of the following strings: none, 

simple, strong. If this property is unspecified, the behavior is determined by the service 

provider.
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ldap.security_athentication=simple

While most LDAP servers support simple plain text login, some Active Directory administrators require 

a secure connection. BigFix Remote Control supports two types of secure connections to an Active 

Directory server, SASL (Digest-MD5) or SSL. If you cannot connect to the Active Directory server and see 

the following error in the trc.log:

LDAP Authentication.exception[LDAP: error code 8 - 00002028: LdapErr: DSID-0C09018A, 

comment: The server requires binds to turn on integrity checking if SSL\TLS are not 

already active on the connection, data 0, vece ] 

BigFix Remote Control needs to be configured for either SASL or SSL connections.

SASL (Simple Authentication and Security Layer)

The following parameters relate to using SASL to secure the connection to the LDAP server. If you are 

not using SASL, the parameters must not be edited. Comment out the parameters. The following values 

are used to configure BigFix Remote Control to connect to Active Directory that uses SASL in a test 

environment. Consult your organizations active directory support team to acquire the correct values for 

your company.

ldap.security_authentication

Specifies the security level to use. If this property is unspecified, the behavior is determined 

by the service provider. If you are using SSL, the value is set to simple. If you are using SASL, 

the value is set to the SASL mechanism DIGEST-MD5.

ldap.security_authentication= DIGEST-MD5

ldap.connectionRealm

The Realm name where the user ID and password resides.

ldap.connectionRealm= mydomain.mycompany.com

ldap.connectionQop

This value can be one of:

• auth = Authentication only

• auth-int = Authentication and integrity checking by using signatures

• auth-conf = (SASL only) Authentication, integrity and confidentiality checking by using 

signatures and encryption.

ldap.connectionQop= auth-conf
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ldap.connectionMaxbuf

Number that indicates the size of the largest buffer the server is able to receive when you 

use auth-int or auth-conf. The default is 65536.

ldap.connectionMaxbuf= 16384

ldap.connectionStrength

Connection strength can be one of: low, medium, high.

ldap.connectionStrength= high

SSL (Secure Socket Layer)

The following parameters define the use of SSL to connect to the Active Directory server. To use SSL, you 

must install a Root CA public key certificate keystore on the BigFix Remote Control Server. If SSL is not 

used, the parameters can be commented out in the ldap.properties file.

ldap.security_protocol

Specifies the security protocol to use. The value is a string that is determined by the service 

provider. For example, ssl. If this property is unspecified, the behavior is determined by the 

service provider.

ldap.security_protocol =ssl

ldap.ssl_keyStore

Enter the location of the keystore file.

ldap.ssl_keyStore=PathOfKeyStoreFile

ldap.ssl_keyStorePassword

Enter the location of the keystore password.

ldap.ssl_keyStorePassword=KeystorePassword

Setting user authentication properties
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Authenticating the user

Use the following properties to define how the user is authenticated when they attempt to log on to the 

BigFix Remote Control server. To configure the following sections use the LDAP browser as described for 

each parameter, to derive the correct settings.

ldap.digest

Digest algorithm that is used by LDAP. Values are SHA, MD2, or MD5 only. The default is 

cleartext. If the LDAP servers returns a password, BigFix Remote Control uses the Digest 

algorithm to encrypt the user input password and compare it with the password it receives 

from the LDAP server. If no password is returned from the LDAP server, BigFix Remote 

Control uses the user name and password that is provided by the end user to authenticate 

with LDAP.

ldap.digest=SHA

ldap.userid

ldap.userid is the LDAP attribute that contains the user ID that is mapped to the userid field 

in the BigFix Remote Control database. The userPrincipalPattern property then needs to 

know whether the @domainname, UPN suffix, is added for Active Directory authentication.

sAMAccountName

sAMAaccount must be used so that the user ID only portion of the logon, 

without the UPN Suffix, is used.

userPrincipalName

userPrincipalName must be used to force all logons to use the full User 

Principal Name.

Note:  It is recommended to set ldap.userid to this value to ensures that it 

does not contain any invalid characters. For example, an apostrophe.

The ldap.userid relates to other configuration values in the ldap.properties file.

For example, if the ldap.userid is set to userPrincipalName, the user must log on to BigFix

Remote Control with their full ID. For example, awilson@example.com.

• The ldap.userSearch variable would be (userPrincipalName={0}).

• The ldap.principalPattern would be {0}.
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If the ldap.userid is set to use sAMAccountName, the user must log on to BigFix Remote 

Control with just the user ID part of their ID. For example, awilson. The following parameters 

must be set so that the fully qualified name is appended.

For example

• The ldap.userSearch variable would be 

(userPrincipalName={0}@mydomain.mycompany.com)

For a user awilson@example.com, the ldap.userSearch variable would be 

(userPrincipalName={0})

• The ldap.principalPattern would be {0}@mydomain.mycompany.com.

For a user awilson@example.com, the ldap.principalPattern would be 

{0}@example.com.

ldap.userPassword

The name of the LDAP attribute in the user's directory entry that contains the user's 

password. In Active Directory, password is the default name of the attribute.

ldap.userPassword=password 

ldap.userEmail

The name of the LDAP attribute in the user's directory entry that contains the user's email 

address.

Note:  The ldap.userEmail  property cannot have a null value. If your Active Directory 

Tree does not contain email information, a different attribute must be used. For example, 

ldap.userEmail  might be set to userPrincipalName.

ldap.userRealm

Realm name that is used for user authentication. This setting is optional and can be 

commented out, in the ldap.properties file, for most configurations.

ldap.userRealm=users.company.domain.com

ldap.principalPattern

Pattern for construction of user principal for using LDAP authentication. Some LDAP servers 

require email address, for example, userid@domain.com and others require the user ID 

only. The string “{0} is substituted by the users user ID entered at the login screen.
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Searching for the users directory entry

The method available for finding the end-users information involves defining a starting point in the Active 

Directory tree and allowing BigFix Remote Control to recursively search through the tree for the userid. 

For most Active Directory implementations this is the preferred method as users are usually spread out 

in several locations in an Active Directory tree. This method is especially helpful if user information is 

contained under a single branch of the tree but broken up by department or underneath the branch

Note:  It should be noted that when LDAP has been enabled, new users and new user groups 

should be created in Active Directory and not in BigFix Remote Control. This is because each time the 

synchronization with Active Directory takes place the users and user groups are deleted from the BigFix

Remote Control database and then imported again from Active Directory.

To use the recursive search configure the following parameters:

ldap.userBase

The base LDAP directory entry for looking up users that match the search criteria. If not 

specified, the search base is the top-level element in the directory context.

for example OU=mylocation,DC=mycompany,DC=com

You can refine your search by going deeper into the OU structure and selecting to search 

only within a specific organizational unit for example an OU called Users and therefore you 

would set the property value as

 ldap.userBase=OU=Users,ou=mylocation,dc=mydomain,dc=mycompany,dc=com

This would instruct BigFix Remote Control to look for users matching the criteria, only within 

the Users OU (and any OUs that belong to the Users OU if ldap.groupSubtree is set to true)

ldap.userSearch

Defines the LDAP query that is used to import Active Directory users to BigFix Remote 

Control. The defined query needs to filter the results such that only those users which match 

the search criteria are imported to BigFix Remote Control. The default value is

(objectClass=user)

which means, look for users in any object that is a user object within the userbase. That is 

import all Active Directory users to BigFix Remote Control.

Note:  When using the above it should be noted that some environments can have 

thousands of users therefore it is important to create a filter which will only import the 

required users. To limit the users that are imported to only those users who match the 

search criteria and are members of the groups that were imported into BigFix Remote 
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Control through the ldap.groupSearch filter, you should set the property ldap.userInGroup

to true. It should also be noted that as well as being imported into the relevant groups that 

are returned in the group search, users are also imported into the DefaultGroup. Setting 

ldap.userInGroup to false will import all users who match the search criteria, regardless of 

their group membership.

The search can therefore be further refined by using more complex queries. For example if 

you have the following values set

ldap.groupBase=(OU=mylocation.DC=mycompany.DC=com) 

Ldap.userSearch: (&(objectClass=user)(|(memberOf=CN=Department1,OU=GROUPS, 

OU=mylocation,DC=mycompany,DC=com) (memberOf=CN=Department3,OU=GROUPS, 

OU=mylocation,DC=mycompany,DC=com))(name={0}))

If there were three groups defined, Department1, Department2 and Department3 the above 

query would authenticate and import any users that are defined as objectclass user and are 

members of the Department1 OR Department3 groups. Users from Department2 would not 

be able to logon to BigFix Remote Control.

The (&(name={0}) is added to the end to specify that the name attribute is used for logging 

in. This value has to match whatever attribute was specified as ldap.userid.

ldap.userSubtree

Set this value to true if you want to recursively search the sub tree of the element specified 

by the userBase attribute for the user's directory entry. The default value of false causes 

only the top level to be searched (a nonrecursive search). This is ignored if you are using the 

userPattern expression.

ldap.userSubtree=true

Importing Active Directory Groups
One of the greatest benefits of integrating with Active Directory is being able to use existing Active 

Directory groups. After Active Directory groups are imported, an administrator must define the 

permissions for each group and group membership is handled inherently by Active Directory. To import 

Active Directory groups, configure the following properties in the ldap.properties file.

ldap.groupName

The LDAP attribute name that is used for the group search.

ldap.groupName=cn    OR   ldap.groupName=name
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ldap.groupDescription

The LDAP attribute name to be used to get the description for the group. It is set to 

description by default.

ldap.groupDescription=description    

ldap.groupNameTrim

Set to true or false. Limits the group name that is imported to the BigFix Remote Control

database to 64 characters. The recommended value is false.

ldap.groupMembers

LDAP attribute name to be used to find the members of the groups that are returned as a 

result of the specified search. The default value is member.

ldapgroupMembers=member

ldap.groupSubtree

If set to true, BigFix Remote Control searches recursively through the subtree of the element 

that is specified in the ldap.groupBase parameter for groups that are associated with a user. 

If left unspecified, the default value of false causes only the top level to be searched, and no 

recursive search is run. True or False (default).

ldap.groupBase

The base LDAP directory entry for starting the search for groups to synchronize. If left 

unspecified, the default is to use the top-level element in the directory context.

for example OU=mylocation,DC=mycompany,DC=com

To refine your search and go deeper into the OU structure, select to start the search only 

within a specific organizational unit. For example, an OU called Test. Set the property to the 

following value.

OU=Test,OU=mylocation,DC=mycompany,DC=com

Therefore, BigFix Remote Control looks for groups that match the criteria, only within the 

Test OU (and any OUs that belong to the Test OU if ldap.groupSubtree is set to true).

ldap.groupSearch

Defines the LDAP query that is used to import AD groups to BigFix Remote Control. The 

defined query needs to filter the results such that only those groups that are needed are 

imported to BigFix Remote Control.

ldap.groupSearch=(objectClass=group)
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Imports all AD groups found in the OU specified in the ldap.groupBase

property to BigFix Remote Control. Some environment can have thousands of 

groups.

ldap.groupSearch=(&(objectClass=group)(cn=*SMS*))

Imports all groups that contain SMS in the cn attribute. For example, visio-

sms-users.

ldap.groupSearch=(&(objectClass=group)(cn=admins))

Imports all groups that are named admins.

ldap.groupSearch=(&(objectClass=group)(cn=admins*))

Imports all groups that have the text admins in the name. For example, 

administrators, server-administrators.

ldap.groupMembers

LDAP attribute name to be used to find the members of the groups that are returned as a 

result of the specified search. The default value is member.

These queries can be tested by using the LDAP browsers directory search option or the LDAP 

configuration utility in the BigFix Remote Control server UI.

Testing the Connection
When the common.properties & ldap.properties files are updated, reset the BigFix Remote 

Control application by selecting Admin > Reset Application.

When the service restarts, log on to the BigFix Remote Control server by using an Active Directory user ID 

and password. If the entries in the LDAP properties file are correct, you are authenticated and logged on 

successfully.

BigFix Remote Control Server connects directly to LDAP. Therefore, any password changes within LDAP 

are immediately effective only if the LDAP password change synchronizes to the LDAP server that is set 

within the ldap.properties file.

Note:  The default ADMIN user ID within the BigFix Remote Control Server application always 

authenticates against the BigFix Remote Control Server regardless of whether LDAP authentication is 

enabled. If there is a connectivity problem between BigFix Remote Control Server and LDAP, the ADMIN 

user can always log on.
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If there are any errors in the ldap.properties file, you see a failed logon message. The Logon screen 

is displayed with an Invalid user name or wrong password message.

To determine the cause of the failure look in the trc.log file. View the application log by using the 

server UI.

• In the BigFix Remote Control Server UI, click Admin > View application log

• Click CTRL+END to reach the end of the file.

The following common errors can be displayed. The errors indicate a problem with creating the initial 

connection between BigFix Remote Control Server and Active Directory.

AcceptSecurityContext error, data 525

Returns when user name is invalid.

AcceptSecurityContext error, data 52e

Returns when user name is valid but password or credentials are invalid. Prevents most 

other errors from being displayed as noted.

AcceptSecurityContext error, data 530

Logon failure: account logon time restriction violation. Displays only when presented with 

valid user name and password credentials.

AcceptSecurityContext error, data 531

Log on failure: user is not allowed to log on to this computer. Displays only when presented 

with valid user name and password credentials.

AcceptSecurityContext error, data 532

Logon failure: the specified account password is expired. Displays only when presented with 

valid user name and password credentials.

AcceptSecurityContext error, data 533

Logon failure: account currently disabled. Displays only when presented with valid user 

name and password credential.

AcceptSecurityContext error, data 701

The user's account is expired. Displays only when presented with valid user name and 

password credential.

AcceptSecurityContext error, data 773

The user's password must be changed before they log on for the first time. Displays only 

when presented with valid user name and password credential.
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AcceptSecurityContext error, data 775

The referenced account is locked out and cannot be logged on to. Displays even if invalid 

password is presented.

LDAP Authentication.exceptionmyserver.mydomain.com:389

Displays when the server name specified by ldap.connectionURL is unreachable.

Verifying that the groups are imported
When authentication is successful and you are logged on to the BigFix Remote Control server, click User 

groups > All User Groups to verify that the correct groups were imported from Active Directory.

After the groups are imported into BigFix Remote Control, define permissions for the newly imported 

groups.

Sample LDAP Configuration File
The file is a sample configuration file. It uses a simple connection to Active Directory with importing of 

Active Directory groups

# Licensed Materials - Property of IBM Corporation

# 5724-N88 5725-C431

# (C) Copyright HCL Technologies Ltd. 2001, 2020

# All Rights Reserved

# US Government Users Restricted Rights - Use, duplication or

# disclosure restricted by GSA ADP Schedule Contract with IBM Corp.

# LDAP Properties

# Server Authentication definition

# The directory URL used to establish an LDAP connection

ldap.connectionURL=ldap://myldapserver

# define the secondary LDAP server name, if the primary is down we can use an alternative LDAP server

#–ldap.alternateURL=
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# The username used to authenticate a read-only LDAP connection. If left not set, an anonymous 

connection is made.

ldap.connectionName=administrator@mydomain.MyCompany.com

# The password used to establish a read-only LDAP connection.

ldap.connectionPassword=myPassword

# Instructs Remote Control to read the value of the password parameter as encrypted ( true) or plain text 

( false). See Admin guide for instructions on generating encrypted password

ldap.connectionPasswordEncrypted=false

# The fully qualified Java class name of the JNDI context factory to be used for

# this connection. If left unset, the default JNDI LDAP provider class is used.

# --- -ldap.contextFactory=com.sun.jndi.ldap.LdapCtxFactory

# ##################### SASL Definition 

##########################################

# specifying the security level to use. Its value is one of the following strings: "simple" or "DIGEST-MD5".

# . If using SSL, you have to use simple.

ldap.security_authentication=simple

#Identifies the realm or domain from which the connection name should be chosen

# ---- ldap.connectionRealm=

#Quality of protection

# QOP can be one of: auth, auth-int, auth-conf

# auth -- Authentication only

# auth-int --Authentication and integrity checking by using signatures

# auth-conf -- (SASL only) Authentication, integrity and confidentiality checking

# by using signatures and encryption.

# ----ldap.connectionQop=auth

# Number indicating the size of the largest buffer the server is able to receive when

# using "auth-int" or "auth-conf". The default is 65536.

# ldap.connectionMaxbuf=16384
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# Strength can be one of: low,medium,high

# ----ldap.connectionStrength=high

# ########################### SSL Definition 

##########################################

# specifying the security protocol to use. Its value is a string determined by

# the service provider (for example: "ssl"). If this property is unspecified, the behaviour

# is determined by the service provider.

# ----ldap.security_protocol=ssl

# Access the keystore, this is where the Root CA public key cert was installed

# No need to specify the keystore password for read operations

# ----ldap.ssl_keyStore=PathOfKeyStoreFile

# ----ldap.ssl_keyStorePassword=KeystorePassword

# specifying how referrals encountered by the service provider are to be processed.

# The value of the property is one of the following strings:

# "follow" -- follow referrals automatically

# "ignore" -- ignore referrals

# "throw" -- throw ReferralException when a referral is encountered.

# If this property is not specified, the default is determined by the provider.

# ----ldap.referrals=follow

# ########################## define Group search for LDAP ########################

# The base LDAP directory entry for looking up group information. If left unspecified,

# the default is to use the top-level element in the directory context.

ldap.groupBase=OU=Groups,OU=mylocation,DC=mydomain,DC=mycompany,

DC=com

#The LDAP filter expression used for performing group searches.

ldap.groupSearch=(&(objectClass=group) (name=TRC*))

# Set to true if you want to recursively search the subtree of the element specified in

# the groupBase attribute for groups associated with a user. If left unspecified, the default
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# value of false causes only the top level to be searched (a nonrecursive search).

ldap.groupSubtree=true

#The LDAP attribute that we should use for group names.

ldap.groupName=name

#The LDAP attribute that we should use for group descriptions

ldap.groupDescription=description

# This is the attribute specifying user members within a group

ldap.groupMembers=member

# ########################## User search definition ########################

#The base of the subtree containing users

#If not specified, the search base is the top-level context.

ldap.userBase=OU=Users,OU=mylocation,DC=mydomain,DC=mycompany, DC=com

# The LDAP filter expression to use when searching for a user's directory entry, with {0} marking

# where the actual username is inserted.

ldap.userSearch=(&(objectClass=User)(sAMAccountName={0}))

# Set this value to true if you want to recursively search the subtree of the element specified by

# the userBase attribute for the user's directory entry. The default value of false causes only the

# top level to be searched (a nonrecursive search).

ldap.userSubtree=true

#Set this value to true if a user has to be a member of the groups found in the group search

ldap.userInGroup=true

# Digest algorithm (SHA, MD2, or MD5 only)

# Remote control will use it to encrypt the user input password and

# compare it with password it receives from the LDAP server. If left unspecified, the default value is 

"cleartext".

# ---- ldap.digest=SHA

#LDAP attribute used for userids
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ldap.userid=sAMAccountname

# LDAP User password attribute

ldap.userPassword=password

# LDAP Attribute containing the Users Email address

ldap.userEmail=userPrincipalName

# If the following parameters are defined they are mapped into the local remote control database

ldap.forename=givenName

ldap.surname=sn

ldap.title=title

ldap.initials=initialsg

ldap.company=company

ldap.department=department

ldap.telephone=telephoneNumber

ldap.mobile=mobile

ldap.state=st

ldap.country=Co

#### Other property definitions

#Set this value to the page size of LDAP search retrievals (default=500).

# Do not set this to anything greater than the max page size for the LDAP server ( for example, AD has a 

limit of 1000)

ldap.page.size=500



Chapter 11. Federal information processing standard 
(FIPS 140-2) compliance in BigFix Remote Control

The US Federal information processing standard 140-2 (FIPS 140-2) is a cryptographic function 

validation program that defines security standards for cryptographic modules that are used in IT 

software. In FIPS 140-2 mode, BigFix Remote Control uses the FIPS 140-2 approved cryptographic 

providers; IBMJCEFIPS (certificate #1081), IBMJSSEFIPS (certificate 409), and OpenSSL FIPS Object 

Module (certificate #1747). The certificate for IBMJCEFIPS (certificate #1081) is held on the NIST 

website at http://csrc.nist.gov/groups/STM/cmvp/documents/140-1/1401val2009.htm#1081. The 

certificate for IBMJSSEFIPS (certificate 409) is held on the NIST website at http://csrc.nist.gov/

groups/STM/cmvp/documents/140-1/1401val2004.htm#409. The certificate for OpenSSL FIPS Object 

Module (certificate #1747) is held on the NIST website at http://csrc.nist.gov/groups/STM/cmvp/

documents/140-1/1401val2012.htm#1747. To enable FIPS for BigFix Remote Control you must configure 

all components, the server, controller, and target.

BigFix Remote Control version 9.x.x uses:

IBM Java JCE FIPS 140-2 Cryptographic Module version 1.3.1 Tested as meeting Level 1 with Windows

XP Professional SP2 operating system that uses IBM JVM 1.6 (single-user mode) FIPS-approved 

algorithms:

• AES (Cert. #805);

• DSA (Cert. #297);

• HMAC (Cert. #445);

• RNG (Cert. #463);

• RSA (Cert. #387);

• SHS (Cert. #803);

• Triple-DES (Cert. #687).

IBM Java JSSE FIPS 140-2 Cryptographic Module version 1.1 Tested as meeting Level 1 with

• Windows 2000 Professional SP3 operating system (JVM 1.3.1_03 and JVM 1.4.1_04), Windows 2000 

Advanced Server SP4 operating system (JVM 1.4.1)

• Sun Solaris 5.8 (JVM 1.3.1 and 1.4.1)

• AIX 5.2 (JVM 1.3.1 and 1.4.1)

• SuSE Linux Enterprise Server 8 (JVM 1.4.1_05)

• Red Hat Linux Advanced Server 2.1(JVM 1.4.1_05)

• IBM OS/400® V5R2M0 (JVM 1.4.1)
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• z/OSV1R4 (JVM 1.4.1)

FIPS-approved algorithms:

• SHA-1 (Cert. #148);

• Triple-DES (Cert. #163);

• AES (Cert. #53);

• DSA (Cert. #83);

• RSA (PKCS#1, vendor affirmed);

• HMAC-SHA-1 (Cert. #148, vendor affirmed);

OpenSSL FIPS Object Module version 2.0.2 Tested as meeting Level 1 with

• Android

◦ Android 2.2 (gcc Compiler Version 4.4.0);

◦ Android 2.2 running on Qualcom QSD8250 (ARMv7) with NEON (gcc Compiler Version 4.4.0);

◦ Android 2.2 running on OMAP 3530 (ARMv7) with NEON (gcc Compiler Version 4.1.0);

◦ Android 3.0 (gcc Compiler Version 4.4.0);

◦ Android 4.0 (gcc Compiler Version 4.4.3);

◦ Android 4.0 running on TI OMAP 3 (ARMv7) with NEON (gcc Compiler Version 4.4.3);

◦ Android 4.1 running on TI DM3730 (ARMv7) (gcc Compiler Version 4.6);

◦ Android 4.1 running on TI DM3730 (ARMv7) with NEON (gcc Complier Version 4.6);

◦ Android 4.2 running on Nvidia Tegra 3 (ARMv7) (gcc Compiler Version 4.6);

◦ Android 4.2 running on Nvidia Tegra 3 (ARMv7) with Neon (gcc Compiler Version 4.6) (single-

user mode).

• Microsoft Windows 7

◦ Microsoft Windows 7 (32-bit) (Microsoft 32-bit C/C++ Optimizing Compiler Version 16.00);

◦ Microsoft Windows 7 (64 bit) (Microsoft C/C++ Optimizing Compiler Version 16.00);

◦ Microsoft Windows 7 running on Intel Core i5-2430M (64-bit) with AES-NI (Microsoft® C/C++ 

Optimizing Compiler Version 16.00 for x64);

• Microsoft Windows 2008

◦ Microsoft Windows 2008 running on Intel Xeon™ E3-1220v2 (32-bit under vSphere) (Microsoft

32-bit C/C++ Optimizing Compiler Version 16.00 for 80x86);

◦ Microsoft Windows 2008 running on Intel Xeon E3-1220v2 (64-bit under vSphere) (Microsoft C/C

++ Optimizing Compiler Version 16.00 for x64);

• uCLinux 0.9.29 (gcc Compiler Version 4.2.1);

• Fedora 14 running on Intel Core i5 with AES-NI (gcc Compiler Version 4.5.1);

• HP-UX 11i (32 bit) (HP C/aC++ B3910B); HP-UX 11i (64 bit) (HP C/aC++ B3910B);
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• Ubuntu 10.04

◦ Ubuntu 10.04 (32 bit) (gcc Compiler Version 4.1.3);

◦ Ubuntu 10.04 (64 bit) (gcc Compiler Version 4.1.3);

◦ Ubuntu 10.04 running on Intel Core i5 with AES-NI (32 bit) (gcc Compiler Version 4.1.3);

• Linux

◦ Linux 2.6 (gcc Compiler Version 4.3.2);

◦ Linux 2.6.27 (gcc Compiler Version 4.2.4);

◦ Linux 2.6.32 (gcc Compiler Version 4.3.2);

◦ Linux 2.6.33 (gcc Compiler Version 4.1.0);

◦ Linux 2.6 (gcc Compiler Version 4.1.0);

• VxWorks 6.8 (gcc Compiler Version 4.1.2);

• Oracle Solaris

◦ Oracle Solaris 10 (32 bit) (gcc Compiler Version 3.4.3);

◦ Oracle Solaris 10 (64 bit) (gcc Compiler Version 3.4.3);

◦ Oracle Solaris 11(32 bit) (gcc Compiler Version 4.5.2);

◦ Oracle Solaris 11 (64 bit) (gcc Compiler Version 4.5.2);

◦ Oracle Solaris 11 running on Intel Xeon 5675 with AES-NI (32 bit) (gcc Compiler Version 4.5.2);

◦ Oracle Solaris 11 running on Intel Xeon 5675 with AES-NI (64 bit) (gcc Compiler Version 4.5.2);

◦ Oracle Solaris 11 (32 bit) (Sun C Version 5.12); Oracle Solaris 11 (64 bit) (Sun C Version 5.12);

• Oracle Linux

◦ Oracle Linux 5 (64 bit) (gcc Compiler Version 4.1.2);

◦ Oracle Linux 5 running on Intel Xeon 5675 with AES-NI (gcc Compiler Version 4.1.2);

◦ Oracle Linux 6 (gcc Compiler Version 4.4.6);

◦ Oracle Linux 6 running on Intel Xeon 5675 with AES-NI (gcc Compiler Version 4.4.6);

• CascadeOS 6.1 (32 bit) (gcc Compiler Version 4.4.5); CascadeOS 6.1 (64 bit) (gcc Compiler Version 

4.4.5);

• Apple iOS 5.1 (gcc Compiler Version 4.2.1);

• Microsoft Windows CE 6.0 (Microsoft C/C++ Optimizing Compiler Version 15.00 for ARM); Microsoft

Windows CE 5.0 (Microsoft C/C++ Optimizing Compiler Version 13.10 for ARM);

• DSP Media Framework 1.4 (TMS320C6x C/C++ Compiler v6.0.13);

• NetBSD 5.1 (gcc Compiler Version 4.1.3);

• RHEL 6

◦ RHEL 6 running on Intel Xeon E3-1220v2 (32-bit under vSphere) (gcc Compiler Version 4.4.6);

◦ RHEL 6 running on Intel Xeon E3-1220v2 (64-bit under vSphere) (gcc Complier Version 4.4.6);

FIPS-approved algorithms:

• AES (Certs. #1884, #2116, and #2234);
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• DRBG (Certs. #157, #229, and #264);

• DSA (Certs. #589, #661, and #693);

• HMAC (Certs. #1126, #1288, and #1363);

• RNG (Certs. #985, #1087, and #1119);

• RSA (Certs. #960, #1086, and #1145);

• SHS (Certs. #1655, #1840, and #1923);

• Triple-DES (Certs. #1223, #1346, and #1398);

• ECDSA (Certs. #264, #270, #315, #347 and #378);

• CVL (Certs. #10, #12, #24, #36 and #49).

Enable FIPS compliance on the server

Enabling FIPS compliance on a server installation with a stand-alone 
WebSphere Application Server

The BigFix Remote Control Server uses the middleware infrastructure that is provided by WebSphere

secure HTTP communications. Therefore, to enable FIPS for a manual BigFix Remote Control Server

installation requires that you configure WebSphere for FIPS-compliant mode. You must also configure the 

BigFix Remote Control Server through a setting in the common.properties configuration file.

To enable FIPS compliance for a manual installation, complete the following steps:

1. Configure WebSphere

The WebSphere documentation describes how to enable FIPS mode in WebSphere.

• WebSphere Application Server:

◦ v7.0: http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/

com.ibm.websphere.base.doc/info/aes/ae/tsec_fips.html

◦ v8.5:http://pic.dhe.ibm.com/infocenter/wasinfo/v6r1/index.jsp?topic=/

com.ibm.websphere.base.doc/info/aes/ae/tsec_fips.html

• WebSphere Application Server Network Deployment:

◦ v7.0: http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/

com.ibm.websphere.nd.doc/info/ae/ae/rovr_fips.html

◦ v8.5: http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=

%2Fcom.ibm.websphere.nd.doc%2Fae%2Ftsec_fips.html

• WebSphere Application Server - Express™:

◦ v7.0:http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/

com.ibm.websphere.express.doc/info/exp/ae/tsec_fips.html

http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/com.ibm.websphere.base.doc/info/aes/ae/tsec_fips.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/com.ibm.websphere.base.doc/info/aes/ae/tsec_fips.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=%2Fcom.ibm.websphere.base.doc%2Fae%2Ftsec_fips.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=%2Fcom.ibm.websphere.base.doc%2Fae%2Ftsec_fips.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/rovr_fips.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/rovr_fips.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=%2Fcom.ibm.websphere.nd.doc%2Fae%2Ftsec_fips.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=%2Fcom.ibm.websphere.nd.doc%2Fae%2Ftsec_fips.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/com.ibm.websphere.express.doc/info/exp/ae/tsec_fips.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/com.ibm.websphere.express.doc/info/exp/ae/tsec_fips.html
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◦ v8.5:http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=

%2Fcom.ibm.websphere.express.doc%2Fae%2Ftsec_fips.html

Note:  Running in FIPS mode in IBM WebSphere with the IBM JRE and the IBM JSSE provider 

currently does not work when you use an MS SQL database. These options work with MS SQL when 

FIPS is not enabled in IBM WebSphere.

2. Log on to the BigFix Remote Control Server with a valid admin ID and password.

3. Click Admin > Edit properties files

4. In the common.properties file set FIPS.compliance to true.

5. Click Submit.

6. Click Admin > Reset Application.

Note:  The FIPS enablement changes in WebSphere affect all other applications that are running on 

the server. Therefore, browser settings for the users who access the other applications must be changed 

to support Transport Layer Security (TLS), if required by their browser version.

For example, to enable TLS in Internet Explorer complete the following steps:

• Click Tools > Internet Options.

• On the Advanced tab, select Use TLS 1.0.

• Click Apply

• Click OK.

Enabling FIPS compliance on an automated server installation

To enable FIPS compliance on an automated BigFix Remote Control Server installation, complete the 

following steps:

1. Edit the java.security file that is found at the following directory.

Windows systems

%TRC_SERVER_PATH%\java\jre\lib\security\java.security

Where %TRC_SERVER_PATH% is the path for the installation directory for the BigFix

Remote Control Server.

Linux / UNIX systems

http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=%2Fcom.ibm.websphere.express.doc%2Fae%2Ftsec_fips.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp?topic=%2Fcom.ibm.websphere.express.doc%2Fae%2Ftsec_fips.html
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$TRC_SERVER_PATH/java/jre/lib/security/java.security

Where $TRC_SERVER_PATH is the path for the installation directory for the BigFix

Remote Control Server.

2. Modify the security.provider.x= list so the following entry is the first one in the list:

security.provider.1=com.ibm.crypto.FIPS.provider.IBMJCEFIPS

security.provider.1=com.ibm.fips.jsse.IBMJSSEFIPS

security.provider.2=com.ibm.crypto.fips.provider.IBMJCEFIPS

Fix the number sequence of the other items in this list so that all items are numbered in sequence. 

For example, the full list after the changes is as follows:

security.provider.1=com.ibm.fips.jsse.IBMJSSEFIPS

security.provider.2=com.ibm.crypto.fips.provider.IBMJCEFIPS

security.provider.3=com.ibm.jsse2.IBMJSSEProvider2

security.provider.4=com.ibm.crypto.provider.IBMJCE

security.provider.5=com.ibm.security.jgss.IBMJGSSProvider

security.provider.6=com.ibm.security.cert.IBMCertPath

security.provider.7=com.ibm.security.sasl.IBMSASL

security.provider.8=com.ibm.xml.crypto.IBMXMLCryptoProvider

security.provider.9=com.ibm.xml.enc.IBMXMLEncProvider

security.provider.10=com.ibm.security.jgss.mech.spnego.IBMSPNEGO

security.provider.11=sun.security.provider.Sun

security.provider.1=com.ibm.crypto.FIPS.provider.IBMJCEFIPS

security.provider.2=com.ibm.crypto.provider.IBMJCE

security.provider.3=com.ibm.jsse.IBMJSSEProvider

security.provider.4=com.ibm.jsse2.IBMJSSEProvider2

security.provider.5=com.ibm.security.jgss.IBMJGSSProvider

security.provider.6=com.ibm.security.cert.IBMCertPath

security.provider.7=com.ibm.crypto.pkcs11impl.provider.IBMPKCS11Impl

security.provider.8=com.ibm.security.cmskeystore.CMSProvider

security.provider.9=com.ibm.security.jgss.mech.spnego.IBMSPNEGO

security.provider.10=com.ibm.security.sasl.IBMSASL

security.provider.11=com.ibm.xml.crypto.IBMXMLCryptoProvider

security.provider.12=com.ibm.xml.enc.IBMXMLEncProvider

security.provider.13=org.apache.harmony.security.provider.PolicyProvider

3. Save the file.
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4. Edit the jvm.options file and add a new line, -Dcom.ibm.jsse2.usefipsprovider=true.

Windows systems

%TRC_SERVER_PATH% \wlp\usr\servers\trcserver\jvm.options

Where %TRC_SERVER_PATH% is the path for the installation directory for the BigFix

Remote Control Server.

Linux / UNIX systems

$TRC_SERVER_PATH/wlp/usr/servers/trcserver/jvm.options

Where $TRC_SERVER_PATH is the path for the installation directory for the BigFix

Remote Control Server.

5. Log on to the BigFix Remote Control Server with a valid admin ID and password.

6. Click Admin > Edit properties files

7. In the common.properties file set FIPS.compliance to true.

8. Click Submit.

9. Click Admin > Reset Application. Restart the server service.

Check to see whether the BigFix Remote Control Server is configured for FIPS by completing the following 

step.

• Click Admin > View Current Server Status.

The following fields show that FIPS compliance is enabled.

• Enabled FIPS mode: - The value of this field is determined by the FIPS.compliance property in the 

common.properties file.

• JVM configured for FIPS: - The value of this field is determined by the configuration of the JVM and 

the security providers that are listed in the java.security file.

Enabling FIPS compliance on the controller
The BigFix Remote Control controller is a Java application that requires a FIPS certified cryptographic 

provider when FIPS compliance is enabled. Only the IBM Java Runtime Environment (JRE) is supported in 

FIPS-compliant mode.
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The IBM JRE for Windows operating system and Linux (Intel) operating systems is included with BigFix

Remote Control and is installed when you install the controller software.

If you are using Windows operating system, the JRE is included in the controller package 

trc_controller_setup.exe and trc_controller.msi. For Linux operating system, the JRE is 

included in the package ibm-trc-controller-jre-9.x.x.i386.rpm. Where 9.x.x is the version 

that you want to install. For example, 9.1.0. These packages install the IBM Java Runtime Environment 

pre-configured with the IBM FIPS certified cryptographic provider. They also register the MIME type 

application/x-ibm-trc-jws and a file association for *.trcjws files. The file types are used by the 

BigFix Remote Control server in FIPS-compliant mode to start the controller. For more information about 

installation instructions for the controller, see Install the controller (on page 95).

To use a different installation of the IBM JRE, the BigFix Remote Control controller uses the FIPS-

compliant cryptography module that is included with the IBM Java virtual machine. To enable FIPS mode, 

the settings of the JVM (Java virtual machine) that are used to run the controller need to be modified. 

When you enable FIPS compliance, any other Java applications that are running on the default JVM can 

also use the FIPS provider and the other security providers that are listed in the java.security file.

Note:  Enabling FIPS on the controller is not supported if you are using an Oracle JVM.

To enable FIPS compliance on the controller if you are not using the version of IBM JRE supplied with 

BigFix Remote Control, complete the following steps:

1. Edit the java.security file

Windows systems

%JRE_HOME%\lib\security\java.security

Where %JRE_HOME% is the path to the directory where the Java virtual machines

Java Runtime Environment (JRE) is installed.

Linux / UNIX systems

$JRE_HOME/lib/security/java.security

Where $JRE_HOME is the path to the directory where the Java virtual machines Java

Runtime Environment (JRE) is installed.

2. Modify the security.provider.x= list so that the following two entries are the first ones in the list:

security.provider.1=com.ibm.fips.jsse.IBMJSSEFIPS

security.provider.2=com.ibm.crypto.fips.provider.IBMJCEFIPS

Fix the number sequence of the other items in this list so that all items are numbered in sequence. 

For example,
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security.provider.1=com.ibm.fips.jsse.IBMJSSEFIPS

security.provider.2=com.ibm.crypto.fips.provider.IBMJCEFIPS

security.provider.3=com.ibm.jsse2.IBMJSSEProvider2

security.provider.4=com.ibm.crypto.provider.IBMJCE

security.provider.5=com.ibm.security.jgss.IBMJGSSProvider

security.provider.6=com.ibm.security.cert.IBMCertPath

security.provider.7=com.ibm.security.sasl.IBMSASL

security.provider.8=com.ibm.xml.crypto.IBMXMLCryptoProvider

security.provider.9=com.ibm.xml.enc.IBMXMLEncProvider

security.provider.10=org.apache.harmony.security.provider.PolicyProvider

security.provider.11=com.ibm.security.jgss.mech.spnego.IBMSPNEGO

Note:

a. Applies to all supported versions of the IBM JVM.

b. You must make a file association for the *.trcjws files before you start the first session with a 

target. Use the following commands

Windows systems

%JRE_HOME%\jre\bin\javaws

Where %JRE_HOME% is the path to the directory where the Java virtual machines

Java Runtime Environment (JRE) is installed.

Linux / UNIX systems

$JRE_HOME/jre/bin/javaws.exe

Where $JRE_HOME  is the path to the directory where the Java virtual machines

Java Runtime Environment (JRE) is installed.

Check to see whether the controller is configured for FIPS by completing the following step during a 

remote control session.

• Click Controller tools > Show session information in the controller window.

Edit the trc_controller.cfg file on the system that the controller is installed on.

Note:  Only required if you are running the controller locally for establishing peer to peer sessions. For 

more information about installing the controller to your local system, see Install the controller (on page 

95) .

Windows systems
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[controller install dir]\trc_controller.cfg

Where [controller install dir] is the installation directory that is chosen when you install the 

controller.

Linux systems

/opt/ibm/trc/controller/trc_controller.cfg

Set the fips.compliance property to true and save the file.

Enable FIPS compliance on the target
The BigFix Remote Control target includes FIPS-capable OpenSSL libraries. You can enable FIPS 

compliance at installation time or by editing the target registry on a Windows system or by changing the 

configuration file on a Linux system.

For more information about installing the target, see the BigFix Remote Control Installation Guide.

Using the target user interface, choose the appropriate option to verify that the target is in FIPS mode.

• On the BigFix Remote Control- Target user interface, click Actions Menu > Connection info

• Hover the mouse over the BigFix Remote Control icon in the system notification area.

Enabling FIPS compliance on a Windows target

On a Windows system, you can enable FIPS compliance on the target in two ways; during installation or 

by editing the target registry after installation.

Enabling FIPS compliance by using the target installer

Enable the FIPS compliance target property during installation by completing the following steps:

1. On the Server Address panel of the target installer, click Advanced settings.

2. Select Use a FIPS certified cryptographic provider and Use secure connections (https). Continue 

with the rest of the target installation.
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Performing a silent installation

When performing a silent target installation, run the installation command and use the FIPSCOMPLIANCE

property to enable FIPS on the target . For more details of performing a silent installation, see Running a 

target custom installation on a Windows system (on page 85).

Use the following properties when enabling FIPS mode

• TRC_SERVER_PROTOCOL=https

• TRC_SERVER_PORT=443

• FIPSCOMPLIANCE=yes

For example : trc_target_setup.exe /s /v"/qn TRC_SERVER_HOSTNAME=yourserver 

TRC_SERVER_PROTOCOL=https TRC_SERVER_PORT=443 FIPSCOMPLIANCE=yes"

where yourserver is the hostname or IP address of your BigFix Remote Control Server.

Enabling FIPS compliance after target installation

After you install the BigFix Remote Control target, you can enable FIPS compliance by editing the target 

registry. To enable FIPS compliance, complete the following steps.

1. Run the regedit command at a command prompt window.

2. In the Windows registry, go to HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Tivoli\Remote 

Control\Target

3. Right-click FIPSCompliance and select Modify.

4. Type yes in the Value data field and click OK.

5. Restart the target service.

For more information about restarting the target service, see Manage the component services (on 

page 127). Follow the steps in the section that is relevant to your operating system.

Enabling FIPS compliance in Linux or UNIX based operating systems

After you install the BigFix Remote Control target, you can enable FIPS compliance by editing the 

ibmtrct.conf file. To enable FIPS compliance, complete the following steps:

1. Edit the /etc/ibmtrct.conf  file.
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2. Set the value of FIPSCompliance to yes and save the file.

3. Restart the target service.

For more information about restarting the target service, see Manage the component services (on 

page 127). Follow the steps in the section that is relevant to your operating system.

Enabling FIPS compliance on the gateway
You can enable FIPS compliance on the gateway component by editing the gateway configuration file that 

is created when you install gateway support.

The trc_gateway.properties file is in the following directory.

Windows systems

\Documents and Settings\All Users\Application Data\IBM\Tivoli\Remote 

Control\Gateway

or \ProgramData\IBM\Tivoli\Remote Control\Gateway.

Linux systems

/etc

To enable FIPS compliance, complete the following steps.

1. Edit the trc_gateway.properties file.

2. Set FIPSCompliance = Yes.

3. Save the file.

4. Restart the gateway service.

For more information about restarting the gateway service, see Manage the component services (on 

page 127). Follow the steps in the section that is relevant to your operating system.

Enabling FIPS compliance on the broker
You can enable FIPS compliance on the broker component by editing the broker configuration file that is 

created when you install broker support.

The trc_broker.properties file is in the following directory.

Windows systems
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\Documents and Settings\All Users\Application Data\IBM\Tivoli\Remote 

Control\broker.

or \ProgramData\IBM\Tivoli\Remote Control\broker.

Linux systems

/etc

To enable FIPS compliance, complete the following steps.

1. Edit the trc_broker.properties file.

2. Set FIPSCompliance = Yes.

3. Save the file.

4. Restart the broker service.

For more information about restarting the broker service, see Manage the component services (on 

page 127). Follow the steps in the section that is relevant to your operating system.



Chapter 12. NIST SP800-131A compliance in BigFix
Remote Control

BigFix Remote Control version 9.1.0 components can be configured for NIST SP800-131A compliance.

The National Institute of Standards and Technology (NIST) Special Publications (SP) 800-131A standard 

strengthens algorithms and increases the cryptographic key lengths to improve security.

The following prerequisites are required:

• Ensure that all keys have at least a key security strength greater than or equal to 112 bits. RSA keys 

must be at least 2048 bits.

• Ensure that all certificates are created with the new key strengths. Any RSA certificates that use keys 

shorter than 2048 bits must be replaced with a certificate that uses 2048-bit keys or higher.

• Ensure that all certificates are signed by an allowed signature algorithm of minimum SHA-2.

When you enable NIST SP800-131A compliance, the TLSv1.2 protocol is used for providing secure 

connections. Therefore, you must ensure that your browser is compatible.

Table 19. Browser compatibility for TLSv1.2

The following table provides information about the supported browser versions that are 

compatible with TLSv1.2.

TLSv1.2 not supported

TLSv1.2 supported but 

disabled but default

TLSv1.2 sup­

ported and en­

abled by default

Inter­

net Ex­

plorer

All versions of IE on Windows XP and 

Windows Vista operating systems (IE6, 

IE7, IE8, IE9)

IE8, IE9, IE10 on Windows

7 and Windows 8 operating

system.

IE11 on Windows 7 

operating system

and later

Fire­

fox

<24 24 None

Compliance with NIST SP800-131A also requires that the cryptographic provider is FIPS 140-2 certified. 

When SP800-131A compliance is enabled, FIPS 140-2 compliance is enabled automatically, even when it 

is disabled in the settings.

For NIST SP800-131A compliance, you must configure all your components. There is no compatibility 

with earlier versions of the components.
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Note:  There is no support for NIST SP800-131A with Oracle JVMs. Therefore, to take advantage of 

the NIST support, you must install the stand-alone controller component.

Enable NIST SP800-131A compliance on the server
You can enable NIST SP800-131A compliance on the BigFix Remote Control server during installation, 

when you are using the server installer program. You can also enable NIST compliance after installation. 

To enable NIST SP800-131A compliance for a manual BigFix Remote Control Server installation, you must 

configure theBigFix Remote Control Server and WebSphere.

Enabling NIST SP800-131A compliance during the server installation

To enable NIST SP800-131A compliance during installation, follow the instructions in Installing by using 

the server installer (on page 32). Select Enable NIST SP800-131A compliance (Enables FIPS) on the Web 

server parameters  pane during the installation.

Enabling NIST SP800-131A compliance on a server with a stand-alone 
WebSphere Application Server
The BigFix Remote Control Server uses the middleware infrastructure that is provided by WebSphere

secure HTTP communications. Therefore, to enable NIST SP800-131A compliance for a manual BigFix

Remote Control Server installation you must configure BigFix Remote Control Server and WebSphere.

To enable NIST SP800-131A compliance for a manual server installation, complete the following steps 

after you install the server.

1. Configure WebSphere

The WebSphere documentation describes how to enable NIST SP800-131A in WebSphere. Follow the 

instructions relevant to your version of WebSphere.

• WebSphere Application Server:

◦ v7.0: http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/topic/com.ibm.websphere.base.doc/

info/aes/ae/tsec_config_strictsp300.html

◦ v8.5:http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/topic/

com.ibm.websphere.base.iseries.doc/ae/tsec_config_strictsp300.html

• WebSphere Application Server Network Deployment:

◦ v7.0: http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/topic/com.ibm.websphere.nd.doc/

info/ae/ae/tsec_config_strictsp300.html

http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/topic/com.ibm.websphere.base.doc/info/aes/ae/tsec_config_strictsp300.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/topic/com.ibm.websphere.base.doc/info/aes/ae/tsec_config_strictsp300.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/topic/com.ibm.websphere.base.iseries.doc/ae/tsec_config_strictsp300.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/topic/com.ibm.websphere.base.iseries.doc/ae/tsec_config_strictsp300.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/topic/com.ibm.websphere.nd.doc/info/ae/ae/tsec_config_strictsp300.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/topic/com.ibm.websphere.nd.doc/info/ae/ae/tsec_config_strictsp300.html
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◦ v8.5: http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/topic/com.ibm.websphere.nd.doc/

ae/tsec_config_strictsp300.html

• WebSphere Application Server - Express:

◦ v7.0:http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/topic/

com.ibm.websphere.express.doc/info/exp/ae/tsec_config_strictsp300.html

◦ v8.5:http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/topic/

com.ibm.websphere.express.iseries.doc/ae/tsec_config_strictsp300.html

2. Log on to the BigFix Remote Control Server with a valid admin ID and password.

3. Click Admin > Edit properties files

4. In the common.properties file set sp800131a.compliance to true.

5. Click Submit.

6. Click Admin > Reset Application.

7. Restart the server service.

For more information about restarting the server service, see Manage the component services (on 

page 127). Follow the steps in the section that is relevant to your operating system.

Note:  NIST SP800-131A enablement changes in WebSphere affect all other applications that are 

running on that server. Therefore, browser settings for the users who access those other applications 

must be changed to support Transport Layer Security (TLS).

To enable TLS in Internet Explorer, complete the following steps.

• Click Tools > Internet Options.

• On the Advanced tab, select Use TLS 1.2.

• Click Apply.

• Click OK.

To enable TLS in Firefox, complete the following steps.

• In the browser, go to the about:config page.

• Click I'll be careful, I promise.

• In the search field search for security.tls.version.max.

• Set the value to 3.

http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/topic/com.ibm.websphere.nd.doc/ae/tsec_config_strictsp300.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/topic/com.ibm.websphere.nd.doc/ae/tsec_config_strictsp300.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/topic/com.ibm.websphere.express.doc/info/exp/ae/tsec_config_strictsp300.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v7r0/topic/com.ibm.websphere.express.doc/info/exp/ae/tsec_config_strictsp300.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/topic/com.ibm.websphere.express.iseries.doc/ae/tsec_config_strictsp300.html
http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/topic/com.ibm.websphere.express.iseries.doc/ae/tsec_config_strictsp300.html
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Enabling NIST SP800-131A compliance after you install the server
After you install the server by using the installer program, you can enable NIST SP800-131A compliance in 

a number of ways.

However, if you did not already enable FIPS you must enable if first. For more information about enabling 

FIPS after you install the server, see Enabling FIPS compliance on an automated server installation (on 

page 154).

You must also make sure that the server certificate is compliant by ensuring that you follow the 

prerequisites for NIST support. For more information about certificate prerequisites, see NIST 

SP800-131A compliance in BigFix Remote Control (on page 163).

To enable NIST SP800-131A compliance after an automated BigFix Remote Control Server installation, 

complete the following steps.

1. Choose the appropriate method for enabling the NIST configuration.

Option 1

a. Go to the tools directory that is in the server installation directory.

b. Edit the trcsetup.cmd or trcsetup.sh file, depending on your operating 

system.

c. In the line that calls the ssl.cmd or ssl.sh file, change the 0 that is before trc to 

a 1. Change the 0 that is at the end of the command to a 1 also. For example,

The command before the change is,

...\tools\ssl.cmd" "C:\Program Files (x86)\IBM\Tivoli\TRC\server" 

 1 0 "C:\" "%CERTSTOREPW%" "servername.localnet" 0 trc 

 "%CERSTOREPWSELF%" "TrC" "0"

...\tools\ssl.cmd" "C:\Program Files (x86)\IBM\Tivoli\TRCServer" 

 1 0 "C:\" "%CERTSTOREPW%" "servername.localnet" 0 trc 

 "%CERSTOREPWSELF%" "TrC" "0"

The command after the change is,

...\tools\ssl.cmd" "C:\Program Files (x86)\IBM\Tivoli\TRC\server" 

 1 0 "C:\" "%CERTSTOREPW%" "servername.localnet" 1 trc 

 "%CERSTOREPWSELF%" "TrC" "1"

...\tools\ssl.cmd" "C:\Program Files (x86)\IBM\Tivoli\TRCServer" 

 1 0 "C:\" "%CERTSTOREPW%" "servername.localnet" 1 trc 

 "%CERSTOREPWSELF%" "TrC" "1"
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d. Save the file.

e. In the same directory, edit tmem.sh or tmem.cmd, depending on your operating 

system.

f. Set the value of NIST800=1. Set the value of FIPSON=1 if it is not already set.

g. Run the following command.

trcsetup userid password certpassword

Where userid and password are the database connection credentials and 

certpassword is your certificate file password.

Note:  Derby does not have database credentials, therefore use userid and 

password for the credentials. Type the following command when you are using 

Derby.

trcsetup userid password certpassword

Option 2 - Temporary NIST configuration

Note:  The configuration changes set in this option are overwritten if you run the 

trcsetup or tmem files again.

a. Edit the ssl.xml file that is in the [installdir]\wlp\usr\servers

\trcserver directory.

Where

[installdir]

Is the server installation directory.

b. Add sslProtocol="TLSv1.2" to the line ssl id="defaultSSLConfig". For example,

<server> 

<ssl id="defaultSSLConfig" sslProtocol="TLSv1.2" 

/> 

<keystore id="defaultKeyStore" password="TrCWebAS" 

/> 

</server>

c. Save the ssl.xml file.

d. In the same directory, edit the jvm.options file.

e. Add the lines, -Dcom.ibm.jsse2.sp800-131=strict and 

-Dcom.ibm.jsse2.overrideDefaultTLS=true.

f. Add the line, -Dcom.ibm.jsse2.sp800-131=strict.

g. Save the file.



BigFix® Remote Control Installation Guide | 12 - NIST SP800-131A compliance in BigFix Remote Control | 
168

2. Log on to the BigFix Remote Control Server with a valid admin ID and password.

3. Click Admin > Edit properties files

4. In the common.properties file, set sp800131a.compliance to true.

5. Click Submit.

6. Click Admin > Reset Application. Restart the server service.

For more information about restarting the server service, see Manage the component services (on 

page 127). Follow the steps in the section that is relevant to your operating system.

Check to see whether the BigFix Remote Control Server is configured for NIST SP800-131A by completing 

the following step.

• Click Admin > View Current Server Status.

The following fields show that NIST SP800-131A compliance is enabled.

• Enabled NIST SP800-131A mode

• JVM configured for NIST SP800-131A mode

Creating a certificate for an MS SQL database when NIST 
SP800-131A is enabled
When you enable NIST SP800-131A compliance and you are using an MS SQL database, you must create 

a certificate.

To generate the certificate, you can use the IBM Key Management tool. You can access the IBM Key 

Management tool if the BigFix Remote Control server is installed with embedded components and also if 

the controller component is installed. It is also provided by IBM WebSphere Application Server.

Note:  To create a certificate with 4096 key size or greater, you must overwrite the restriction policy 

files local_policy.jar and US_export_policy.jar.

Go to the following directory and copy the local_policy.jar and US_export_policy.jar files.

Windows systems

TRC\server\java\demo\jce\policy-files\unrestricted

Linux systems

TRC/server/java/demo/jce/policy-files/unrestricted
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Replace the following files with the JAR files that you copied.

Windows systems

TRC\server\java\jre\lib\security\local_policy.jar

TRC\server\java\jre\lib\security\US_export_policy.jar

Linux systems

TRC/server/java/jre/lib/security/local_policy.jar

TRC/server/java/jre/lib/security/US_export_policy.jar

To create and install the certificate, complete the following steps:

1. Install one of the supported versions of MS SQL server and the latest patches. Minimum requirement 

is MS SQL Server 2012 Service Pack 3.

2. Create a keystore with a self-signed certificate.

a. Open a command line window.

b. Go to one of the following directories to run the keytool.

Remote control server that is installed with embedded components

Go to the BigFix Remote Control server installation directory.

WebSphere Application Server is installed

Go to the WebSphere Application Server installation directory.

The controller component is installed

Go to the ...\Controller\jre directory. For example,

Windows systems.

C:\Program Files\IBM\tivoli\Remote Control

\Controller\jre

Linux systems.

/opt/ibm/trc/controller/jre

c. Change to the bin directory.

d. Run the ikeyman file relevant to your operating system.

Windows systems

ikeyman.bat



BigFix® Remote Control Installation Guide | 12 - NIST SP800-131A compliance in BigFix Remote Control | 
170

Linux systems

ikeyman.sh

e. Select Key Database File > New

f. Select PKCS12 for Key database type.

g. Click Browse and go to the location in which you want to store the keystore.

h. Type a file name for your file and click Save.

i. Click OK.

j. Enter and confirm a password to protect the keystore and click OK.

k. Select Create > New Self-Signed Certificate

l. Enter a name for the Key Label.

For example, the host name of the server.

m. Select X509 V3  for the Version.

n. Select a Key Size value.

Recommended value for NIST SP800-131A compliance is 2048 or greater.

o. Select SHA256WithRSA for the Signature Algorithm

p. Type a Common Name.

Set to the DNS host name of your server.

For example, trcserver.example.com.

q. Enter any additional optional information as required.

r. Enter a Validity Period.

Set the number of days that the certificate is valid for. Default is 365 days.

s. Set the Subject Alternative Names, DNS Name option to the DNS host name of your server.

t. Click OK.

3. Add the certificate store to the database server.

a. At a command line, run mmc.exe.

b. Add a certificate snap-in.
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i. Select File > Add/Remove Snap-in.

ii. Select the Certificates snap-in and click Add.

iii. Select Computer account and click Next.

iv. Ensure that the Local computer option is selected and click Finish.

v. Click OK.

c. Import the certificate

i. In the Console1 window, go to Console Root > Certificates.

ii. Right click Certificates and select All Tasks > Import.

iii. Click Next on the Welcome window.

iv. Click Browse and select the certificate store that you created.

v. Click Next.

vi. Enter the password for the certificate store and click Next.

vii. Ensure that Place all certificated in the follolwing store is selected and that Certificate 

Store is set to Personal. Click Next.

viii. Click Finish.

4. Manage private keys.

a. Right-click the certificate file and select All Tasks > Manage Private Keys.

b. Click Add.

c. Click Check Names, select MSSQLSERVER and click OK.

d. Click OK on the Select Users and Groups window.

e. Set permissions for MSSQLSERVER on the Permissions window and click OK. For example, 

select Allow for Read for a Read-only option.

5. To complete the configuration, run the SQL Server Configuration Manager.

a. Expand SQL Server Network Configuration.

b. Right click Protocols for MSSQLSERVER and select Properties.

c. On the Certificates tab, select your imported certificate.

d. On the Flags tab set Force Encryption to Yes and click OK.

e. Click OK on the Warning window.

f. Select SQL Server Services.

g. Right-click SQL Server (MSSQLSERVER) > Restart in the right pane.

Enabling NIST SP800-131A compliance on the controller
The IBM JRE for Windows operating system and Linux (Intel) operating systems is included with BigFix

Remote Control and is installed when you install the controller software.
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If you are using a Windows system, the JRE is included in the controller package 

trc_controller_setup.exe and trc_controller.msi. For Linux systems, the JRE is included 

in the package ibm-trc-controller-jre-9.x.x.i386.rpm. Where 9.x.x is the version that you 

want to install. The packages install the IBM Java Run-time Environment preconfigured with the IBM FIPS 

certified cryptographic provider and NIST SP800-131A enabled. The packages also register the MIME type 

application/x-ibm-trc-jws and a file association for *.trcjws files.

To check whether the controller is connected in FIPS or NIST SP800-131A mode during a remote control 

session, click Controller tools > Show session information. Encryption is set to AES FIPS when FIPS 

mode is enabled and is set to TLSv1.2 when NIST mode is enabled.

Enabling NIST SP800-131A compliance in the stand-alone controller
After you install the stand-alone controller, you can edit the properties file to enable NIST SP800-131A 

compliance.

If you install the controller component locally to start peer to peer remote control sessions, you must edit 

the trc_controller.cfg file to enable NIST SP800-131A compliance. To enable NIST SP800-131A 

compliance, complete the following steps.

1. Edit the trc_controller.cfg file on the system that the controller is installed on.

Windows systems

[controller install dir]\trc_controller.cfg

Where [controller install dir] is the installation directory you chose when you installed the 

controller.

Linux systems

opt/ibm/trc/controller/trc_controller.cfg

2. Set sp800131a.compliance to true.

3. Save the file.

Enable NIST SP800-131A compliance on the target
You can enable NIST SP800-131A compliance on the BigFix Remote Control target in various ways. NIST 

SP800-131A compliance can be enabled during installation when you are using the target installation 



BigFix® Remote Control Installation Guide | 12 - NIST SP800-131A compliance in BigFix Remote Control | 
173

program. You can enable NIST SP800-131A compliance after the installation by editing the target registry 

on Windows systems, or by editing the configuration file on Linux systems.

Using the target user interface, choose the appropriate option to verify that NIST SP800-131A compliance 

is enabled on the target.

• On the BigFix Remote Control- Target user interface, click Actions Menu > Connection info.

• Hover the mouse over the BigFix Remote Control icon in the system notification area.

Enabling NIST SP800-131A compliance in a Windows target

When you are using a Windows operating system, you can enable NIST SP800-131A compliance on the 

target in two ways. You can enable compliance during installation or by editing the target registry after 

installation.

Enabling NIST SP800-131A compliance during the target installation

To enable the NIST SP800-131A compliance target property during installation, follow the instructions 

in Install the target (on page 57). On the Server Address screen of the target installer, click Advanced 

settings. Select Enable NIST SP800-131A compliance (Enables FIPS).

Enabling NIST SP800-131A compliance during silent installation of the 
target

To enable NIST SP800-131A compliance during a silent installation of the target, you can use the 

SP800131A parameter in the installation command. For more information about a target silent 

installation, see Running a target custom installation on a Windows system (on page 85).

Use the following parameters to enable NIST SP800-131A compliance.

• TRC_SERVER_PROTOCOL=https

• TRC_SERVER_PORT=443

• SP800131A=yes

For example, trc_target_setup.exe /s /v"/qn TRC_SERVER_HOSTNAME=yourserver

TRC_SERVER_PROTOCOL=https TRC_SERVER_PORT=443 SP800131A=yes"

Where yourserver is the host name or IP address of your BigFix Remote Control Server.
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Enabling NIST SP800-131A compliance after target installation

After you install the BigFix Remote Control target, you can enable NIST SP800-131A compliance by 

editing the target registry. To enable NIST SP800-131A compliance, complete the following steps.

1. Run the regedit command at a command prompt window.

2. In the Windows registry, go to HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Tivoli\Remote 

Control\Target

On a 64-bit system, the 32-bit registry keys are under the WOW6432Node key.

For example, HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\IBM\Tivoli\Remote 

Control\Target.

3. Right-click SP800131ACompliance and select Modify.

4. Type yes in the Value data field and click OK.

5. Restart the target service.

For more information about restarting the target service, see Manage the component services (on 

page 127). Follow the steps in the section that is relevant to your operating system.

Enabling NIST SP800-131A compliance on Linux or UNIX based targets

After you install the BigFix Remote Control target, you can enable NIST SP800-131A compliance by 

editing the ibmtrct.conf file. To enable NIST SP800-131A compliance, complete the following steps.

1. Edit the /etc/ibmtrct.conf  file.

2. Set the value of SP800131ACompliance to yes and save the file.

3. Restart the target service.

For more information about restarting the target service, see Manage the component services (on 

page 127). Follow the steps in the section that is relevant to your operating system.

Enabling NIST SP800-131A compliance on the gateway
You can enable NIST SP800-131A compliance on the gateway component by editing the gateway 

configuration file that is created when you install gateway support.

The trc_gateway.properties file is in the following directory.
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Windows systems

\Documents and Settings\All Users\Application Data\IBM\Tivoli\Remote 

Control\Gateway

or \ProgramData\IBM\Tivoli\Remote Control\Gateway.

Linux systems

/etc

To enable NIST SP800-131A compliance, complete the following steps.

1. Edit the trc_gateway.properties file.

2. Set SP800131ACompliance = Yes.

3. Save the file.

4. Restart the gateway service.

For more information about restarting the gateway service, see Manage the component services (on 

page 127). Follow the steps in the section that is relevant to your operating system.

Enabling NIST SP800-131A compliance on the broker
You can enable NIST SP800-131A compliance on the broker component by editing the broker 

configuration file that is created when you install broker support.

The trc_broker.properties file is in the following directory.

Windows systems

\Documents and Settings\All Users\Application Data\IBM\Tivoli\Remote 

Control\broker

or \ProgramData\IBM\Tivoli\Remote Control\broker.

Linux systems

/etc

To enable NIST SP800-131A compliance, complete the following steps.

1. Edit the trc_broker.properties file.

2. Set SP800131ACompliance = Yes.
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3. Save the file.

4. Restart the broker service.

For more information about restarting the broker service, see Manage the component services (on 

page 127). Follow the steps in the section that is relevant to your operating system.

Enabling NIST SP800-131A compliance on the CLI tools
NIST SP800-131A compliance can be enabled during installation when you are installing the CLI tools on 

a Windows operating system. You can enable NIST SP800-131A after you install the CLI tools in Linux by 

editing the configuration file.

Enabling NIST SP800-131A compliance when you install the Windows cli 
tools

To enable NIST SP800-131A compliance during the installation of the command line interface tools, 

follow the instruction in Installing the cli tools on a Windows system (on page 103). Click Advanced 

settings on the Server Address screen, and select Enable NIST SP800-131A compliance (Enables FIPS)

during the installation.

Enabling NIST SP800-131A compliance on the cli on Linux or UNIX based 
targets

After you install the cli tools, you can enable NIST SP800-131A compliance by editing the ibmtrct.conf

file. To enable NIST SP800-131A compliance, complete the following steps.

1. Edit the /etc/ibmtrct.conf  file.

2. Set the value of SP800131ACompliance to yes.

3. Save the file.



Chapter 13. Verifying the server installation

When you complete the server installation, you can verify it by completing the following steps:

1. In a browser window, type the address of the BigFix Remote Control server. For 

example,http://yourservername/trc where yourservername is the host name or IP address of your 

BigFix Remote Control server.

2. Verify that the BigFix Remote Control logon screen is displayed.

3. Log on with the following admin ID and password - id=admin, password=password.

4. At the change details screen, change the password by following the instructions that are given.



Chapter 14. Recover from installation errors

If you experience installation errors, use the following chapters to identify the problem and address it.

Recovery steps
Use the following information as a starting point to find log files and other information to help you recover 

from installation errors.

If you must contact HCL Software Support, gather the following information.

• If you are using a Windows operating system, any event log that is relevant to the installation error.

• The installation log files.

• Operating system version, including any service packs.

• The version of the WebSphere Application Server, database server, and Java.

• Hardware description.

• Installation media type.

• Windows services that were active during the unsuccessful installation. For example, antivirus 

software.

The following files can also be used to gather information about any errors that might occur.

\tsetup.ini

Contains some basic information, logged during an automated installation.

[installdir]\install.log

Contains internal debug messages.

[installdir]\inst.ini

Contains all parameters about the installation.

[installdir]\wlp\usr\server\trcserver

Contains configuration xml files.

[installdir]\wlp\usr\server\trcserver\logs\messages.log

[installdir]\wlp\usr\server\trcserver\logs\messages_xxxxxxx.log

[installdir]\wlp\usr\server\trcserver\logs\ffdc directory
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Errors during installation
The following topics describe recovery actions for errors that might occur during the BigFix Remote 

Control server installation when you use the server installer program.

Not enough memory

Symptom

Memory error reported during the installation and the installation does not continue.

Cause

The memory check at the beginning of the installation determines that the computer that 

you are installing on does not have the required minimum memory for installation.

Solution

For more information about the requirements for memory, see Server requirements (on page 

9) .

DB2 connection error when database options are verified

Symptom

DB2 database connection error reported during installation.

Causes

During the installation if you select DB2 as the database, the installer verifies the 

information that is given in the database options screen. The user ID, password, and port 

values are used to establish a connection to the database. If a connection is not successful, 

an error is reported. This error also contains the error reported by DB2.

Solution

This error can be reported for any of the following reasons.

• Incorrect values are entered in the database options screen. Go back to the previous 

screen and verify the information.

• There is no database instance present. If you are planning to use DB2, it must be 

installed before the BigFix Remote Control server. A database instance must also be 

created.

• Cannot connect to the remote database. If you are using a remote database, verify that 

you can ping the IP address of the remote system.
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Oracle pre-checks

Symptom

Oracle database connection error reported during installation.

Cause

During the installation if you select Oracle as the database, the installer verifies the 

information that is given in the database options screen by connecting to the database. 

If the connection fails, an error is reported. The error message contains the error that is 

returned from Oracle.

Solution

Go back to the previous screen and use the information that is given to correct the problem.

For example: If the Oracle database is not created before the installation, the following error 

is reported.

Failed to verify userid, password, server, database and driver 

file combination supplied.Please verify details and try again. 

 ( Listener refused the connection with the following error: 

ORA-12505. TNS:listener does not currently know of SID given in 

connect descriptor 

The Connection descriptor used by the client was: 

127.0.0.1:1521:TRCDB

In this case, you must cancel the installation and create the Oracle database before you 

install BigFix Remote Control again.

libstdc++.so.5 error when installing the server using the installation 
program

Symptoms

The server installation aborts with the following exception error in Linux.

This application has unexpectedly quit:Invocation of this Java application has caused 

an InvocationTargetException. This application will now exit".

The installation log may show the following error
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java.lang.unsatisfiedlinkerror :fontmanager (libstdc++.so.5: can not open shared 

object file:No such file or directory)

Causes

Missing package required.

Solution

Install the libstdc++.so.5 package. This can be installed by installing the compat-libstdc+

+-33 package which includes libstdc++.so.5.

Errors after installation
When the installation of BigFix Remote Control is complete and the application service starts, you can log 

on. If you cannot log on successfully, use the following information to resolve the problem.

• Check that the server service is running.

Windows systems

In Windows services, check that the following service is started

BigFix Remote Control-Server.

Linux systems

The following service is created /etc/init.d/trcserver or /etc/rc.d/init.d/

trcserver  and started.

Note:  To manually stop or start the server type the following command.

/etc/init.d/trcserver [parameter] Where parameter is stop, start, or restart.

• Check the log files in the [installdir]\wlp\usr\server\trcserver\logs directory for any 

reported errors. You can also check the trc.log file in the server installation directory.

• If you are using an Oracle database, check that the user ASSET exists.

Out of memory error

Symptom

Out of memory errors are reported in the log files when the BigFix Remote Control Server is 

started. Failed to instantiate heap is reported in them.

Causes
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There is not enough memory available to run the application. The reason for the error is that 

the maximum memory that is allocated to the heap is too high, and can be affected by other 

applications that are running or installed.

During installation, the installer attempts to set up the BigFix Remote Control application to 

use up to 70% of available RAM. The percentage is lowered if a Java virtual machine (JVM) 

cannot be started. However, if other software is installed, an out of memory error might also 

be reported in the BigFix Remote Control log files.

Solution

The solution to this problem is to use a supplied script to manually set the memory 

parameters to a lower value. This script, can be found in the BigFix Remote Control

installation directory. Use the script to set the memory parameters and the number of 

threads and web connections.

• tmem.cmd - for Windows systems.

• tmem.sh  - for UNIX based systems.

Run the following command from the BigFix Remote Control installation directory:

tmem.cmd minmem maxmem 

Note:  Use tmem.sh for UNIX based systems.

minmem; maxmem

Sets the minimum and maximum memory to be allocated.

Note:  The 32-bit Java that is supplied in 32-bit eWAS can use a maximum 

of 2.7 GB only, no matter how much RAM is available.

You can also use the tmem.cmd and tmem.sh command to adjust the following parameters.

maxwebconn

Sets the number of web connections allowed. The default is 85 and can 

increase to 175.

maxthreads; minthreads

Sets the minimum and maximum threads allowed. Maximum threads are 50, 

increasing to 150.

To edit these parameters in version 9.x.x, complete the following steps:

1. Edit trcsetup.cmd or trcsetup.sh.
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2. Edit the line that contains the call to the memory.cmd file. For example, C:\TRC

\server\tools\memory.cmd 163 49 135 1

Where

• maxwebconn = parameter 1 (163)

• minthreads = parameter 2 (49)

• maxthreads = parameter 3 (135)

Do not edit parameter 4. Keep the value 1.

3. Change the required values.

4. Save the trcsetup file.

5. Type the following command.

trcsetup userid password certpassword

Where userid and password are the database connection credentials and certpassword

is your certificate file password.

Note:  Derby does not have database credentials, therefore use user ID and 

password for the credentials. Type the following command when you are using Derby:

trcsetup userid password certpassword

Database connection authorization failure

Symptom

A database connection authorization failure error is reported in the log files.

Causes

The database password might be invalid.

Solution

Change the password by running the following command from the BigFix Remote Control

installation directory:

Windows systems.

[installdir]\tools\tdbpasswd.cmd userid password. Where installdir  is the 

BigFix Remote Control installation directory and userid and password are the 

database logon credentials.

UNIX based systems.
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[installdir]/tools/tdbpasswd.sh userid password.  Where installdir is the 

BigFix Remote Control installation directory and userid and password are the 

database logon credentials.

Run the command to change the database password for the application. Restart the BigFix

Remote Control service after you run the command.

Application welcome page does not display

Symptom

The BigFix Remote Control server welcome page does not appear when you type in the 

BigFix Remote Control server URL in your browser.

Cause

The issue can occur for a number of reasons, which are reported in the log files.

Solution

Look through the install.log file in the server installation directory, for any reported 

errors.

DB2 connection error when database options are verified

Symptom

DB2 database connection error reported during installation.

Causes

During the installation if you select DB2 as the database, the installer verifies the 

information that is given in the database options screen. The user ID, password, and port 

values are used to establish a connection to the database. If a connection is not successful, 

an error is reported. This error also contains the error reported by DB2.

Solution

This error can be reported for any of the following reasons.

• Incorrect values are entered in the database options screen. Go back to the previous 

screen and verify the information.

• There is no database instance present. If you are planning to use DB2, it must be 

installed before the BigFix Remote Control server. A database instance must also be 

created.
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• Cannot connect to the remote database. If you are using a remote database, verify that 

you can ping the IP address of the remote system.

Targets cannot contact the server

Symptom

Targets are not registering or updating their details on the BigFix Remote Control Server.

Causes

• The target does not have the correct URL for the server.

• The host name part of the URL, that is used to contact the server, does not match the 

common name in the server's SSL certificate.

Solution

When you install the target software the target contacts the server by using http or https, 

and the server URL that is defined during the installation of the target. However, there are 

two important things to note to ensure that the connection between the server and target is 

successful.

• The target must have the correct URL for the server.

• The host name part of the URL must match the common name in the server's SSL 

certificate.

When the BigFix Remote Control Server is installed with the installation program, you must 

ensure that you supply the correct values in the Web server parameters window. By default, 

the upload data to server field is populated with the computer name from the Windows

operating system settings. The server installer program uses the field value to generate 

the server URL. The URL is then saved in the trc.properties file, in the url property 

and is also saved in the SSL certificate. Therefore, make sure that you specify the correct 

computer name during the installation. If you specify an incorrect value, the following 

problem might occur.

When a target contacts the server for the first time, it uses the ServerURL property from 

the target registry or configuration file to contact the server. When the server responds 

to the target, it includes the server address that is assigned to the url property in the 

trc.properties file. The target uses this URL to contact the server. If the address that 

is sent to the target is incorrect, the target can register once and then is not able to contact 

the server again. After a while, the target is marked as being offline. You are also unable to 
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start sessions with this target, because the target does not have a correct working URL with 

which to authenticate an incoming session.

The common name that is in the server's SSL certificate must be a host name that 

resolves to the IP address of the server. If the SSL certificate has, for example, mytrcserver, 

but on the target there is no way to translate mytrcserver to the IP address of the 

server, your environment is not correctly configured. The only names that are correctly 

supported are fully qualified domain names that are registered in the DNS. For example, 

mytrcserver.example.ibm.com. To use only mytrcserver, the server and target must be on 

the same local network and have WINS configured.

You can check that the DNS server is properly configured by using the nslookup command 

to query the full computer name and IP address.

For example: At a command prompt type, the following commands.

C:\>nslookup 

Default Server:  dns.example.ibm.com 

Address:  192.0.2.0 

Type in the hostname of your server 

> mytrcserver.example.ibm.com 

Server:  dns.example.ibm.com 

Address:  192.0.2.0 

Name:    mytrcserver.example.ibm.com 

Address:  192.0.2.1 

Type in the ip address of your server 

> 192.0.2.1 

Server:  dns.example.ibm.com 

Address:  192.0.2.0 
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Name:    mytrcserver.example.ibm.com 

Address:  192.0.2.1

you can see that the server host name resolves to the correct IP address.

Errors when you use Oracle as the database

Symptom

java.lang.ArrayIndexOutOfBoundsException error reported when you use an 

Oracle database.

Cause

There is a problem with the Oracle jdbc drivers.

Solution

Choose the appropriate option to resolve the problem.

• Use the Oracle 10.2g JDBC 4 drivers. The drivers work with oracle 9, 10 and 11.

• If you are using the Oracle 11g drivers, manually edit the trc.properties file and set 

the following property oracle.increment.keys.off=1.

Note:  Restart the server service.

Errors when trying to connect to the Microsoft SQL database in FIPS 
compliancy mode

Symptom

Errors when trying to connect to the Microsoft SQL database in FIPS compliancy mode

Cause

Using the IBM JRE and the IBM JSSE provider and Websphere Application Server, which 

has been enabled for FIPS compliancy currently, does not work when using an MS SQL 

database.

Solution

These options only work with MS SQL when FIPS is not enabled in IBM Websphere.



Chapter 15. Uninstall the components

After you install the various BigFix Remote Control components, you can uninstall them in various ways.

Uninstall the server
To remove the BigFix Remote Control server, the method you choose depends on the type of installation 

that was run. If you installed the server by using the BigFix Remote Control installation program, you can 

uninstall the software by using the installer or by using Add or Remove programs. If you ran a manual 

installation of BigFix Remote Control Server, you must uninstall the software by using the IBM WebSphere 

Application Server administration console.

Uninstalling the server by using the installer

Use the following procedure to uninstall the BigFix Remote Control server software if you are using a 

Windows operating system or a Linux operating system.

To uninstall the BigFix Remote Control server by using the installer, complete the following steps :

1. Navigate to the BigFix Remote Control server installation directory.

The default directory or the specific directory that you chose when you installed the server. For 

example,

Windows systems

\Program Files\ibm\Tivoli\TRC\server

Linux systems

/opt/IBM/Tivoli/TRC/server

2. Double click Uninstall BigFix Remote Control - Server.exe

3. Click Uninstall.

4. Click Done when finished.

The BigFix Remote Control features, files, and folders that were created by the installer are removed.
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Uninstalling the server application in IBM Websphere Application Server

If you have performed a manual installation of the BigFix Remote Control Server software, you can 

uninstall the software using the IBM Websphere Application Server administration console by completing 

the following steps:

To access the Administrative Console complete the following steps:

1. In your browser type

https://[server : port]/ibm/console 

 

where server is the ipaddress or name for the application server machine for example localhost or 

192.0.2.0 and port is the port that the server is listening on.

2. Logon with the ID and password that were defined when installing Websphere.

3. Expand Applications and click Enterprise applications.

4. Select the check box for the BigFix Remote Control server application.

5. Click Uninstall.

6. Select Save to save to the Master Configuration.

Uninstalling the server using Add or Remove programs

If you are using a Windows operating system you can uninstall the server software, using Add or Remove 

Programs by completing the following steps :

1. Open the Control Panel.

2. Double click Add or Remove Programs.

3. Select BigFix Remote Control - Server.

4. Click Change Remove.

5. Click Uninstall.

6. Click Done when finished.

Uninstalling the target on Windows systems
Using Add or Remove Programs to remove the target software from a Windows system.
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To remove the target software by using Add or Remove Programs complete the following steps:

1. Open the Control Panel.

2. Double-click Add or Remove Programs.

3. Select IBM BigFix Remote Control - Target.

4. Click Remove.

5. Click Yes  at the prompt.

The BigFix Remote Control target software is removed from your system.

Uninstalling the target on Linux systems
To remove the target software on Linux systems, complete the following steps:

1. To find the BigFix Remote Control package name that is installed, run the following command.

rpm  -qa  |grep  trc 

2. Run the following command:

rpm  -e <trcpackage>

where trcpackage is your package name.

For example: rpm -e ibm-trc-target

You can verify that the target is removed by completing the following steps:

1. Run the command in step 1 (on page 190) to make sure that there is no BigFix Remote Control

package installed.

2. Run the following command to make sure that no BigFix Remote Control process is running.

ps  -ef  |grep  trc  



Chapter 16. Upgrade from previous versions

The following limitation is not an issue when you upgrade from version 9.0.0 or 9.0.1 or 9.1.0 to version 

9.1.2.

In BigFix Remote Control version 9.0.0 new capabilities that were introduced can cause some 

compatibility issues with earlier versions if the different components are not upgraded in the correct 

order.

This limitation applies only to environments where the gateway and broker components are deployed. In 

these environments, the broker and gateway must be updated before the server or the target components. 

After they are upgraded, the targets and server can be upgraded in the order that best suits your 

environment, since there are no dependencies between them.

It is suggested to always back up any properties files as a precaution. However, for the controller upgrade 

in this release, you must back up the properties files as any existing properties are lost.

Upgrade the gateway component
You can upgrade the gateway component by using any of the following methods:

Using the installation files

For more information about obtaining the component installation files, see Obtain the 

installation files (on page 22). For more information about installing the gateway support on 

a Windows system, by using the installation files, see Installing Windows gateway support

(on page 106). For more information about installing the gateway support in Linux, by using 

the installation files, see Installing Linux gateway support (on page 107).

Using the BigFix console

If you have the BigFix console infrastructure installed, you can use the update fixlet to 

upgrade the gateway support. For more information about the upgrade fixlet, see the BigFix

Remote Control Console User's Guide.

Upgrade the broker component
You can upgrade the broker support by using any of the following methods:

Using the installation files
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For more information about obtaining the component installation files, see Obtain the 

installation files (on page 22). For more information about installing the broker support on a 

Windows system, by using the installation files, see Installing Windows broker support (on 

page 108). For more information about installing the broker support in Linux, by using the 

installation files, see Installing Linux broker support (on page 109).

Using the BigFix console

If you have the BigFix console infrastructure installed, you can use the update fixlet to 

upgrade the broker support. For more information about the upgrade fixlet, see the BigFix

Remote Control Console User's Guide.

Upgrade the server component
If you already installed the BigFix Remote Control Server software, you can upgrade the component by 

carrying out a similar installation type to your original installation.

Before you start the upgrade, you must back up your property files and any recording files if applicable. 

Back up any certificates, if applicable. For more information about backing up and restoring certificates, 

see the BigFix Remote Control Administrator's Guide

Property files

• common.properties

• ldap.properties

• trc.properties

• log4j.properties

• controller.properties

The files are in the following directories.

Windows systems

[InstallDir]wlp\usr\servers\trcserver\apps\TRCAPP.ear\trc.war\WEB-

INF\classes\ Where InstallDir is the BigFix Remote Control server installation directory. 

For example, C:\Program Files ( x86)\IBM\Tivoli\TRC\server\wlp\usr

\servers\trcserver\apps\TRCAPP.ear\trc.war\WEB-INF\classes\

Linux systems

[InstallDir]wlp/usr/servers/trcserver/apps/TRCAPP.ear/trc.war/WEB-

INF/classes/ Where InstallDir is the BigFix Remote Control server installation directory.

Recordings Files
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The video recordings folder is defined by the rc.recording.directory property in the 

trc.properties file.

You can upgrade the server component by using any of the following methods:

Using the installation files

For more information about obtaining the component installation files, see Obtain the 

installation files (on page 22). For information about installing the server, by using the 

installer, see Installing by using the server installer (on page 32).

Note:  During the installation, select to keep existing property files and do not select to 

drop the database.

For information about installing the server, on WebSphere 8.5, see Installing on WebSphere 

Application Server version 8.5: deploying the war file (on page 44).

Using the BigFix console

If you have the BigFix console infrastructure installed, you can create and run a server 

installation task to upgrade the server. For more information about using the wizard to 

create a server configuration task, see the BigFix Remote Control Console User's Guide .

Note:  When you create the server task, do not select the drop database option if you 

want to keep your existing database.

When you complete the upgrade verify that the new version is installed, manually edit the new properties 

files. Update the values with the values that are in your backed up properties files. Restore your recording 

files and certificates if applicable

Upgrade the target component
You can upgrade the target component by using any of the following methods:

Using the installation files.

For more information about obtaining the component installation files, see Obtain the 

installation files (on page 22). For more information about installing the target component 

on a Windows system, by using the installation files, see Installing the Windows target (on 

page 57). For more information about installing the target component on a Linux system, by 

using the installation files, see Installing the Linux target (on page 81).

Using the BigFix console.
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If you have the BigFix console infrastructure installed. you can use the update fixlet to 

upgrade the target component. For more information about the upgrade fixlet, see the 

BigFix Remote Control Console User's Guide.

Upgrade the controller component
The controller component upgrade is a major upgrade. Any existing properties are backed up and added 

to the new properties file.

If you are using a Linux operating system and are upgrading from Endpoint Manager for Remote 

Control version 9.0.1 or earlier, edit the trc_controller.cfg.rpmnew file. Compare the property 

values in the file with the values in the trc_controller.cfg file. Merge the differences into the 

trc_controller.cfg file and save the file.

Any of the following methods can be used to upgrade the controller component:

Using the installation files

For more information about obtaining the component installation files, see Obtain the 

installation files (on page 22). For more information about installing the controller 

component on a Windows system, by using the installation files, see Installing the controller 

on a Windows system (on page 96). For more information about installing the controller 

component in a Linux system, by using the installation files, see Installing the Linux 

controller (on page 96).

Using the BigFix console

If you have the BigFix console infrastructure installed, you can use the update fixlet to 

upgrade the controller component. For more information about using the update fixlet, see 

the BigFix Remote Control Console User's Guide.



Chapter 17. Maintaining the target installation

The BigFix Remote Control Target installation can be modified by using a maintenance program.

You can access the maintenance program on a system with Microsoft Windows by running the 

trc_target_setup.exe program. To access the maintenance program, complete the following steps:

1. Go to the target installation directory. For example,

\Program Files\ibm\Tivoli Remote Control\RCTarget

2. Double-click trc_target_setup.exe.

3. At the welcome screen click Next.

4. Select an option and click Next

Modify

Select this option to go through the target installation screens to modify the previously 

installed values.

To modify the installation properties, follow from step 5 (on page 57).

Repair

Select this option to fix missing or corrupted files, shortcuts, and registry entries.

a. Click Repair.

b. Click Finish.

Remove

Select this option to remove the target software and all of its features.

a. Click Remove.

b. Click Finish.



Appendix A. Properties that can be set in the target 
configuration

You can configure target properties either during or after installation. The operating system on the target 

system determines which properties can be configured. The target properties determine the actions that 

can be carried out during a peer-to-peer session. If you set a server URL and set the Managed property to 

Yes, the actions are determined by the policies that are set on the Remote Control server.

For more information about which properties are configurable in each operating system, see Table 24: 

Operating systems that the property is configurable in (on page 219).

Windows systems

The target properties are saved in the target registry. Edit the target registry to modify the 

properties:

1. Edit the target registry and go to HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Tivoli

\Remote Control\Target

Note:  On a 64-bit system, all the 32-bit registry keys are under the Wow6432Node

key. For example: HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\IBM\Tivoli 

Remote Control\Target

2. Right-click the required property and select Modify

3. Set the required value and click OK.

4. Restart the target service.

Linux systems

The target properties are saved to the /etc/ibmtrct.conf file. Edit the file after 

installation to configure the target.

1. Edit the ibmtrct.conf file.

2. Modify the required properties.

3. Save the file.

4. Restart the target service.

macOS devices

You can configure the properties in the trc_target.cfg file when you install the target. 

For more information, see Installing the BigFix Remote Control Target for macOS by using 

the .pkg file (on page 83). The target properties are saved to /Library/Preferences/
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com.ibm.bigfix.remotecontrol.target.plist. To modify a target property, 

complete the following steps:

1. Click Go > Utilities > Terminal.

2. Open the Terminal.app.

3. To modify a property, enter the following command.

sudo defaults write /Library/Preferences/com.ibm.bigfix.remotecontrol.target.plist

Keyword Value

Where Keyword is the property name and Value is the value for the property.

For example,

sudo defaults write /Library/Preferences/com.ibm.bigfix.remotecontrol.target.plist 

LogLevel 4

4. Restart the target.

a. Click Remote Control Target > Quit Remote Control Target.

b. Open the Remote Control Target.app.

Target property definitions

Table 20. Installation option descriptions

Target property

Default

Value Description

ServerURL Blank For the target to register with the server and take part in re­

mote control sessions that are started from the server, pro­

vide the BigFix Remote Control server URL in the format:

http://servername/trc, where servername is the fully qual­

ified name of yourBigFix Remote Control server.

For example, http://trcserver.example.com/trc

Note:  If you provide a server URL and you want the tar­

get to take part only in remote control sessions that are started

from the server, set AllowP2P to No.

ProxyURL Blank Host name or IP address for a proxy server, if you are using one.

BrokerList Blank The list of host names or IP addresses of the brokers and their 

ports, that you want the target to connect to. In the format, host­

name1:port,hostname2:port,hostname3:port.
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Target property

Default

Value Description

GroupLabel Blank A target group name that the target is made a member of when 

the configuration is applied. This target group must exist in the 

BigFix Remote Control database.

Note:  The GroupLabel property can be used only if the tar­

get is not already registered with the server. If the target is al­

ready registered, it is not assigned to the target group. The al­

low.target.group.override property in the trc.properties file 

on the server must be set to Yes for the GroupLabel property val­

ue to be applied.

PortToListen 888 Specify the TCP port that the target listens on. The default value

for the BigFix Remote Control Target for macOS is 8787.

AllowP2P Yes Used to enable peer-to-peer mode. Use this parameter to enable

peer to peer connections regardless of the server status. Default

value is No

No

A peer-to-peer session cannot be established be­

tween a controller and this target. If a ServerURL is 

provided, the targets can take part only in remote

control sessions that are initiated from the server.

Yes

A peer-to-peer session can be established between

a controller user and this target.

Note:  If this option is Yes and a server URL is 

provided, the target can take part in both peer-to-

peer sessions and sessions that are initiated from 

the server.

AllowP2PFailover No Use this parameter to enable failover to peer-to-peer mode when 

the server is down or unreachable. AllowP2P must also be set to 

Yes. Default value is No.

No

The session does not failover to peer-to-peer mode 

when the server is down or unreachable.
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Target property

Default

Value Description

Yes

The session does failover to peer-to-peer mode 

when the server is down or unreachable.

FIPSCompliance No Use this property to enable the use of a FIPS-certified crypto­

graphic provider for all cryptographic functions. For more infor­

mation about enabling FIPS compliance, seeFederal information

processing standard (FIPS 140-2) compliance in BigFix Remote

Control (on page 150).

Note:  If you enable FIPS compliance on the target, you 

must also enable FIPS compliance on the controller compo­

nents that are installed. Only the IBM Java Run-time Environ­

ment (JRE) is supported in FIPS-compliant mode and the JRE is 

installed when you install the controller software. To enable FIPS 

compliance on the controller, complete the following steps.

1. Edit the trc_controller.cfg file on the system that the 

controller is installed on.

Windows systems

[controller installation dir]\tr­

c_controller.cfg

where [controller installation dir] is the directo­

ry that the controller is installed in.

Linux systems

opt/ibm/trc/controller/trc_con­

troller.cfg

2. Set the fips.compliance property to Yes and save the file.

SP800131ACompliance No Select this option to enforce NIST SP800-131A-compliant al­

gorithms and key strengths for all cryptographic functions. For 

more information about enabling NIST SP800-131A compliance,

see NIST SP800-131A compliance in BigFix Remote Control (on 

page 163).
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Target property

Default

Value Description

Note:  If you enable NIST SP800-131A compliance on the 

target, you must also enable NIST SP800-131A compliance on 

the controller components that are installed. Only the IBM Java

Run-time Environment (JRE) is supported in NIST SP800-131A 

compliant mode and the JRE is installed when you install the 

controller software. To enable NIST SP800-131A compliance on 

the controller, complete the following steps.

1. Edit the trc_controller.cfg file on the system that the 

controller is installed on.

Windows systems

[controller installation dir]\tr­

c_controller.cfg

where [controller installation dir] is the directo­

ry that the controller is installed in.

Linux systems

opt/ibm/trc/controller/trc_con­

troller.cfg

2. Set the sp800131A.compliance property to Yes and save 

the file.

Accessibility No Select this option to enable the accessibility UI. Available only

on Windows operating system.

LogLevel 2 0 - Logging is set to a minimal level.

1 - Logging is set to ERROR level.

2 - Logging is set to INFO level.

4 - Logging is set to DEBUG level.

Note:  Use Log Level = 4 only by request from IBM. support.

LogRollover Daily Hourly

Start a new log file on the hour. Recommended if 

the log is written to frequently or when you use a 

log level higher than 2.

Daily
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Target property

Default

Value Description

Start a new log file every day.

LogRotation Weekly Daily

Overwrite log files after 1 day. When LogRollover is 

set to Hourly, the suffix that is added to the log file 

name is 00H to 23H.

Weekly

Overwrite log files after 1 week. When LogRollover 

is set to Hourly, the suffix that is added to the log 

file name specifies the day and hour. Value can be 

Mon-00H to Sun-23H. When LogRollover is set to 

Daily, the suffix that is added to the log file name 

specifies the day. The value can be Mon to Sun.

Monthly

Overwrite log files after 1 month. 01-00H to 

31-23H. When LogRollover is set to Hourly, the suf­

fix that is added to the log file name specifies the 

numeric day of the month and the hour. Value can 

be 01-00H to 31-23H. When LogRollover is set to 

Daily, the suffix that is added to the log file name 

specifies the numeric day of the month. The value

can be 01 - 31.

Disabled

LogRotation is disabled. When LogRollover is set 

to hourly, the suffix that is added to the log file 

name specifies the current date and time. Value

can be YYYY-MM-DD-hh. When LogRollover is 

set to Daily, the suffix that is added to the log file 

name specifies the current date. The value can be 

YYYY-MM-DD.
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Table 21. Session option properties.

Target property Default Value Description

AllowMonitor Yes Determines whether the target can take part in monitor peer-to-

peer sessions. For information about the different types of re­

mote control session that can be established, see Types of re­

mote control sessions that can be establishedthe BigFix Re­

mote Control Controller User's Guide.

Yes

The target can take part in monitor peer-to-peer 

sessions. The Monitor option is available for se­

lection in the session type list in the controller win­

dow. The Open connection window also lists a 

Monitor option.

No

The target cannot take part in monitor peer-to-peer 

sessions. The Monitor option is not available in the 

session type list in the controller window.

AllowGuidance Yes Determines whether the target can take part in guidance peer-to-

peer sessions.

Yes

The target can take part in guidance peer-to-peer 

sessions. The Guidance option is available in the 

session type list in the controller window. The 

Open connection window also lists a Guidance op­

tion.

No

The target cannot take part in guidance peer-to-

peer sessions. The Guidance option is not avail­

able in the session type list in the controller win­

dow.

AllowActive Yes Determines whether the target can take part in active peer-to-

peer sessions.

Yes
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Target property Default Value Description

The target can take part in active peer-to-peer ses­

sions. The Active option is available in the session

type list in the controller window. The Open con­

nection window also contains an Active option.

No

The target cannot take part in active peer-to-peer 

sessions. The Active option is not available in the 

session type list in the controller window.

DisableChat No Determines the ability to start a chat session with the target and 

also chat to the controller user during a peer-to-peer session.

Yes

If Chat Only is chosen as the connection type on 

the open connection screen, the session is re­

fused. During the session, the chat icon is not 

available in the controller window.

No

A Chat Only session can be initiated from the open 

connection window. During the session, the chat 

icon is available in the controller window.

DisableFilePull No Determines the ability to transfer files from the target to the con­

troller during the session.

Yes

Files cannot be transferred from the target to the 

controller.

No

Files can be transferred from the target to the con­

troller.

DisableFilePush No Determines the ability to transfer files from the controller to the 

target during the session.

Yes

Files cannot be transferred from the controller to 

the target.
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Target property Default Value Description

No

Files can be transferred from the controller to the 

target.

DisableClipboard No Determines the availability of the clipboard transfer menu in the 

controller UI in a peer-to-peer session. Use the menu to transfer

the clipboard content between the controller and target during a 

remote control session.

Yes

The clipboard transfer menu is not available dur­

ing the session to transfer the clipboard content to 

and from the target.

No

The clipboard transfer menu is available during the 

session.

AllowRecording Yes The controller user can make and save a local recording of the 

session in the controlling system.

Yes

The record option is available in the controller win­

dow.

No

The record option is not available in the controller

window.

AllowCollaboration Yes Use this property to allow more than one controller to join a ses­

sion. Determines the availability of the collaboration icon on the 

controller window.

Yes

The collaboration icon is available in the controller

window.

No

The collaboration icon is not available in the con­

troller window.
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Target property Default Value Description

AllowHandover Yes The master controller in a collaboration session, can hand over 

control of the session to a new controller. Determines the avail­

ability of the Handover button on the collaboration control panel.

Yes

The Handover button is displayed in the collabora­

tion control panel.

No

The Handover button is not displayed in the collab­

oration control panel.

AllowForceDisconnect No Determines whether a Disconnect session button is available in 

the message window that is displayed when you attempt to con­

nect to the target. You can use the Disconnect session option to 

disconnect the current session.

Yes

The disconnect button is displayed in the message

window.

No

The disconnect button is not displayed in the mes­

sage window.

ForceDisconnectTimeout 45 Number of seconds you must wait for the controller user to re­

spond to the prompt to disconnect the current session. If they 

do not respond in the time that is given, they are automatical­

ly disconnected from the session. The timer takes effect only

when AllowForceDisconnect and CheckUserLogin are set to 

Yes. The default value is 45.

AutoWinLogon Yes Determines whether a session can be started when no users 

are logged on at the target. Determines whether the user accep­

tance window is displayed on a target where the target user is 

not logged on.

Yes

Session is started with the target.
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Target property Default Value Description

The acceptance window is not visible on the target

and the session is established.

No

Session is not started and the following message

is displayed. Session rejected because there 

is no user logged to confirm the sessionThe 

session is refused because no user is logged on at 

the target to accept the session.

RunPreScript No Determines whether a user-defined script is run before the re­

mote control session starts. The script is run just after the ses­

sion is allowed but before the controller user has access to the 

target. The outcome of running the script and the continuation

of the session is determined by the value that is set for Proceed

on pre/post-script failure.

Yes

When a remote control session is requested, the 

defined script is run before the controller user has 

access to the target.

No

No script is run before the session.

For more information about setting up pre and post session

scripts, see the BigFix Remote Control Administrator's Guide.

RunPostScript No Determines whether a user-defined script is run after the remote

control session finishes.

Yes

When a remote control session ends, the user-de­

fined script is run.

No

No script is run after the session.

For more information about setting up pre and post session

scripts, see the BigFix Remote Control Administrator's Guide.
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Target property Default Value Description

ProceedOnScriptFail No The cction to take if the pre-script or post-script execution fails. 

A positive value or 0 is considered a successful run of the pre-

script or post-session script. A negative value, a script that is not 

found, or not finished running within 3 minutes is considered a 

failure.

Yes

If the pre-script or post-script run fails, the session

continues.

No

If the pre-script or post-script run fails, the session

does not continue and ends.

WorkaroundW2K3RDP No Automatically reset the console after a Remote Desktop con­

sole session. When a Remote Desktop user uses the /admin or 

/console option to start a Remote Desktop session with a Win­

dows Server 2003 system and a user starts a remote control

session with this target before, during or after the Remote Desk­

top session, remote control is unable to capture the display. The 

result is that a gray screen is shown in the controller. This is­

sue is a limitation in Windows Server 2003 operating systems.

Therefore, this property introduces a workaround that will reset

the Windows session either after each Remote Desktop session

ends, or before a remote control session starts, depending on 

the value Yes.

0

The workaround is disabled. This value is the de­

fault value.

1

Reset the session automatically when a remote

control session is started.

Note:  The Windows session takes a couple

of minutes to initialize and a blank desktop is dis­

played on the controller until the initialization is 

complete. A message informs the controller user 
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Target property Default Value Description

that the session is being reset and it might take a 

few minutes.

2

Reset the session automatically when the Remote

Desktop user logs out.

EnableTrueColor No Determines whether the target desktop is displayed in high-qual­

ity colors in the controller window at the start of a session. Used 

together with Lock color quality.

Yes.

The target desktop is displayed in true color 24-bit 

mode at the start of the session. Partial screen up­

dates are also enabled.

No.

The target desktop is displayed in 8-bit color mode 

at the start of the session. Partial screen updates

are also enabled. This value is the default value.

LockColorDepth No Determines whether the color quality that a remote control ses­

sion is started with can be changed during the session. Used to­

gether with Enable high quality colors.

Yes.

The initial color quality, for the remote control ses­

sion, is locked and cannot be changed during the 

session. The Performance settings icon is dis­

abled in the controller window. The controller user 

cannot change settings to improve the session

performance if their network is slow.

No.

The color quality can be changed during the ses­

sion. The Performance settings icon is enabled in 

the controller window.
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Target property Default Value Description

RemoveBackground No If a desktop background image is set on the target, this proper­

ty can be used to remove the background from view during a re­

mote control session.

Yes.

The desktop background image on the target is 

not visible during a remote control session.

No.

The desktop background image on the target is 

visible during a remote control session.

NoScreenSaver No Stops the target from sending screen updates when it detects

that the screen saver is active.

Yes.

While the screen saver is active on the target sys­

tem, the target stops transmitting screen updates.

The controller displays a simulated screen saver 

so that the controller user is aware that a screen 

saver is active on the remote display. The con­

troller user can remove the screen saver by press­

ing a key or moving the mouse.

No.

A simulated screen saver is not displayed in the 

session window. The target screen is displayed as 

normal and the target continues to transmit screen 

updates.

Managed Yes Determines whether the target registers with the Remote Control

server.

Yes.

The target registers with the Remote Control serv­

er and periodically contacts the server.

No.
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Target property Default Value Description

The target does not register with the Remote Con­

trol server. The target can take part only in peer-to-

peer sessions.

Table 22. User acceptance property descriptions

Target property

Default

Value Description

ConfirmTakeOver Yes Determines whether the acceptance window is displayed on the target,

when a remote control session is requested.

Yes

The user acceptance window is displayed and the target

user can accept or refuse the session.

No

The user acceptance window is not displayed and the ses­

sion is established.

ConfirmModeChange Yes Determines whether the user acceptance window is displayed when the 

controller user selects a different session mode from the session mode 

list on the controller window.

Yes

The user acceptance window is displayed each time a ses­

sion mode change is requested and the target user must ac­

cept or refuse the request.

No

The user acceptance window is not displayed and the ses­

sion mode is changed automatically.

ConfirmFileTransfer Yes Determines whether the user acceptance window is displayed when the 

controller user selects to transfer files between the target and the con­

troller.

Yes

The acceptance window is displayed in the following two 

cases. The target user must accept or refuse the file trans­

fer.
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Target property

Default

Value Description

• The controller user selects pull file from the file transfer

menu on the controller window. The target user must 

select the file that is to be transferred after they accept

the request.

• The controller user selects send file to controller from 

the Actions menu in the target window.

No

The acceptance window is not displayed and files are trans­

ferred automatically from the target to the controller system

when requested.

ConfirmSysInfo Yes Determines whether the user acceptance window is displayed when the 

controller user requests to view the target system information.

Yes

When the controller user clicks System information in the 

controller window, the user acceptance window is dis­

played. The target user must accept or refuse the request. If 

the target user clicks accept, the target system information

is displayed in a separate window on the controller system.

If they click refuse, a message is displayed on the controller

and the system information is not displayed.

No

The target system information is displayed automatically

when the controller user clicks the system information icon.

ConfirmRecording Yes Determines whether the user acceptance window is displayed when the 

controller user clicks the record icon on the controller window.

Yes

When the controller user clicks the record icon on the con­

troller window, a message window is displayed. If the target

user clicks Accept, the controller user can select a directory

to save the recording to. If the target user clicks Refuse, a 

recording refused message is displayed to the controller.



BigFix® Remote Control Installation Guide | 1 - Properties that can be set in the target configuration | 212

Target property

Default

Value Description

Note:  After the target user accepts the request for 

recording, if the controller user stops and restarts local

recording, the acceptance window is not displayed.

No

When the controller user clicks the record icon on the con­

troller window, the message window is not displayed. The 

controller user can select a directory to save the recording

to.

ConfirmCollaboration Yes Determines whether the user acceptance window is displayed when an­

other controller user requests to join a collaboration session with a target.

Yes

When the controller user tries to join the collaboration ses­

sion, the user acceptance window is displayed. The target

user must accept or refuse the request to allow the addition­

al controller to join the session. If the target user clicks ac­

cept, the additional controller joins the collaboration ses­

sion. If they click refuse, a message is displayed on the con­

troller system and the additional controller cannot join the 

collaboration session.

No

The additional controller automatically joins the collabo­

ration session when they try to connect to the master con­

troller of the session.

AcceptanceGraceTime 45 Sets the number of seconds to wait for the target user to respond before

a session starts or times out, used with Confirm incoming connections.

• Acceptable values 0 - 60. If set to 0, the target user is not asked to re­

spond to the session request.

Note:  If Confirm incoming connections is Yes, Acceptance grace 

time must be set to a value >0 to provide the target user with enough time 

to respond.
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Target property

Default

Value Description

AcceptanceProceed No The action to take if the user acceptance window timeout lapses. The tar­

get user did not click accept or refuse within the number of seconds de­

fined for Acceptance grace time.

Yes

Session is established.

No

Session is not established.

HideWindows No Determines whether the Hide windows check box is displayed on the user 

acceptance window when Confirm incoming connections is also set to 

Yes.

Yes

The Hide windows check box is displayed on the user ac­

ceptance window.

No

The Hide windows check box is not visible on the user ac­

ceptance window.

Table 23. Security property descriptions

Target property Default Value Description

CheckUserLogin Yes Determines whether a logon window is displayed when the con­

troller user clicks a session type button on the Open Connection

window.

Yes

The logon window is displayed and the controller

user must log on with a valid Windows operating

system ID and password. If the logon credentials

are invalid, the target refuses the session.

No

The logon window is not displayed and the session

is established.

CheckUserGroup see description Default value.
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Target property Default Value Description

Windows systems

BUILTIN\Administrators

Linux systems

wheel

When CheckUserGroup has a value set, the user name that is 

used for authentication must be a member of one of the groups 

that are listed. If the user is not a member, the session is re­

fused. Multiple groups must be separated with a semicolon. For 

example, wheel;trcusers

Note:  By default, on Windows systems, only the Adminis­

trator user is granted access. On Linux systems, by default no 

users are granted access. To resolve this issue, complete one of 

the following steps.

1. To also grant administrator rights to the users, make them 

members of the Administrators group on Windows systems

or the wheel group on Linux systems.

2. For users with no administrator rights, complete the follow­

ing steps.

a. Create a group or use an existing group. For example,

the following command can be run as root:

groupadd trcusers

.

b. Add the users to this group. For example, the following

command can be run as root to add bsmith to trcusers:

usermod -a -G trcusers <bsmith>

c. Add the group to the list in the Authorized user group

field.

AuditToSystem Yes Determines whether the actions that are carried out during re­

mote control sessions are logged to the application event log on 

the target. This file can be used for audit purposes.

Yes
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Target property Default Value Description

Entries that correspond to each action that is car­

ried out during the session, are logged in the appli­

cation event log of the target.

No

No entries are logged to the application event log.

AutoSaveChat No Determines whether the chat text, entered during a chat session,

can be saved.

Yes

The chat text is saved as an html file. The file is 

chat-username-date.html, where username

is the display name of the logged on user on the 

controller machine in a peer-to-peer session. In 

managed mode username is the display name for 

the controller user that is on the server. The date is 

in the format YYYYMMDD. The file is saved in the 

working directory of the target. The location of the 

working directory is defined by the target proper­

ty WorkingDir. For example, on Windows systems,

the file is saved to

c:\ProgramData\IBM\Tivoli\Remote Con­

trol.

On Linux systems the file is saved to /var/opt/

ibm/trc/target/.

c:\Documents and Settings\All Users

\Application Data\IBM\Tivoli\Remote

Control

No

The chat text is not saved to a file.

EnableFileTransferSystemAccess No Determines whether the file transfer session allows for target

file system access using System privileges (Windows) or root 

privileges (Linux). This option is valid for peer to peer sessions

only.

Yes
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Target property Default Value Description

The file transfer session uses System privileges

(Windows) or root privileges (Linux) on the target

file system.

No

The file transfer session uses the privileges of the 

logged on user on the target file system.

Note:  If the option is set to No, and there is no logged on 

user on the target during the file transfer session, an error mes­

sage is displayed.

SessionDisconnect No Determines whether the target computer is automatically locked 

when the remote control session ends. Allowed value: lock.

When you set the value to lock, the target computer is automat­

ically locked at the end of the session. If the property is blank 

or set to another value, the target computer is not automatically

locked at the end of the session.

Yes

The target computer is automatically locked at the 

end of the session.

No

The target computer is not automatically locked at 

the end of the session.

AllowPrivacy Yes Determines whether a controller user can lock the local input

and screen of the target in a remote control session. Determines

the visibility of the Enable Privacy option on the controller win­

dow.

Yes

The  Enable Privacy option is available in the Per­

form Action in target menu in the controller win­

dow.

No
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Target property Default Value Description

The  Enable Privacy option is not available in the 

Perform Action in target  menu in the controller

window.

AllowInputLock Yes This property works with Allow privacy and on its own. You can 

use Allow input lock  to lock the target users mouse and key­

board during a remote control session.

Yes

The lock target input menu item is enabled, in the 

Perform action in target menu in the controller

window. Select lock target input to lock the target

users mouse and keyboard during a remote con­

trol session. The target screen is still visible to the 

target user.

No

The lock target input menu item is not enabled in 

the Perform action in target menu in the controller

window.

Note:  If the option to Enable Privacy is Yes during a ses­

sion, the remote user input is automatically locked. It is not pos­

sible to enable privacy without also locking the input.

EnablePrivacy No Determines whether the local input and screen are locked for all 

sessions. Therefore, the target user cannot input or do anything

on the target while in a remote control session.

Yes

The target screen is blanked out by the privacy

bitmap when the session starts, preventing the tar­

get user from interacting with the screen while in 

the session. The target desktop is still visible to 

the controller user in the controller window.

No

The target screen is not blanked out when the ses­

sion is started and the target user can interact with 

the screen.
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Target property Default Value Description

EnableInputLock No This property works with  Enable privacy. When privacy mode is 

enabled, use Enable input lock to determine whether the target

user can view their screen, during a remote control session.

Yes

The target screen is visible to the target user dur­

ing the session, while in privacy mode but the 

mouse and keyboard control is locked.

No

The target screen is not visible to the target user. 

The privacy bitmap is displayed on the target dur­

ing the session. The target users mouse and key­

board input is also disabled.

Note:  Enable privacy must be Yes for Enable input lock to 

take effect.

DisablePanicKey No Determines whether the Pause Break key can be used by the tar­

get user to automatically end the remote control session.

Yes

The target user cannot use the Pause Break key to 

automatically end the remote control session.

No

The target user can use the Pause Break key to au­

tomatically end the remote control session.

EnableOSSN No Determines whether a semi-transparent overlay is displayed on 

the target computer to indicate that a remote control session is 

in progress. Use this property when privacy is a concern so that 

the user is clearly notified when somebody can remotely view or 

control their computer.

Yes

The semi-transparent overlay is displayed on the 

target screen with the text BigFix Remote Con­

trol  and what type of remote control session is in 

progress. For example, BigFix Remote Control - 
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Target property Default Value Description

Active Mode. The overlay does not intercept key­

board or mouse actions. The user is still able to in­

teract with their screen.

No

No overlay is displayed on the target computer.

Note:  This policy is only supported on targets where a Win­

dows operating system installed.

DisableGUI No Determines whether the target UI is visible when the remote con­

trol session is starting and also during the session.

Note:  This option works only when the target is installed

in peer-to-peer mode and the Managed target property is set to 

No. This option is ignored when applied to any targets that were 

installed by using the BigFix Remote Control server mode when 

a server URL was supplied.

Yes

The target UI is not visible on the target and the 

target user is not aware that the session is started.

The BigFix Remote Control target icon is not visi­

ble in the Windows system tray.

No

The target UI is displayed on the target as the ses­

sion is starting and is available to the target user 

during the remote control session.

Operating systems that the property is configurable in

Table 24. Operating systems that the property is configurable in

Property name Windows Linux
macOS - avail­

able from V9.1.4

ServerURL * *

ProxyURL * *

BrokerList * * *
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Property name Windows Linux
macOS - avail­

able from V9.1.4

GroupLabel * *

PortToListen * * *

AllowP2P * *

AllowP2PFailover * *

FIPSCompliance * *

SP800131ACompliance * *

Accessibility *

LogLevel * * *

LogRollover * * *

LogRotation * * *

AllowMonitor * * *

AllowGuidance * *

AllowActive * * *

DisableChat * *

DisableFilePull * * *

DisableFilePush * * *

DisableClipboard * *

AllowRecording * * *

AllowCollaboration * * *

AllowHandover * * *

AllowForceDisconnect * *

ForceDisconnectTimeout * *

AutoWinLogon * *

RunPreScript * *

RunPostScript * *
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Property name Windows Linux
macOS - avail­

able from V9.1.4

ProceedOnScriptFail * *

WorkaroundW2K3RDP *

EnableTrueColor * * *

LockColorDepth * * *

RemoveBackground *

NoScreenSaver *

Managed * *

ConfirmTakeOver * * *

ConfirmModeChange * * *

ConfirmFileTransfer * * *

ConfirmSysInfo * * *

ConfirmRecording * * *

ConfirmCollaboration * * *

AcceptanceGraceTime * * *

AcceptanceProceed * * *

HideWindows * *

CheckUserLogin * *

CheckUserGroup * *

AuditToSystem * * *

AutoSaveChat * *

EnableFileTransferSystemAccess * *

SessionDisconnect * *

AllowPrivacy *

AllowInputLock *

EnablePrivacy *
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Property name Windows Linux
macOS - avail­

able from V9.1.4

EnableInputLock *

DisablePanicKey *

EnableOSSN *

DisableGUI *



Appendix B. Support

For more information about this product, see the following resources:

• Knowledge Center

• BigFix Support Center

• BigFix Support Portal

• BigFix Developer

• BigFix Wiki

• HCL BigFix Forum

https://help.hcltechsw.com/bigfix/9.5/compliance/welcome/BigFix_Compliance_welcome.html
https://support.hcltechsw.com/csm
https://support.hcltechsw.com/csm?id=bigfix_support
https://developer.bigfix.com/
https://bigfix-wiki.hcltechsw.com/wikis/home?lang=en-us#!/wiki/BigFix%20Wiki/page/BigFix%20Compliance
https://forum.bigfix.com
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This information was developed for products and services offered in the US.

HCL may not offer the products, services, or features discussed in this document in other countries. 

Consult your local HCL representative for information on the products and services currently available 

in your area. Any reference to an HCL product, program, or service is not intended to state or imply that 

only that HCL product, program, or service may be used. Any functionally equivalent product, program, or 

service that does not infringe any HCL intellectual property right may be used instead. However, it is the 

user's responsibility to evaluate and verify the operation of any non-HCL product, program, or service.

HCL may have patents or pending patent applications covering subject matter described in this 

document. The furnishing of this document does not grant you any license to these patents. You can send 

license inquiries, in writing, to:

HCL

330 Potrero Ave.

Sunnyvale, CA 94085

USA

Attention: Office of the General Counsel

For license inquiries regarding double-byte character set (DBCS) information, contact the HCL Intellectual 

Property Department in your country or send inquiries, in writing, to:

HCL

330 Potrero Ave.

Sunnyvale, CA 94085

USA

Attention: Office of the General Counsel

HCL TECHNOLOGIES LTD. PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, 

EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-

INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some jurisdictions do 

not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement 

may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically 

made to the information herein; these changes will be incorporated in new editions of the publication. 

HCL may make improvements and/or changes in the product(s) and/or the program(s) described in this 

publication at any time without notice.



Any references in this information to non-HCL websites are provided for convenience only and do not in 

any manner serve as an endorsement of those websites. The materials at those websites are not part of 

the materials for this HCL product and use of those websites is at your own risk.

HCL may use or distribute any of the information you provide in any way it believes appropriate without 

incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 

exchange of information between independently created programs and other programs (including this 

one) and (ii) the mutual use of the information which has been exchanged, should contact:

HCL

330 Potrero Ave.

Sunnyvale, CA 94085

USA

Attention: Office of the General Counsel

Such information may be available, subject to appropriate terms and conditions, including in some cases, 

payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by 

HCL under terms of the HCL Customer Agreement, HCL International Program License Agreement or any 

equivalent agreement between us.

The performance data discussed herein is presented as derived under specific operating conditions. 

Actual results may vary.

Information concerning non-HCL products was obtained from the suppliers of those products, their 

published announcements or other publicly available sources. HCL has not tested those products and 

cannot confirm the accuracy of performance, compatibility or any other claims related to non-HCL 

products. Questions on the capabilities of non-HCL products should be addressed to the suppliers of 

those products.

Statements regarding HCL's future direction or intent are subject to change or withdrawal without notice, 

and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate 

them as completely as possible, the examples include the names of individuals, companies, brands, and 

products. All of these names are fictitious and any similarity to actual people or business enterprises is 

entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming 

techniques on various operating platforms. You may copy, modify, and distribute these sample programs 



in any form without payment to HCL, for the purposes of developing, using, marketing or distributing 

application programs conforming to the application programming interface for the operating platform 

for which the sample programs are written. These examples have not been thoroughly tested under 

all conditions. HCL, therefore, cannot guarantee or imply reliability, serviceability, or function of these 

programs. The sample programs are provided "AS IS," without warranty of any kind. HCL shall not be liable 

for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must include a copyright 

notice as follows: 

© (your company name) (year). 

Portions of this code are derived from HCL Ltd. Sample Programs. 

Trademarks
HCL Technologies Ltd. and HCL Technologies Ltd. logo, and hcl.com are trademarks or registered 

trademarks of HCL Technologies Ltd., registered in many jurisdictions worldwide.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered trademarks or trademarks 

of Adobe Systems Incorporated in the United States, and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or 

its affiliates.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the 

United States, other countries, or both.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other product and service names might be trademarks of HCL or other companies.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the HCL website.



Personal use

You may reproduce these publications for your personal, noncommercial use provided that all proprietary 

notices are preserved. You may not distribute, display or make derivative work of these publications, or 

any portion thereof, without the express consent of HCL.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that all 

proprietary notices are preserved. You may not make derivative works of these publications, or reproduce, 

distribute or display these publications or any portion thereof outside your enterprise, without the express 

consent of HCL.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either 

express or implied, to the publications or any information, data, software or other intellectual property 

contained therein.

HCL reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use 

of the publications is detrimental to its interest or, as determined by HCL, the above instructions are not 

being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable 

laws and regulations, including all United States export laws and regulations.

HCL MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS 

ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 

INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, 

AND FITNESS FOR A PARTICULAR PURPOSE.
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